1 Getting Started

By the end of this section, you will be able to:

- Use the Student Guide
- Log on to SiteManager
- View the SiteManager Panel
- Control the Display of Multiple SiteManager Components
- Close Versus Exit in SiteManager
- Change Your SiteManager Password
- Identify security Access in SiteManager
- Use Open, New, and Choose Keys
- Use the Object Menu for Data Manipulation and Retrieval
- Identify Support Resources
- Use Current Window Help
Using the Student Guide

The student guide is divided into sections called learning modules. Each learning module consists of:

- Objectives
- Multiple Topics and Instructor-Led Exercises
- Review
- Summary Exercise

Each section will begin with the objectives for the module. The module will be divided into topics roughly corresponding to the objectives of the module. Each topic will have a short description of the SiteManager function, one or more general procedures about how to perform an action in SiteManager, and an instructor-led exercise for the topic. Instructor-led exercises are easy to spot on each page. Instructor-led exercises are identified by the Bulldozer graphic illustrated below and are numbered sequentially. Instructor-led exercises are very explicit and detail the specific steps and data to be used in performing the action.

![Bulldozer Graphic](image)

Each module will end with a review and a summary exercise. The review will summarize the main points and all of the SiteManager functionality covered in the module. The review pages may serve as an excellent reference for the summary exercise that follows the review and as a work aid for use back at the office when you are trying to reconstruct what you did in class.

The summary exercise gives you the opportunity to practice the skills you learned in the learning module. The summary exercise instructions will provide you with the data to be used and general instructions. Remember that the module review on the pages immediately preceding the summary exercise is composed of the general procedures covered in the module. The review will serve as a good reference as you perform the summary exercise.

SiteManager Procedures, the steps you follow to access a component of SiteManager, vary depending on whether you have just entered the system...
or have been in some other component and have already selected a common variable.

For instance, if you enter the application and navigate directly to the Contractor Payments component, the Estimate Summary window requires the selection of the desired Contract and Estimate.

However, if you have been working in the Contract Records component, already have a Contract selected, and then navigate to the Contractor Payments component, the Estimate Summary window displays for selection the Estimates for the Contract previously selected in Contract Records.

The procedures in this manual describe how to access components of SiteManager as if you just entered the application.

In NJDOT, there are three student guides:

- SiteManager Training Guide for Resident Engineers
- SiteManager Training Guide for Inspectors
- SiteManager Training Guide for Management
Logging on to SiteManager

Start Trnp•port SiteManager the same way you would any program on your computer.

![SiteManager Logon Window](image)

Figure 1-2. SiteManager Logon Window

In NJDOT, SiteManager may only be accessed through the Citrix Server.

NJDOT will not use RTF Templates.

The steps in the training manual assume that the user is already logged into Citrix and is able to access SiteManager.
Exercise 1-1

To log on to the AASHTO SiteManager system and join a group:

Login:  tpsjone  
Group:  RE

1. Double-click the SiteManager icon on your desktop.
2. Type tpsjone.
3. Press the Tab key.
4. Type pass.
5. Press Enter.
**Viewing the SiteManager Panel**

Depending on your security group, the Main Panel will display icons that represent the following components of the system: Contract Administration, Daily Work Reports, Contractor Payments, Change Orders, Accessories, System Administration, and Reports.

![SiteManager Main Panel](image)

Figure 1-3. SiteManager Main Panel

**The SiteManager Status Bar**

The SiteManager Status Bar at the bottom of the SiteManager window indicates your mode, connection, database region, logon group and individual ID.

![SiteManager Status Bar](image)

Figure 1-4. SiteManager Status Bar
Navigating in SiteManager Using the Main Panel

The SiteManager Panel is used to navigate to the components of the SiteManager application. The highest level is the SiteManager folder tab that contains the different functional groups, with each group individually represented by an icon. Double-clicking the icon of a functional group brings up another folder tab consisting of the sub-groups or the actual windows contained within that functional group. As icons are selected, the next level’s folder tab appears next to the previous level.

Figure 1-5. Navigating in SiteManager
Exercise 1-2

To browse through the components of SiteManager:

Login: tpsjone    Group: RE    Contract: 7777G

1. Double-click the Contract Administration icon.
2. Double-click the Contractor Management icon.
3. Click the Contract Administration folder tab.
4. Double-click the Contract Records icon.
5. Click the Main Panel folder tab.
6. Double-click the Daily Work Reports icon.
7. Click the Main Panel folder tab.
8. Double-click the Contractor Payments icon.
9. Click the Main Panel folder tab.
10. Double-click the Change Orders icon.
11. Click the Main Panel folder tab.
12. Double-click the Accessories icon.
13. Click the Main Panel folder tab.
15. Double-click the Contract Records icon.
16. Double-click the Contracts icon.
17. In the Contract ID list box, scroll to and double-click 7777G.
**Viewing the Toolbar**

Many of the functions available from the menus are also conveniently available from the SiteManager toolbar.

**Exercise 1-3**

To identify the components of the toolbar, place the mouse over the button and use the tool tip to identify each component.

Login: tpsjone  Group: RE  Contract: 7777G

![SiteManager Toolbar](image)

Some buttons are available on all windows. Others are window specific.

- **A** SiteManager Panel
- **B** Toolbar
- **C** Exit SiteManager
- **D** Help Contents
- **E** New
- **F** Open
- **G** Close
- **H** Delete
- **I** Save
- **J** Remarks
- **K** Address
- **L** Generic Fields
- **M** Attachments

1. Place the mouse pointer on the toolbar.
2. Use the right-click button to click the toolbar.
3. In the **Object** menu, click **Show Text**.
Controlling the Display of Multiple SiteManager Components

In many instances, you will be working in a SiteManager component, need to leave it temporarily to open another component. Having opened more than one component of SiteManager you may then need to control the display.

Opening Multiple SiteManager Components

While being in one SiteManager component, you may need to go to another component without closing the current one.

Exercise 1-4

To open multiple components of SiteManager:

1. Click the SiteManager Panel button.
2. Double-click the Projects icon.
3. In the Project Number list box, scroll to and double-click Contract 7777G.

Using the Window Menu to Control the Display of Multiple SiteManager Components

Having opened more than one SiteManager component, you can now use a variety of standard Windows methods to control the display of the components and your movement between them.

Figure 1-7. Window Menu With Display Options
**Controlling the Window Display Using Tile**

Tiling divides the screen into the number of SiteManager components that you have active. Typically, tiling is used to display two SiteManager components side by side horizontally to compare the entries in each or to return a single component to full screen once you have closed the other component. Typically, it is not used when more than two components of SiteManager are active since you would not be able to see enough of each component of SiteManager to make it worthwhile. With three components of SiteManager active, tiling would give each component only one third of the screen. Unless you have a very large display, tiling with more than two SiteManager components open may not be very useful.

![Figure 1-8. Two Tiled SiteManager Windows](image)

**Exercise 1-5**

To tile the two current components of SiteManager:

1. Click the **Window** menu and click the **Tile** choice.
Controlling Window Display Using Cascade

Cascading makes the number of SiteManager components that you have active an equal size and arranges each component in an overlapping offset window. Typically, cascading is used to display more than two open SiteManager components offset. When you have a need to navigate between more than two open SiteManager components, the Cascade choice may make it easier to move between them.

![Figure 1-9. Cascading SiteManager Windows](image)

Exercise 1-6

To cascade components of SiteManager:

Login: tpsjone      Group: RE      Contract: 7777G

1. Click the **SiteManager Panel** button.

2. Double-click the **Categories** icon.

3. Click the **Window** menu and click the **Cascade** choice.

4. Click the visible portion of the **Projects** window.

5. Click the visible portion of the **Contracts** window.
Controlling Window Display Using Layer

Layering displays the SiteManager component that you have active in the most efficient full screen display. Typically, layering is used to give each active component a full window for display or to return a single active component to full display after you have closed the other components that were tiled or cascaded.

Figure 1-10. The Window Menu with Three SiteManager Components Active

Exercise 1-7

To layer three open components of SiteManager and move between them:

Login: tpsjone Group: RE Contract: 7777G

1. Click the Window menu and click the Layer choice.
2. Click the Window menu and click the Categories choice.
3. Click the Window menu and click the Projects choice.
Closing Versus Exiting in SiteManager

While SiteManager is not document oriented like other common Windows applications, the same principle of closing versus exiting still applies. When you are in a SiteManager component and you wish to end your work in it, but still continue to perform other SiteManager activities, you should close. As with other applications, you only exit SiteManager when you are through with your activities.

![File Menu](image)

Figure 1-11. The File Menu

---

**When logged into Citrix, File – Exit must be used to Exit SiteManager. Do not use the Exit button or the corner X to Exit SiteManager.**

---

**Exercise 1-8**

To close a window and exit SiteManager:

Login:  tspjone  
Group:  RE  
Contract:  7777G

1. Click the Close button.

2. Click the File menu and click the Exit choice.
Changing Your SiteManager Password

In addition to your network logon identity, SiteManager also has password protection. Your SiteManager ID determines what information you have access to and whether you can update the data or not. If you have any questions regarding your SiteManager security access, contact your SiteManager system administrator.

![Change Password Window](image)

Figure 1-12. Change Password Window
IMPORTANT TIPS REGARDING YOUR USER ID:

1. When a User ID is first assigned to a User, the default Password is PASSWORD (all caps). The User must change the password before logging on to SiteManager.

2. SiteManager Users IDs for NJDOT have the following criteria:
   a. NJDOT Personnel will use the standard tp number.
   b. Consultants will each be given a unique user id.

IMPORTANT TIPS REGARDING YOUR PASSWORD AND LOGON ATTEMPTS:

1. It is important that you do not give out your password to anyone. SiteManager maintains a record of everything you do in SiteManager. These records are the same as your signature.

2. If you have attempted to log on twice and have failed, close the SiteManager Logon window and start again. This will allow you to try and log on again without disabling your password.

3. If you attempt to log on three times and fail, SiteManager will disable your password. Contact the SiteManager Administrator if your password is disabled.

4. SiteManager Password Criteria:
   a. Four to eight characters in length.
   b. Case-sensitive.
   c. Cannot be the word ‘password.’
Exercise 1-9

To log on to SiteManager using another ID and change the password:

Login: tspere  Group: INSP  Contract: 7777G

1. Double-click the SiteManager icon on your desktop.
2. Hold down the Shift key and press the Tab key.
3. Type tspere.
4. Press the Tab key.
5. Type PASSWORD.
6. Click the Change Password button.
7. Type PASSWORD.
8. Press the Tab key.
9. Type pass.
10. Press the Tab key.
11. Type pass.
12. Click the Ok button.
Identifying Security Access in SiteManager

Depending on your security privileges to SiteManager you may have update or inquiry only rights. Available SiteManager security privileges are as follows:

Update rights to all SiteManager windows and data,

Inquiry rights only and be able to access data and print reports, but not update information,

Update rights on some SiteManager windows, inquiry only on other windows, and/or no access to other windows,

Update rights on some SiteManager data, inquiry rights on other data, and/or no access to other data,

When you have access to the window and the data, the field will appear with a white background. When you only have inquiry access, the data will appear but the fields will have a gray background.

Figure 1-13. An Inquiry-Only SiteManager Window
Exercise 1-10

To access an inquiry-only window:

Login: tspere      Group: INSP      Contract: 7777G

1. Double-click the Contractor Payments icon.
2. Double-click the Estimate icon.
3. Double-click the Estimate Summary icon.
4. Double-click Contract 7777G.
5. Double-click Estimate Number 0001.
6. Are you in Inquiry or Update Mode? Inq
7. Click the Close button.
8. Click the Main Panel folder tab.
Using Open, New, and Choose Keys

When you have the authority and update rights and first enter a SiteManager window, you can:

  - Open for an existing record,
  - Create a new record for data entry, or
  - Choose keys to create a new record,

In some instances, SiteManager will not even let you into the window without choosing the keys first. Choosing the keys identifies the initial values for the new or existing record.

Opening an Existing Record

When you want to open an existing record, in some windows all you have to do is activate the window and click the Open button and select the record you need. Choosing a key first is unnecessary.

Figure 1-14. Opening a Multi-Key Window
Exercise 1-11

To access a window and open an existing record that needs multiple keys:

Login: tspere    Group: INSP    Contract: 7777G

1. Double-click the **Daily Work Reports** icon.

2. Double-click the **Daily Work Reports** icon.

3. What security mode are we in (Inquiry or Update)? _________

4. What **Contract ID** is displayed? ________________________

5. On the toolbar, click the **Open** button.

6. Click the **No** button.

7. In the **Inspector** list box, scroll to and double-click user ID **tpsbrow**.

8. In the **Date** list box, scroll to and double-click DWR date **08/07/08**.

9. When informed that the DWR will be opened in read-only format, click the **OK** button.

10. When you want to open an existing record, do you use Open, New, or Choose Keys? ________________________

Creating a New Record

When you want to create a new record, all you have to do is activate the window and you are ready to create the new record. Choosing a key first is not always necessary. If you access an existing record first, you will have to use the New button to create a new record.
Exercise 1-12

To access a window and identify the new record mode:

Login: tspere  Group: INSP  Contract: 7777G

1. Click the New button.

2. What is the Inspector’s Name? Perez, Jessie

3. What is the DWR date? 00/00/00

4. What is the Contract? 7777G, It’s the same one as the one you opened.

5. When you want to create a new record, do you use Open, New or Choose Keys? New

Choosing Keys

In some windows, you cannot create a new record without choosing the keys first. Choosing the keys identifies the initial values for the new record.
Exercise 1-13

To access a window that requires keys to be chosen and identify the new record mode:

   Login: tpspere   Group: INSP   Contract: 7777J

1. Click the Services menu.

2. Click the Choose Keys choice. SiteManager displays the Contract ID window.

3. In the Contract ID list box, scroll to and double-click Contract ID 7777J.

4. Note that you are ready to create a record for Contract 7777J.

5. When you want to create a new record for a DIFFERENT Contract, do you use Open, New, or Choose Keys?
   New, then Choose Keys

6. Click the Close button.

7. When asked if you would like to save changes, click the No button.

8. Click the Main Panel folder tab.
Using the Object Menu for Data Manipulation and Retrieval

To make data entry and retrieval easier, SiteManager provides a Search, Filter, Find, and Sort capability throughout the application. The Filter and Find functions also provide users with the ability to limit the data retrieved from the SiteManager database by specifying criteria using relational operators. The Clear button clears the current data retrieval choice in effect. The Show Filter/Sort choice shows the current criteria in effect for these choices.

Identifying the Criteria Window Buttons

**Insert:** Inserts a blank row before the currently selected row.

**Add:** Inserts a blank row after the last row.

**Remove:** Deletes the selected row. Remove deletes only one row at a time.

**Clear:** Deletes all rows. All rows must be deleted to return to the complete, unfiltered list.

**Load:** Opens saved filter list. Saved filter allows for loading and deleting of saved (and default) filters.

**Save:** Opens filter name window to allow filter to be saved. The Default check box allows a filter to be automatically applied every time the window is accessed.

Identifying the Criteria Window Conditions

Using the Equal (=) condition:
- Requires the specified value to be exact.
- Only matching whole words will be included
- Only matching capitalization will be included

Using the Like condition:
- Allows specified value to be imprecise
- Wildcard % allowed – A wildcard is a value that matches any value – like the wild card when playing Uno.
SiteManager assumes value% when the Like condition is selected, including all data that start with the entered value.

%value% allows partial data matches to be included.

Only matching capitalization will be included.

When creating multiple conditions, AND joins will be executed before OR joins.

**Sorting**

When the window displays as a list, the Sort feature allows you to sort the list, based on specified criteria. Each time the window displays, the default sort criterion is automatically applied. As with the Filter function, only one default sort criterion can be in effect for a window at any given time.

![Figure 1-17. The Sort Window](image_url)
Exercise 1-14

To sort the records in the window:

Login: tspere  Group: INSP  Contract: 7777J

1. Double-click the Contract Administration icon.
2. Double-click the Reference Tables icon.
3. Double-click the Item Master icon.
4. Position the pointer over the first record.
5. Use the right-click button click the record.
6. In the Object menu, click Sort.
7. In the Sort Criteria window, click the Add button.
8. In the Field drop-down list, click Spec Year.
9. Click the Add button, again.
10. In the Field drop-down list, click Short Description.
11. Click the OK button.
12. Click the Item Code column heading.
Finding

When a window displays as a scrollable list, the Find choice allows the user to get to a specific row by selecting the appropriate value to find.

When creating multiple conditions, remember that AND joins will be executed before OR joins.

Figure 1-18. The Find Window
**Exercise 1-15**

To display only the record meeting your condition:

```
Login: tspere       Group: INSP       Contract: 7777J
```

1. Position the selection pointer over the first record in the list at the top of the window.

2. Using the right mouse button, click the record.

3. From the object menu, click the **Find** choice.

4. On the **Find Criteria** window, click the **Add** button.

5. In the **Field** drop-down list, click **Item Code**.

6. In the **Condition** drop-down list, click **=**.

7. In the **Value** field, type **602213M**.

8. Click the **Add** button.

9. In the **Field** drop-down list, click **Spec Year**.

10. In the **Condition** drop-down list, click **=**.

11. In the **Value** field, type **2007**.

12. Click the **Find** button.
Filtering

The Filter choice allows you to specify filtering criteria for SiteManager fields and their limiting values using relational operators. Each time a window displays, the filtering criteria, marked as default, is automatically applied, thereby limiting the amount of data retrieved. Only one default filter criterion can be in effect for a window at any given time.

When creating multiple conditions, remember that AND joins will be executed before OR joins.

Exercise 1-16

To display only the records meeting your condition:

Login:  tpspere  
Group:  INSP  
Contract:  7777J

1. Position the selection pointer over a record in the list at the top of the window.

2. Using the right mouse button, click the record.

3. From the object menu, click the Filter choice. SiteManager displays the Filter Criteria window.
4. In the **Filter Criteria** window, click the **Add** button.

5. In the **Field** drop-down list, click **Short Description**.

6. In the **Condition** drop-down list, click **Like**.

7. In the **Value** field, type `%BEAM%`.

8. Click the **OK** button.

9. When informed that the specified filter will return a number of rows, click the **Ok** button.

### Clearing the Current Criteria

Remember that the current data retrieval choice will stay in effect until cleared. The Clear button clears the current data retrieval choice in effect.

### Exercise 1-17

To clear the current find:

- **Login:** tspere  **Group:** INSP  **Contract:** 7777J

1. Position the selection pointer over a record

2. Using the *right* mouse button, click the record.

3. From the **Object** menu, click the **Filter** choice.

4. Click the **Clear** button.

5. Click the **OK** button.

6. Click the **OK** button.
Identifying Support Resources

SiteManager offers several help options within the application. These include Current Window Help, Contents, and Search for Help On, which operated similar to any other Windows application Help functions. The SiteManager Help features, however, contain information regarding how SiteManager works as a whole and does not contain NJDOT specific uses or procedures. Therefore, the following support resources have been developed specifically for NJDOT and are available for assisting users in the use of SiteManager:

SiteManager Training – This includes the three training manuals as well as the customized NJDOT database and standalone SiteManager Training application.

SiteManager Construction Guide – This document provides a description of how NJDOT is using each window and field in SiteManager.

Contract Activation Process Plan – This document describes how a Contract is transferred from Trns•port PES/LAS to SiteManager, how to activate and prepare the Contract for the field, and who is responsible for each of these tasks.

Progress Estimate Process Plan – This document describes how to generate an estimate in SiteManager, how to review an estimate, how to approve and estimate, and who is responsible for each of these tasks.

Change Order Process Plan – This document describes how to create a Change Order in SiteManager, how to review and modify a Change Order, how to approve a Change Order and who is responsible for each of these tasks.

Contract Finalization Process Plan – This document describes the tasks and reports that must be completed to generate a Final Estimate in SiteManager and to complete a Contract in SiteManager as well as who is responsible for each of these tasks.

Design Documents – Most custom reports and the custom programs have design specification documents which describe the origin of each field and the behavior of the report or program.
Using the Current Window Help

With any SiteManager window active, the Help menu’s Current Window choice will access context sensitive help that includes Help on fields.

![Image](AASHTO_SiteManager_Help.png)

**Figure 1-20. Help on a SiteManager Window**

**Exercise 1-18**

To access help on the Current Window:

1. Click the **Help** menu and click the **Current Window** choice.

2. Click the **Item Code – Item Master Panel** field, Help displays a pop-up window with the field description.

3. Click the **File** menu and click the **Exit** choice.

4. Click the **File** menu and click the **Exit** choice.
Review for Section 1

To start on the AASHTO SiteManager system:

1. Double-click the SiteManager desktop icon.
   Or
2. Click the start button, click the Program choice, click the SiteManager choice, and click the SiteManager choice.
3. Type your logon identification name.
4. Press the tab key.
5. Type your password.
6. If appropriate in the Connect to drop-down list, click the expand arrow and click the desired database choice.
7. Press enter.
8. If appropriate in the Available Group for … dialog box, click the group ID.

To select a main panel component of SiteManager:

1. Double-click the component’s icon.

To select up or down a level in SiteManager:

1. Click the level’s folder tab.

To open more than one component of SiteManager:

1. Open the first component of SiteManager.
2. Click the Main Panel button.
   Or
1. Click the File menu and click the Main Panel choice.
2. Open the other component of SiteManager.

To tile:

1. Open the number of SiteManager components that you want to tile.
2. Click the Window menu and click the Tile choice.

To cascade:

1. Open the number of SiteManager components that you want to cascade.
2. Click the Window menu and click the Cascade choice.
3. Click the visible portion of the window you want to display.

To layer:

1. Open the number of SiteManager components that you want to layer.
2. Click the Window menu and click the Layer choice.

To move between multiple layered SiteManager components:

1. Click the Window menu and click the name of the SiteManager component from the list.

To close a SiteManager component:

1. Click the Close button.
   Or
2. Click the File menu and click the Close choice.

To exit SiteManager:

1. Click the File menu and click the Exit choice.

To change your password:

1. Start SiteManager.
2. On the logon screen, type your old password.
3. Click the Change Password button.
4. Type your old password.
5. Press the Tab key.
6. Type your new password.
7. Press the Tab key.
8. Type your new password again.
9. Click the Ok button.

To choose keys when you first enter a window:

1. In the list box, scroll to and double-click desired value.
2. Repeat step 1 until all initial values are selected.

To choose keys after you enter a window:

1. Click the Services menu and click the Choose Keys choice.
2. In the list box, scroll to and double-click desired value.
3. Repeat step 2 until all initial values are selected.
To create a new record:
1. Double-click the window’s icon.
2. Click the New button.

To open an existing record:
1. Double-click the window’s icon.
2. Click the Open button.
3. Scroll to and click the desired record.
4. Click the Ok button.

To filter out other records:
1. Position the selection pointer over a record.
2. Using the right mouse button, click the record.
3. From the Object menu click the Filter choice.
4. Click the Add button.
5. In the Field drop-down list, click the expand arrow and click the desired field.
6. In the Condition drop-down list, click the expand arrow and click the desired choice.
7. In the Value field, select the current entry and type the desired value.
8. To add additional conditions, click the Add button.
9. In the Join drop-down list, click the expand arrow and click the desired choice.
10. Repeat steps 5-9 until you have selected all conditions.
11. Click the Ok button.

To clear a filter:
1. Position the selection pointer over a record.
2. Using the right mouse button, click the record.
3. From the Object menu, click the Object Menu choice to be cleared (Filter, Find, or Sort).
4. Click the Clear button.
5. Click the Ok button.

To find specific records:
1. Position the selection pointer over a record.
2. Using the right mouse button, click the record.
3. From the object menu click the Find choice.
4. Click the Add button.
5. In the Field drop-down list, click the expand arrow and click the desired field.
6. In the Condition drop-down list, click the expand arrow and click the desired choice.
7. In the Value field, select the current entry and type the desired value.
8. To add additional conditions, click the Add button.
9. In the Join drop-down list, click the expand arrow and click the desired choice.
10. Repeat steps 5-9 until you have selected all conditions.
11. Click the Ok button.

To sort the records:
1. Click the desired sort field at the top of the list.

Or
2. Position the selection pointer over a record.
3. Using the right mouse button, click the record.
4. From the Object menu click the Sort choice.
5. Click the Add button.
6. In the Field drop-down list, click the expand arrow and click the desired field.
7. In the Order drop-down list, click the expand arrow and click the desired choice.
8. To add additional sorts, click the Add button.
9. Repeat steps 4-7 until you have selected all sorts.
10. Click the Ok button.
To access Help by Contents:

1. Click the **Help** menu and click the **Contents** choice.
   
   Or
   
   1. Click the **Help** button.

   Or

   1. In a SiteManager window, press the f1 key.
   2. In the **Topics** list box, scroll to and click the desired topic.
   3. When finished, click the **File** menu and click the **Exit** choice.

To access Help by searching:

1. Click the **Help** menu and click the **Search for Help** on choice.
2. Type the topic on which you need help.
3. Click the topic.
4. Click the **Display** button.
5. When finished, click the **File** menu and click the **Exit** choice.

To access Help on the current window:

1. Display the SiteManager window for which you need help.
2. Click the **Help** menu and click the **Current Window** choice.
3. When finished, click the **File** menu and click the **Exit** choice.

To access Help on a field:

1. Display the SiteManager window that has the field for which you need help.
2. Click the **Help** menu and click the **Current Window** choice.
3. In the **Field** list, scroll to and click the desired field.
4. When finished, click the **File** menu and click the **Exit** choice.
Summary for Section 1

In the following exercise, you will navigate through SiteManager.

**Login:** tpsjone  **Group:** RE  **Contract:** 8888G

1. Log into SiteManager as tpsjone.

2. Navigate to the **Items** window
   (Main Panel > Contract Administration > Contract Records > Items).

3. Select the first project for Contract **8888G**, and then any of the available items.
   Both! Some fields may be changed, but since the Contract is activated, the item quantities and price cannot be changed.

4. Are you in inquiry or update mode? _______________________________________

5. Click the **Close** button to close the **Items** window.

6. Navigate to the **Item Master** window
   (Main Panel > Contract Administration > Reference Tables > Item Master).

7. Use the **Find** feature to find the Item Code **108003M**.

8. What is the **Item Description**? ___________________________________________
   **Lane Occupancy Charges**

9. **Filter** for short description **%ASPHALT CURB%** and Spec Year **2007**.

10. How many items are retrieved? ___________________________________________
    3

11. Clear the filter.

12. Click the Close button to close the **Item Master** window.


15. Click the **Close** button to close the **Milestones** window.

16. Exit SiteManager.
2 Activating Contracts

By the end of this section, you will be able to:

- Review the Contract Activation Process
- Update the Contract Description Folder Tab
- Update the Location Folder Tab
- Update the Payment Data Folder Tab
- Update the Critical Date Folder Tab
- Update the Primary Personnel Folder Tab
- Update the Prime Contractor Folder Tab
- Update the DBE Folder Tab
- View and Update the Projects Window
- View the Categories Window
- Update the Items Window
- Change a Contract’s Status to Active
Reviewing the Contract Activation Process

The SiteManager Contract Activation process begins with the award of the Contract in Trns•port LAS and concludes with the input of the Official Contract Start Time date.

All SiteManager Contracts are loaded into SiteManager from Trns•port LAS by the Trns•port Office once the Contract as been awarded. Once the Contract is in SiteManager, Construction Services should ensure that the necessary contractor information is available in SiteManager and Capital Programming should ensure that the funding sources are assigned appropriately.

Once the funding and contractor information is verified in SiteManager, the SiteManager Coordinator or the Resident Engineer should supplement the Contract information in the SiteManager Contracts, Projects, and Items windows and then activate the Contract.

When the Contract is activated, the Resident Engineer or his designee should prepare the Contract for field activities and for the first estimate. During this time, tasks should include establishing DWR Master List data, assigning Contract Authority to Inspectors, establishing Key Dates, and scheduling Checklist Events.

When the Contractor begins work or the date of the Official Contract Start Date is reached, whichever is first, the Resident Engineer should enter the Official Contract Start Date and Daily Work Reports should then be created.
The SM Coordinator and/or the Resident Engineer are responsible for activating the Contract and for preparing the Contract for field documentation and the first estimate.
Exercise 2-1
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will view and update the Contract Description folder tab.

Login: tpsjone   Group: RE   Contract: 7777A

1. Double-click the SiteManager icon on your desktop.

2. In the User ID field, type tpsjone.

3. Press the Tab key.

4. In the Password field, type pass.

5. Press the Enter key.

6. Double-click the Contract Administration icon.

7. Double-click the Contract Records icon.

8. Double-click the Contracts icon.

9. In the Contract ID list box, scroll to and double-click Contract ID 7777A.
Updating the Contract Description Folder Tab

When a Contract is first loaded from a Pre-construction system, the SiteManager system verifies that the data is acceptable. An authorized user can review the new Contract description and add or modify data before activating the Contract. After the user changes the Contract status to active, some data can not be modified. This is indicated by a gray background in the protected data fields.

The Description folder tab displays the Contract description data that can be added, modified, or deleted. This includes the Contract’s status, project number, administrative offices, funding type, and other descriptive information that determines how the system processes data for this Contract. The fields on this folder tab that are loaded from Trns•port PES/LAS and are required for activation are as follows:

- Contract ID
- Fed St/Pr Prj Nbr
- Primary PCN
- Region
- Division (1 is Construction, 4 is Maintenance)
- Funding Indicator (Federal, State, or Multiple)
- Description
- Time Charges
- Bid Days (if time is charged as Calendar Days or Work Days)
- Contract Type
- Work Type
- Fed Oversight (ON or OFF)
- Spec Year
- Unit System (English or Metric)
- CE Job Number
SiteManager has a generic fields capability comparable to the same function in Transport. Generic fields are fields attached to some of the SiteManager windows that are transportation agency defined. After the installation of SiteManager, NJDOT has attached descriptive labels to the generic fields of SiteManager, enabling users to enter and track data unique to NJDOT. The Contract Generic Fields window in NJDOT is used to track up to six municipalities and up to 12 Legislative districts affected by the Contract as well as the number of lanes affected.
During the Contract Activation Process, the SM Coordinator or the Resident Engineer adds the Wage Decision ID ‘Wage’ to the Contract. Additionally, the SM Coordinator or the Resident Engineer enters the Legislative Districts, Municipalities, and Number of Lanes affected by the Contract in the Contract Generic Fields window.

Exercise 2-2
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will view and update the Contract Description folder tab.

Login: tpsjone    Group: RE    Contract: 7777A

1. Click the Wage Decision area.
2. Click the New button.
3. Using the right mouse button, click the Wage Decision ID field.
4. From the object menu, click the Search choice.
5. In the Wg Dcsn Id list box, double-click WAGE.
6. Click the Generic Fields button.
7. In the Legislative District 1 drop-down list, click the expand arrow and click 13.
8. In the first Municipality drop-down list, click the expand arrow and click Morris-Riverdale.
9. In the Number of Lanes field, type 2.
10. Click the Generic Fields button.

This is the first time students are viewing the Generic Fields window.
Updating the Location Folder Tab

The Location folder tab lets the user add, modify, and delete Contract location data, and add or remove counties. Each Contract must have one county selected as the primary county. The user can not remove a county that is currently associated with one of the Contract’s projects. The fields on this folder tab that are loaded from Trns•port PES/LAS and are required for activation are as follows:

- Location
- Beg Sta Nbr
- End Sta Nbr
- Beg Termini
- End Termini
- Route Nbr
- Highway Nbr
- Road System
- Highway Nbr
- Contract County

Beginning and Ending Milepost information is located in the Beg Termini and End Termini fields.
During the Contract Activation Process, the SM Coordinator or the Resident Engineer reviews the Location folder tab for accuracy and identifies the Primary County for the Contract, if not already identified.

**Exercise 2-3**

Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will view the Contract Location folder tab.

- Login: **tpsjone**  
  - Group: **RE**  
  - Contract: **7777A**

1. Click the **Location** folder tab.

2. What is the Primary County? **Morris County**
Updating the Payment Data Folder Tab

The Payment Data folder tab lets the user add, modify, or delete Contract payment data such as the Liquidated Damages Rate Amount, the day of the month to generate estimates and retainage data. The retainage data includes the type of retainage allowed and the values that determine how retainage is to be applied to the Contract. The fields on this folder tab that are loaded from Trns•port PES/LAS and are required for activation are as follows:

- Current Contract Amt
- Retainage Information defaulted at 2%

During the Contract Activation Process, the SM Coordinator or the Resident Engineer enters the day on which estimates should be generated in the Generate Est1 Day field and enters the Final Liquidated Damages amount as defined in Special Provisions in the Liquidated Dam Rate Amt field.

If the Contract uses securities in lieu of retainage then the SM Coordinator or the Resident Engineer checks the Securities Allowed checkbox ON.
**Exercise 2-4**
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will view and update the Contract Payment Data folder tab.

Login: **tpsjone**  Group: **RE**  Contract: **7777A**

1. Click the **Payment Data** folder tab.
2. In the **Generate Est1 Day** field, type **5**.
3. In the **Liquidated Dam Rate Amt** field, type **1000.00**.
Updating the Critical Date Folder Tab

The Critical Dates folder tab lets the user view and record the occurrence of Critical Dates. The user can also add or modify related data. The Critical Date types were defined during system development and can not be added or deleted. These dates are considered critical because SiteManager includes them in the standard Contract record reports. When a new Contract is added from the pre-construction system, SiteManager includes the Critical Date types defined in the Default Critical Date reference table. Therefore, every Contract has the same Critical Date types.

The actual occurrence of a Critical Date event is recorded as the Actual Date of the event. Some Actual Dates are entered by the system and some are entered by an authorized user. To change a new Contract’s status from pending to active, the following Critical Date types must have an Actual Date entered:

- Award Date
- Execution Date
- Letting Date
- Price Adjustment Base Date

When an Actual Date is entered, the system notifies the recipients selected on this folder tab. Before saving an Actual Date, the user should make sure the recipient(s) to be notified have been selected.

Although the Official Contract Start Date is not required for contract activation, it must be entered before any estimates may be generated. The Official Contract Start Date can only be entered when the Contract status is changed to active.
The following table describes NJDOT’s use of the SiteManager Critical Dates.

<table>
<thead>
<tr>
<th>Critical Date</th>
<th>Req’d Act/ Final</th>
<th>Dist. List/ Recipient ID</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accepted Date</td>
<td>F</td>
<td>N/A</td>
<td>The Accepted Date is entered by the Close Out Engineer as the date the State Transportation Engineer signed the DC-20. The Certificate of Completion should have been issued by the Department.</td>
</tr>
<tr>
<td>Adjusted Completion Date</td>
<td>N</td>
<td>N/A</td>
<td>The Adjusted Completion Date is populated and updated by SiteManager with the current completion date of the Contract when a time adjustment Change Order is approved.</td>
</tr>
<tr>
<td>Award Date</td>
<td>A</td>
<td>N/A</td>
<td>The Award Date is populated by SiteManager when the Contract is loaded into SiteManager from Trns•port LAS.</td>
</tr>
<tr>
<td>Checked Out to Field Date</td>
<td>N</td>
<td>N/A</td>
<td>The Checked Out to Field Date is populated by SiteManager and updated each time the contract is “checked-out” via the pipeline process.</td>
</tr>
<tr>
<td>Contract Archived Date</td>
<td>N</td>
<td>N/A</td>
<td>The Contract Archived Date is populated by SiteManager as part of the Contract Archival process.</td>
</tr>
<tr>
<td>Contractor Bankruptcy Date</td>
<td>N</td>
<td>N/A</td>
<td>The Contractor Bankruptcy Date is updated by Resident Engineer when applicable.</td>
</tr>
<tr>
<td>Contractor Default Date</td>
<td>N</td>
<td>N/A</td>
<td>The Contractor Default Date is updated by Resident Engineer when applicable.</td>
</tr>
<tr>
<td>Contractor Final Certificate Date</td>
<td>F</td>
<td>NA</td>
<td>Final Certificate is entered by the Close Out Engineer when the Final Certification has been issued to the Contractor. This is the Final date of Estimate and when the two year time frame for legal action against the Department begins.</td>
</tr>
<tr>
<td>Execution Date</td>
<td>A</td>
<td>N/A</td>
<td>The Execution Date, set by Construction Services, is entered by the Resident Engineer during the Contract Activation process.</td>
</tr>
<tr>
<td>Critical Date</td>
<td>Req’d Act/ Final</td>
<td>Dist. List/ Recipient ID</td>
<td>Comment</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------</td>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Final As-Built Change Order Approved</td>
<td>F</td>
<td>Resident Engineer</td>
<td>The Final As-Built Change Order Approved date is entered by the Close Out Engineer once all work and documentation for the Contract is complete. Once this date is entered, all items are finalized and Daily Work Reports can no longer be created. This date should be entered just before the Final Estimate is created.</td>
</tr>
<tr>
<td>Letting Date</td>
<td>A</td>
<td>N/A</td>
<td>The Letting Date is populated by SiteManager when the Contract is loaded into SiteManager from Trns•port LAS.</td>
</tr>
<tr>
<td>Official Contract Start Date</td>
<td>N</td>
<td>N/A</td>
<td>The Resident Engineer enters the Official Contract Start Date as follows: Fixed Completion Date: Execution Date + 25 days Working Day/Calendar day: 25 days after execution or the first day they work. This date starts counting time on the Contract and is the first Estimate’s begin date.</td>
</tr>
<tr>
<td>Open to Traffic Date</td>
<td>Y</td>
<td>Construction- Close Out Distribution List Operations- Project Manager Recipient</td>
<td>The Resident Engineer enters this date when the Contract is fully open to traffic.</td>
</tr>
<tr>
<td>Price Adjustment Base Date</td>
<td>Y</td>
<td>N/A</td>
<td>The Price Adjustment Base Date is entered by the Resident Engineer as the date noted in Special Provisions during the Contract Activation process.</td>
</tr>
<tr>
<td>Signed Date</td>
<td>N</td>
<td>N/A</td>
<td>NJDOT is not using this field.</td>
</tr>
<tr>
<td>Substantial Work Complete Date</td>
<td>F</td>
<td>RCE or RMM</td>
<td>The Substantial Work Complete Date is entered by the Resident Engineer once the Contract is determined to be substantially complete.</td>
</tr>
</tbody>
</table>
### NJDOT Critical Date Settings

<table>
<thead>
<tr>
<th>Critical Date</th>
<th>Req’d Act/ Final</th>
<th>Dist. List/ Recipient ID</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Completion Date</td>
<td>N</td>
<td>N/A</td>
<td>The Original Completion Date is populated by SiteManager when the Contract is loaded into SiteManager from Trnsport LAS for Fixed Completion Date Contracts. This date is calculated by SiteManager for Calendar Day Contracts.</td>
</tr>
<tr>
<td>Work Begin Date</td>
<td>N</td>
<td>RCE or RMM</td>
<td>The Work Begin Date is entered by the Resident Engineer when work starts on the Contract.</td>
</tr>
</tbody>
</table>

**Table 2-1. NJDOT Critical Date Settings**

**Figure 2-6. The Critical Dates Folder Tab**

During the Contract Activation Process, the SM Coordinator or the Resident Engineer enters the Actual Occurrence Dates for the Execution Date and the Price Adjustment Base Date.
Exercise 2-5
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will view and update the Contract Critical Date folder tab.

Login: tpsjone   Group: RE   Contract: 7777A

1. Click the Critical Date folder tab.

2. In the Critical Date Description list, click Execution Date.

3. In the Actual Occurrence Date field, type 080608.

4. In the Critical Date Description list, click Price Adjustment Base Date.

5. In the Actual Occurrence Date field, type 072508.
Updating the Primary Personnel Folder Tab

The Primary Personnel folder tab lets the user add, modify, and delete the Contract’s primary personnel. Every Contract must have a Resident Engineer and a Project Manager. When an authorized user adds the Resident Engineer and Project Manager to the Contract, SiteManager adds them to Contract Authority automatically. If primary personnel are later replaced, SiteManager starts authority for the new personnel and ends authority for the previous personnel.

The fields on this panel required for activation are as follows:

- Resident Engineer
- Project Manager

During the Contract Activation Process, the SM Coordinator or the Resident Engineer enters the Resident Engineer and Project Manager for the Contract.
Exercise 2-6
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will view and update the Contract Primary Personnel folder tab.

Login: tpsjone Group: RE Contract: 7777A

1. Click the Primary Personnel folder tab.

2. Using the right mouse button, click the Resident Engineer field.

3. From the object menu, click the Search choice.

4. In the User Name list box, double-click User ID tpsjone, User Name Jones, Kelly.

5. Using the right mouse button, click the Project Manager field.

6. From the object menu, click the Search choice.

7. In the User Name list box, double-click User ID tpsjack, User Name Jackson, Bailey.
Updating the Prime Contractor Folder Tab

The Prime Contractors folder tab lets the user add and delete the Prime Contractor and the Prime Associates. The user can also specify the maximum percentage of the Contract work that can be subcontracted. If the Prime Contractor is in default, the user can record the defaulted date and reason. The Prime Contractor entities are defined as follows:

Prime Contractor The Prime Contractor is the Contractor who is awarded the Contract.

Prime Associates The Prime Associates are vendors who have a Contract-specific relationship with the Prime Contractor.

The fields on this panel required for activation are as follows:

- Prime Contractor
- Prime Contractor’s address

To be selected as a Current Prime, a contractor must first be entered as a vendor in the Vendor reference tables.

To be selected as a Prime Associate, a Vendor must first be selected as an Associate of the Prime Contractor on the Vendor Associates folder tab. Every Contract requires two Associates - a surety company and an insurance company.

![Figure 2-8. The Prime Contractor Folder Tab](njdot.png)

NJDOT is not using the Prime Contacts area.
During the Contract Activation Process, the SM Coordinator or the Resident Engineer associates the Surety Company to the Prime Contractor. The generic insurance record X9999 Insurance – See DC 175 should also be associated to the Prime Contractor after the Contractor submits the DC 175 to NJDOT.

The SM Coordinator or the Resident Engineer also selects the appropriate Contractor’s address for the Contract.

If the Surety Company or Contractor’s Address is not available, Contact Construction Services.

**Exercise 2-7**
Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will view and update the Contract Prime Contractor folder tab.

Login: tpsjone      Group: RE      Contract: 7777A

1. Click the **Prime Contractor** folder tab.
2. Click the **Address** button.
3. In the **Address** list box, scroll to and click **To Be Determined**.
4. Click the **Services** menu, and then click the **Select Address** choice.
5. Click the **Prime Associates** area.
6. Click the **New** button.
7. Using the right mouse button, click the **Assoc Vendor ID** field.
8. From the object menu, click the **Search** choice.
9. In the **Vendor Id** list box, double-click X9999 Insurance – See DC 175.
10. Click the **New** button.
11. Using the right mouse button, click the **Assoc Vendor ID** field.
12. From the object menu, click the **Search** choice.

13. In the **Vendor Id** list box, double-click Vendor ID **A4001**, Vendor Name, **AI & ASSOC INC**.

14. Click the **Save** button.
Updating the DBE Folder Tab

The DBE Commit folder tab lets the user add and modify the DBE goal percentage and view the DBE commitments for a Contract. If the Prime Contractor is a DBE, the user can also enter the DBE Work Class on this folder tab. The system calculates the DBE commitment amounts displayed on this folder tab using values entered on the Subcontracts panel. The fields on this folder tab that are loaded from Trns•port PES/LAS and are required for activation are as follows:

- DBE Work Class (if the Prime Contractor is a DBE)
- DBE Goal Percent (if applicable)

During the Contract Activation Process, the SM Coordinator or the Resident Engineer reviews the DBE Goal Percent for accuracy.
Exercise 2-8
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will view the Contract DBE Commit folder tab.

Login: tpsjone    Group: RE    Contract: 7777A

1. Click the DBE Commit folder tab.

2. What is the DBE Goal Percent? 16%

3. Click the Close button.
Viewing and Updating the Projects Window

The Project panel contains data related to the Contract Projects. There must be at least one Project defined for each Contract.

Updating the Projects Description Folder Tab

The Project Description folder tab lets the user modify the Project’s information. Projects are loaded from Trns•port PES/LAS and may be modified during the Contract Activation Process. In NJDOT, there is one Project per Contract.

During the Contract Activation Process, the SM Coordinator or the Resident Engineer updates the Surface Type field as applicable. Throughout the life of the Project, the Resident Engineer updates the Status field to reflect the current stage of Project.
Exercise 2-9
Main Panel > Contract Administration > Contract Records > Projects

In the following exercise, you will view and update the Projects Description folder tab.

Login: tpsjone    Group: RE    Contract: 7777A

1. Double-click the Projects icon.

2. In the Project Nbr list box, scroll to and double-click PCN 7777A.

3. In the Status drop-down list, click the expand arrow and click Active Construction Project.

4. In the Surface Type drop-down list, click the expand arrow and click Bituminous (Base + Surface > 9in).

5. Click the Save button.

The Project Status is exported to the Monthly Status of Construction Report.
Viewing Project Counties

The Counties folder tab lets the user add and remove counties to and from the Project. For every county included in the Project, the user must enter the percentage of the Project work to be done in the county. The percentages for all counties must add up to 100 percent.

![Figure 2-11. The Project Counties Folder Tab](image)

**During the Contract Activation Process, the SM Coordinator or the Resident Engineer views the Counties folder tab for accuracy.**

**Exercise 2-10**
Main Panel > Contract Administration > Contract Records > Projects

In the following exercise, you will view and update the Projects Counties folder tab.

- **Login**: tpsjone  
  **Group**: RE  
  **Contract**: 7777A

1. Click the **Counties** folder tab.

2. In which County is 100 % of the work? **MORRIS**
Viewing Project Price Adjustment Indices

The Adjustment Indices folder tab lets the user add or delete a Price Adjustment Index to or from a Project. Price Adjustment Indices are used to adjust the cost of Items that are known to have fluctuating prices, such as fuel and asphalt. If the user adds an Item’s Price Adjustment Index to a Project, the index will be used during estimate process to calculate the price adjustment.

Figure 2-12. The Adjustment Indices Folder Tab

**During the Contract Activation Process, the SM Coordinator adds the appropriate Fuel and Asphalt indices.**

**The Resident Engineer reviews the Adjustment Indices for accuracy.**

The association of the fuel and asphalt adjustment indices must be done by the SM Coordinator due to security restrictions.
Exercise 2-11
Main Panel > Contract Administration > Contract Records > Projects

In the following exercise, you will view and update the Projects Adjustment Indices folder tab.

Login: tpsjone   Group: RE   Contract: 7777A

1. Click the Adjustment Indices folder tab.

2. Is there a fuel adjustment index on this Contract? Yes

3. What asphalt price adjustment index is available for this Contract?
   NASH Asphalt Price Index North of and Including Route 195.

4. Click the Close button.
Viewing the Categories Window

The Categories panel lets the user add, modify, and delete Categories. Categories are typically used to group Items within a Project that are to be funded by the same source. To do this, the user can create a Category, associate Items with the Category, and select a funding source for the Category. Each Category in a Project can have a different funding source. A Category with Items associated to it can not be deleted.

![Figure 2-13. The Category Panel](image)

During the Contract Activation Process, the SM Coordinator or the Resident Engineer views the Category window to ensure that each category is classified as Bridge or Roadway in the Suppl Wrk Cls Type field. Contact the Trns•port office if discrepancies occur.

Categories are loaded from Trns•port PES/LAS and are used to group items for funding purposes.

When a structure is deemed “Open to Traffic,” the Resident Engineer emails the SM Coordinator the associated category number and date. The SM Coordinator then enters the information in the Structure Open to Traffic Date field in the Categories Generic Fields window.

The Bridge ID, Brdg Type, Brdg Span Nbr, Brdg Length, and Brdg Width fields for Structure Categories.

The date must be entered by the SM Coordinator due to security restrictions.
Exercise 2-12
Main Panel > Contract Administration > Contract Records > Categories

In the following exercise, you will view the Category window.

Login: tpsjone  Group: RE  Contract: 7777A

1. Double-click the Categories icon.

2. How many Categories are on this Contract? 6

3. What is the Supplemental Wrk Cls Type for Category Number 0002? ROAD

4. Click the Close button.
**Updating the Items Window**

The Items panel lets the user add, modify, and delete Items on the selected Contract and Project. The transportation agency defines standard Items and lists them on the Item Master. The user adds an Item to a Contract by selecting the Item from the Item Master. After the Contract is active, Items are added through Change Orders. The Items panel fields have specific display, protection, and calculation requirements depending on whether the data was added through a Change Order.

Items that are not on the Item Master cannot be added to a Contract. To add an Item to an active Contract, refer to the Change Order Section.

![Items Panel](image)

**Figure 2-14. Items Panel**

During the Contract Activation Process, the SM Coordinator or the Resident Engineer identifies items as Pay Plan Qty or Specialty items.

The Line Item Number is the item’s ID on the selected Contract.

The Item Code is the item’s ID on the Item Master.
Exercise 2-13
Main Panel > Contract Administration > Contract Records > Items

In the following exercise, you will view and update the Items window.

Login: tpsjone  Group: RE  Contract: 7777A

1. Double-click the Items icon.

2. Click the Open button.

3. In the Project Nbr list box, scroll to and double-click PCN 7777A.

4. In the Contract Item list box, scroll to and double-click Category Nbr 0004, Line Nbr 0045, Item Code 504006P, Description Reinforcement Steel Epoxy-Coated.

5. Click the Pay Plan Qty check box ON.

6. Click the Save button.

7. Click the Close button.
Changing a Contract’s Status to Active

Contract work can not be recorded in SiteManager until the Contract status is changed from pending to active. After all required Contract data is entered, an authorized user can change the status to active.

During the Contract Activation Process, the SM Coordinator or the Resident Engineer changes the Contract Status from Pending to Active once all required information is entered in the Contracts, Projects, and Items window.
Exercise 2-14
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you change the Contract Status to Active.

Login: tpsjone   Group: RE   Contract: 7777A

1. Double-click the Contracts icon.

2. In the Status drop-down list, click the expand arrow and click Active.

3. Click the Save button.

4. Click the OK button.

5. Click the Close button.

6. Click the Main Panel folder tab.
Review for Section 2

To update the Contract Description folder tab during Contract Activation:

1. Double-click the Contract Administration icon.
2. Double-click the Contract Records icon.
3. Double-click the Contracts icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. Click the Wage Decision area.
6. Click the New button.
7. Using the right mouse button, click the Wage Decision ID field and perform a search.
8. In the Wg Dcsn ID list box, double-click WAGE.
9. Click the Generic Fields button.
10. In the Legislative drop-down list, click the expand arrow and click the desired Legislative number.
11. In the Municipality drop-down list, click the expand arrow and click desired Municipality.
12. In the Number of Lanes field, type the desired lanes.
13. Click the Generic Fields button.

To view the Contract Location folder tab during Contract Activation:

1. Double-click the Contract Administration icon.
2. Double-click the Contract Records icon.
3. Double-click the Contracts icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. Click the Location folder tab.
6. Double-click the Contract Location folder tab.

To update the Contract Payment Data folder tab during Contract Activation:

1. Double-click the Contract Administration icon.
2. Double-click the Contract Records icon.
3. Double-click the Contracts icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. Click the Payment Data folder tab.
6. In the Generate Est1 Day field, type the day of estimate generation.
7. In the Liquidated Dam Rate Amt field, type the Final Liquidated Damage amount.

To update the Contract Critical Date folder tab during Contract Activation:

1. Double-click the Contract Administration icon.
2. Double-click the Contract Records icon.
3. Double-click the Contracts icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. Click the Critical Date folder tab.
6. In the Critical Date Description list, click Execution Date.
7. In the Actual Occurrence Date field, type the execution date.
8. In the Critical Date Description list, click Price Adjustment Base Date.
9. In the Actual Occurrence Date field, type the price adjustment base date.
To update the Contract Primary Personnel folder tab during Contract Activation:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Contracts** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. Click the **Primary Personnel** folder tab.
6. Using the right mouse button, click the **Resident Engineer** field and perform a search.
7. In the **User Name** list box, double-click the Contract’s Resident Engineer’s User ID.
8. Using the right mouse button, click the **Project Manager** field and perform a search.
9. In the **User Name** list box, double-click the Contract’s Project Manager’s User ID.

To update the Prime Contractor folder tab during Contract Activation:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Contracts** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. Click the **Prime Contractor** folder tab.
6. Click the **Address** button.
7. In the **Address** list box, scroll to and click the desired address.
8. Click the **Services** menu, and then click the **Select Address** choice.
9. Click the **Prime Associates** area.
10. Click the **New** button.
11. Using the right mouse button, click the **Assoc Vendor ID** field and perform a search.
12. In the **Vendor Id** list box, double-click the Insurance vendor ID.
13. Click the **New** button.
14. Using the right mouse button, click the **Assoc Vendor ID** field and perform a search.
15. In the **Vendor Id** list box, double-click the desired Surety vendor ID.
16. Click the **Save** button.

To view the Contract DBE Commit folder tab during Contract Activation:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Contracts** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. Click the **DBE Commit** folder tab.
To update the Projects Description folder tab

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Projects** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Project Nbr** list box, scroll to and double-click the desired PCN.
6. In the **Status** drop-down list, click the expand arrow and click current status of the Project.
7. In the **Surface Type** drop-down list, click the expand arrow and click the current surface type for the Project.
8. Click the **Save** button.

To update the Projects Counties folder tab during Contract Activation:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Projects** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Project Nbr** list box, scroll to and double-click the desired PCN.
6. Click the **Counties** folder tab.
7. Click the **Available Counties** area.
8. Select the desired County and click the **Add** button.
9. In the **Proj Len % field**, type the percentage of the project being completed in the county.
10. Click the **Save** button.

To update the Projects Adjustment Indices during Contract Activation:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Projects** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Project Nbr** list box, scroll to and double-click the desired PCN.
6. Click the **Price Adjustment Indices** folder tab.
7. Click the **Available Price Indices** area.
8. Click the desired price indices and click the **Add** button.
9. Click the **Save** button.
To view the Category window during Contract Activation:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Categories** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **PCN** list box, scroll to and double-click the desired Project Number.
6. Click the **Close** button.

To update the Items window during Contract Activation:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Items** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Project Nb** list box, scroll to and double-click the desired PCN.
6. In the **Contract Item list** box, scroll to and double-click desired item.
7. Click the **Pay Plan Qty** check box **ON**.
8. Click the **Save** button.
9. Click the **Open** button.
10. Repeat steps 6-8 for all Pay Plan Quantity items.
11. In the **Contract Item list** box, scroll to and double-click desired item.
12. Click the **Specialty** check box (ON).
13. Click the **Save** button.
14. Click the **Open** button.
15. Repeat steps 11-14 for all Specialty items.
16. Click the **Close** button.

To change the Contract Status to Active during Contract Activation:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Contracts** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Status** drop-down list, click the expand arrow and click **Active**.
6. Click the **Save** button.
7. Click the **OK** button.
8. Click the **Close** button.
Summary for Section 2

In the following exercise, you will activate a Contract.

Login: tpsjone       Group: RE       Contract: 8888A

1. Navigate to the Contracts window and open Contract ID 8888A.

2. Associate the Wage Decision.

3. Associate the Contract to Legislative District 15 and Municipality Morris-Mount Arlington.

4. Enter 2 as the Number of Lanes affected by the Contract.

5. What is the Primary County? _____________________________________________

6. Enter 7 as the Generate Est 1 Day and 1500.00 as the Liquidated Damage rate.

7. Enter 08/06/08 as the Execution Date and 07/28/08 as the Price Adjusted Base Date.

8. Enter Jones, Kelly as the Resident Engineer and Jackson, Bailey as the Project Manager.

9. Associate the ‘To Be Determined’ Address to the Contract.

10. Associate the Surety Company and the Generic Insurance to the Contractor.

11. What is the DBE Goal Percent? __________ 16%

12. Navigate to the Projects window and open Project Nbr 8888A.

13. Change the Project Status to Active Construction Project.

14. Change the Surface Type to Bituminous (Base + Surface < 9in).

15. Navigate to the Categories window.

16. What is the Suppl Wrk Cls Type for Category Number 0002?

   Road

17. Navigate to the Contracts window and change the Contracts Status to Active.

18. Navigate to the Main Panel.
This page intentionally left blank.
3 Preparing for Work

By the end of this section, you will be able to:

- Create and Print the DC 34 Key Contact Personnel Report
- Identify Construction Layout Items
- Establish Contract Manpower Information
- View the Contract Authority Window
- Create a Correspondence Log Record for the Preconstruction Meeting Minutes
- Add Permits
- Establish Key Dates
- Establish the Checklist Event Schedule
- View Subcontracts
- Create the Contract’s Master List of Equipment, Personnel Types, and NJDOT Activities
- Associate DWR Templates
- Enter the Work Begin Date and the Official Contract Start Date
Creating and Printing the DC 34 Key Contact Personnel Report

The information used to create the DC 34 Key Contact Personnel Report is entered in SiteManager Contracts window. DC 34 Key Contact Personnel Report is generated through Crystal Reports, accessible through the SiteManager Reports icon.

Creating the DC 34 Key Contact Personnel Report

The information printed in the DC 34 Key Contact Personnel Report is generated in multiple areas of SiteManager. For example, the person who is entered in the Resident Engineer field on the Contracts window is the person whose name appears in the DC 34 Key Contact Personnel Report. Additional information used in the report is manually entered in the Custom Contract Usage Record window, accessible through the Services menu in the Contracts window. Authorized users may access the DC 34 Key Contact template and enter the contact information required for the Contract.

Figure 3-1. DC 34 Key Contact Personnel Custom Contract Template

The Resident Engineer or his designee enters the information required to generate the DC 34 Key Contact Personnel Report in the Custom Contract Template in the Contracts window.

The DC 34 Key Contact Personnel information is to be updated throughout the life of the Contract.
Exercise 3-1
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will create the DC 34.

Login:  tpxxxxx  Group: RE  Contract: ID

1. Click the Contract Administration icon.
2. Click the Contract Records icon.
3. Double-click the Contracts icon.
4. Click the Open button.
5. In the Contract ID list box, scroll to and double-click Contract ID.
6. Click the Services menu, and then click the Custom Record choice.
7. Using the right mouse button, click the Template Id field.
8. From the object menu, click the Search choice.
9. In the list box, scroll to and double-click Template ID DC 34 Key Contact Personnel.
10. In the Revision Number field, type 1.
11. In the Project Superintendent field, type the name of the Project Superintendent.
12. In the Project Superintendent Home Phone field, type the Home Phone number of the Project Superintendent.
13. In the Project Superintendent Cellular field, type the Cellular Phone number of the Project Superintendent.
14. In the 1st Alternative field, type the name of the 1st Alternative.
15. In the 1st Alternative Home Phone field, type the Home Telephone number of the 1st Alternative.

Phone numbers should be entered without slashes or parenthesis. The DC 34 Report will apply correct formatting.
16. In the **1st Alternative Cellular** field, type the Cellular Phone number of the 1st Alternative.

17. In the **Traffic Coordinator (1)** field, type the name of the Traffic Coordinator (1).

18. In the **Traffic Coordinator (1) Home Phone** field, type the Home Telephone number.

19. Click the **Save** button.

20. Click the **Close** button.

21. Click the **Close** button.

22. Click the **Main Panel** folder tab.

Typically, the whole template should be populated. We are only populating a few fields due to time constraints of the Training class.
Printing the DC 34 Key Contact Personnel Report

The DC 34 Key Contact Personnel Report is a custom NJDOT report generated through Crystal Reports. Crystal Reports can be accessed directly through a web browser or through the SiteManager Reports icon on the Main Panel. Once in Crystal Reports, the user must identify the parameters for the generation of the report. The DC 34 Key Contact Personnel Report can be generated by Contract, Region, or Statewide.

![Parameter Table]

Figure 3-2. DC 34 Key Contact Personnel Report Parameters

The Resident Engineer or his designee generates the DC 34 Key Contact Personnel Report for distribution.

The DC 34 Key Contact Personnel Report may be regenerated and printed throughout the life of the Contract.

---

Exercise 3-2

Main Panel > Reports

In the following exercise, you will view the DC 34.

Login: tpxxxxx  Group: RE  Contract: 8888B

1. Double-click the Reports icon.
2. Double-click the Key Contact Personnel Report.
3. Who is the Resident Engineer? Kelly Jones
4. Click the Close button.
5. Click the Close button to return to SiteManager.

Refer to the Review section for Crystal Reports steps.
Identifying Construction Layout Items

The Construction Layout Program is a custom program developed for the specific use of NJDOT to identify items on the Contract that should not be included in the construction layout adjustment calculations. The Construction Layout Program is accessed as an attachment in the Contracts window.

The Construction Layout Program lists all items on the Contract. The users should click the Exclude check box if the item should not be included in the construction layout adjustment calculations. During the Contract Finalization Process, the Construction Layout Report will calculate the construction layout adjustment using data from all items that have not been excluded in the Construction Layout Program. By default ALL items are included in the construction layout adjustment calculations.

![Construction Layout Program](image)

Figure 3-3. Construction Layout Items

The Resident Engineer or his designee identifies the items that are to be excluded from construction layout adjustment calculations in the Construction Layout Program.

The Construction Layout Program may be modified throughout the life of the Contract.

If an item is added via Change Order and should not be included in the adjustment calculations, it should be identified in the Program once the Change Order is approved.
Exercise 3-3
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will identify items to be excluded from the Construction Layout calculations.

Login: tpxxxxx  Group: RE  Contract: ID

1. Double-click the Contract Administration icon.

2. Double-click the Contract Records icon.

3. Double-click the Contracts icon.

4. Click the Attachments button.

5. Double-click the Construction Layout Program attachment.

6. Scroll to and click the Exclude check box for the following items:
   A. Category Nbr 0001, Line Nbr 0001, Item Code 151003M, Description Performance Bond and Payment Bond.
   B. Category Nbr 0001, Line Nbr 0003, Item Code 153003P, Description Progress Schedule.
   C. Category Nbr 0001, Line Nbr 0004, Item Code 154003P, Description Mobilization.
   D. Category Nbr 0002, Line Nbr 0005, Item Code 155006M, Description Field Office Type B Set Up.
   E. Category Nbr 0002, Line Nbr 0006, Item Code 155024M, Description Field Office Type B Maintenance.
   F. Category Nbr 0005, Line Nbr 0042, Item Code 157003M, Description Construction Layout.

7. Click the Save button.

8. Click the Close button.
Establishing Contract Manpower Information

The Contract Manpower Program is a custom program developed for the specific use of NJDOT to capture the planned hours as well as the Daily hours of individuals working on a Contract. The Contract Manpower Program is accessed as an attachment in the Contracts window.

Viewing the Contract’s Planned Hours

The planned hours for the Contract are generated by the Bureau of Construction Management and entered into the Contract Manpower Program on the Planned Hours folder tab by the SiteManager Coordinator. The Planned Hours may be updated throughout the life of the Contract.

![Planned Hours Folder Tab](image)

Figure 3-4. Planned Hours Folder Tab

The SiteManager Coordinator enters and updates the planned hours for the Contract in the Contract Manpower Program.
Exercise 3-4
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will view the planned man hours for the Contract.

Login:  tpxxxx  Group: RE  Contract: ID

1. Double-click the Contract Manpower Program attachment.

2. Click the Planned Hours folder tab.

3. How many hours are planned for the Resident Engineer on this Contract? 770

4. How many hours are planned for State Police for this Contract? 480
Establishing Contract Manpower Personnel

The Contract personnel whose activities and work hours will be tracked on the Contract must first be identified on the Contract Personnel folder tab in the Contract Manpower Program.

Available Personnel (Construction/Operations, Consultants, and Material Users) are listed on the left side of the window. To associate personnel to the Contract, scroll to and click the desired personnel in the Available Personnel list and then click the Add button. Personnel associated to the Contract are listed in the Contract Personnel box. Personnel may be removed from the Contract by clicking the desired personnel in the Contract Personnel box and then clicking the Remove button. If the desired personnel is not available in the Available Personnel box, then the Trns•port Office should be contacted.

The personnel associated with the Contract will appear on the Weekly Hours folder tab and will be available for recording activity hours. Materials personnel will not appear by name on the Weekly Hours folder tab, but they should still be associated to the Contract for reporting on the Weekly Report.

If a consulting firm is used for inspection on the Contract then the prime consulting firm should also be selected on the Contract Personnel folder tab. If the consulting firm is not available, then the Trns•port Office should be contacted.

![Contract Personnel Folder Tab](image)

Figure 3-5. Contract Personnel Folder Tab

Materials personnel will not appear on the Weekly Hours folder tab, but will be included on the Weekly Report.
The Resident Engineer or his designee associates personnel to be tracked on the Contract in the Contract Manpower Program.

If a consulting firm is used, the Resident Engineer or his designee also selects the prime consulting firm. If the consulting firm is not available in the drop-down list, contact the Transport office.

Exercise 3-5
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will add personnel to the Contract Manpower Program.

Login: tpxxxxx Group: RE Contract: ID

1. Click the Contract Personnel folder tab.
2. In the Available Personnel List, scroll to and click Allen, Sidney.
3. Click the Add button.
4. In the Available Personnel List, scroll to and click Brown, Sam.
5. In the Available Personnel List, scroll to and click Eaker, Bobby.
6. In the Available Personnel List, scroll to and click Jones, Kelly.
7. In the Available Personnel List, scroll to and click Lewis, Tyler.
8. In the Available Personnel List, scroll to and click Miller, Carson.
9. In the Available Personnel List, scroll to and click Rodriguez, Angel.
10. Click the Add button.
11. Click the Close button.

Personnel can be added individually or by selecting multiple users at a time.
12. Click the **Close** button.
Viewing the Contract Authority Window

Contract Authority gives the user the authority to view or modify a specific Contract. Contract Authority works in conjunction with other security features. The user’s ability to add, modify, or delete Contract data also depends on the user group window access rights, the office level assignment, and whether or not the user has Global (Office-wide) Contract Access, and the user’s group assignments.

If a user is assigned to different groups, the user can have different Contract authority assignments for each group. For example, John Doe may be assigned to the Inspector and Office Engineer groups. As a Inspector, he may access contracts A and B. As the Office Engineer, he may only access Contract A.

![Contract Authority Panel](image)

Figure 3-6. The Contract Authority Panel

In NJDOT all field personnel will have Contract specific authority.
The Resident Engineer emails the SM Coordinator with field personnel names, group access, and Contract ID information. Additionally, users in the Change Order Review Process, such as the Field Manager and the Regional Construction/Maintenance Engineer, are to be given specific Contract Authority.

The SiteManager Coordinator grants and ends Contract Authority. Contract Authority can be modified throughout the life of the Contract.

Exercise 3-6
Main Panel > Contract Administration > Contract Records> Contract Authority

In the following exercise, you will view users to the Contract Authority window.

Login: tpxxxxx Group: RE Contract: ID

1. Double-click the **Contract Authority** icon.

2. In the **User Identification** list box, scroll to and click User ID tpslew, User Name Lewis, Tyler.

3. Does Tyler Lewis have Office-Wide or Contract specific authority in SiteManager?  

4. In the **User Identification** list box, scroll to and click User ID tpsalle, User Name Allen, Sidney.

5. What Group access does Sidney Allen have in SiteManager?  

6. Click the **Close** button.
Creating a Correspondence Log Record for the Preconstruction Meeting Minutes

The Preconstruction Meeting Minutes should be recorded in the Correspondence Log window, and the meeting minutes should be attached to the record as a SiteManager attachment.

Creating the Correspondence Log Record

The Correspondence Log panel lets the user add and modify records of correspondence related to a specific Contract. A correspondence record describes a document that has been either sent or received by a user. The user can describe the document, identify related records and disputes, attach reference documents, forward the correspondence record to other users, and open reference documents that have been received with correspondence records from other users.

![Correspondence Log Panel](image)

Figure 3-7. The Correspondence Log Panel

In the NJDOT, the Resident Engineer or his designee creates a Correspondence Log record to record communications regarding the Contract. If available, the communication (email, letter, meeting minutes, etc) is to be attached to the Correspondence Log record using the Attachments feature.
Creating an Attachment

The Attachment functionality of SiteManager allows URL links, Plug-In applications, and OLE attachments to be attached to certain SiteManager records. Attachments are activated by clicking the attachment button, then double-clicking the attachment.

The Microsoft Windows’ Object Linking and Embedding standard (OLE) allows Windows programs like SiteManager to access the functionality of other OLE-compliant Windows applications. The Attachments feature choice will work with any properly-installed, OLE-compliant Windows application.

When you use the OLE functionality to create a new attachment, you are actually embedding the data and the connection to the application’s functionality in the SiteManager database. Even though the OLE object is assigned a name, the data does not actually exist as an external file on your network or workstation hard drive. It only exists as a named object in the SiteManager database. Anyone with access to the record can assess the embedded data if the application that created the data is installed on their workstation.

![Attachment window](image)

Figure 3-8. The Attachment window
In NJDOT, attachments in SiteManager are limited to PDF, Word, and Excel files. All other file formats including pictures are to be maintained as project documentation outside of SiteManager.

Attachments are to be identified with the following naming convention:

YYYYMMDDAAAA = Year, Month, Day, and abbreviation of the attached document.

A description is to be included for each attachment. When selecting Security Groups for attachments, “Add All” should be selected.

---

**Exercise 3-7**

Main Panel > Contract Administration > Contract Records > Correspondence Log

In the following exercise, you will create a Correspondence Log record to record the Construction Conference Meeting Minutes.

Login:  tpxxxxx  Group: RE  Contract: ID

1. Double-click the **Correspondence Log** icon.

2. Click the Service menu, and then click the **Choose Keys** choice.

3. In the **Contract ID** list box, scroll to and double-click Contract ID **ID**.

4. In the **Correspondence Type** drop-down list, click the expand arrow and click **Memo**.

5. In the drop-down list, click the expand arrow and click **Received**.

6. In the **On** field, type **080708**.

7. In the **Sent From** field, type **Andy Clay, Regional Construction Engineer**.

8. In the **Sent To** field, type **Kelly Jones**.

9. In the **Document Category** drop-down list, click the expand arrow and click **Meeting Minutes**.
10. In the **Major Topics** field, type **Preconstruction Conference Meeting Minutes**.

11. Click the **Save** button.

12. Click the **Attachments** button.

13. Click the **New OLE** button.

14. Click the **Create from File** button.

15. Click the **Browse** button.

16. Click the **PCMM file to be attached in the following location: c:\smtrains\smfiles.**

17. Click the **Open** button.

18. Click the **OK** button.

19. In the **Name** field, type **20080807PCMM**.

20. In the **Description** field, type **Precon Meeting Minutes**.

21. In the **Attachment Security** box, click the **Add All** button.

22. Click the **Add** button.

23. Click the **Save** button.

24. Click the **Close** button.
Adding Permits

The Permits panel lets the user add, modify, and delete Contract permit data. This is a record of the permits obtained for the Contract, including the permit type, the person who requested the permit, and the date the request was submitted. The top datawindow lists the permits for the selected Contract. The data for the selected record is displayed in the bottom datawindow.

![Permit Data Window]

Figure 3-9. The Permits Panel

The Resident Engineer or his designee enters permits obtained for the Contract, in the Permits window.

The Permits window can be modified throughout the life of the Contract.
Exercise 3-8
Main Panel > Contract Administration > Contract Records > Permits

In the following exercise, you will add a permit to the Contract.

Login: tpxxxxx   Group: RE   Contract: ID

1. Double-click the Permits icon.

2. In the Permit Type drop-down list, click the expand arrow and click NJDEP Highlands Preservation Area.

3. In the Submitted Date field, type 072108.

4. In the Effective Date field, type 080108.

5. In the Expiration Date field, type 073109.

6. In the Permit Number field, type HPA-113-2008.

7. Click the Save button.

8. Click the Close button.
Scheduling Key Dates and Checklist Events

Key Dates and Checklist Events are the SiteManager components that let the user establish and monitor a series of key dates and scheduled events. Key Dates and Checklist Events, although similar in functionality, are independent events.

Key Dates are dates that are important when they occur. Therefore, personnel are notified when a Key Date is accomplished. They are also notified when a Key Date is not accomplished by the projected date. A Key Date can be set up to be required either when the Contract is activated or when it is finalized. The user creates the Key Date schedule and records the actual occurrences of Key Dates on the Key Dates panel.

Checklist Events are actions that are important when they do not occur. Therefore, personnel are notified when a Checklist Event is not accomplished by the projected date. For Checklist Events that occur more than once or at regular intervals (e.g., monthly or weekly), SiteManager tracks each occurrence. A Checklist Event can be set up to be required when the Contract is activated or finalized, or to cause a discrepancy when estimates are generated. The user creates the Checklist Event schedule on the Checklist Scheduled Events panel.

The Checklist Event Dates panel lets the user view the Checklist Event schedule, including multiple occurrences of each event, and provides a chronological history of the events. The user records the actual occurrences of the Checklist Events in the Checklist Events window.
Establishing Key Dates

The Key Dates panel lists the Key Dates for the selected Contract in the top datawindow. The data for the selected Key Date is displayed in the bottom datawindow. The Key Date Types are pre-defined in the SiteManager code tables. SiteManager adds a set of default Key Dates automatically to each new Contract. The user creates the Key Date schedule and records the actual occurrence of Key Dates on this panel. The user can add, modify, and delete the Key Dates.

<table>
<thead>
<tr>
<th>Key Date Type</th>
<th>Message Text</th>
<th>Projected Date</th>
<th>Dist. List/ Recipt.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acceptance Inspection</td>
<td>The acceptance inspection was held.</td>
<td>Final Completion Date</td>
<td>Construction-Close Out Distribution List&lt;br&gt;Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>All Required Material Certs and Drawings</td>
<td>All required material certifications and drawings have been submitted.</td>
<td>Final Completion Date</td>
<td>Construction – Close Out Distribution List&lt;br&gt;Operations – Project Manager Recipient</td>
</tr>
<tr>
<td>All Required Payrolls and EEO Statements</td>
<td>All required payrolls and EEO statements have been submitted.</td>
<td>Final Completion Date</td>
<td>Construction-Close Out Distribution List&lt;br&gt;Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>All Required Releases Received</td>
<td>All required releases have been received from the Contractor.</td>
<td>Final Completion Date</td>
<td>Construction-Close Out Distribution List&lt;br&gt;Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>All ROW Issues Resolved</td>
<td>All ROW and encroachment issues have been resolved.</td>
<td>Final Completion Date</td>
<td>Construction-Close Out Distribution List&lt;br&gt;Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>As-Built Qtys Agreed to by Contractor</td>
<td>As-built quantities have been agreed to by the Contractor.</td>
<td>Final Completion Date</td>
<td>Construction-Close Out Distribution List&lt;br&gt;Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>Key Date Type</td>
<td>Message Text</td>
<td>Projected Date</td>
<td>Dist. List/ Recipt.</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>As-Built Qtys Reviewed by BCE</td>
<td>As-built quantities have been reviewed by the Bureau of Construction Engineering.</td>
<td>Final Completion Date</td>
<td>Construction-Close Out Distribution List Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>As-Built Qtys Sent to Contractor</td>
<td>As-built quantities have been sent to the Contractor.</td>
<td>Final Completion Date</td>
<td>Construction-Close Out Distribution List Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>Close Out Meeting Held</td>
<td>The close out meeting was held.</td>
<td>Substantial Completion Date</td>
<td>Construction-Close Out Distribution List Operations-Project Manager Recipient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If a meeting is not required, then the date the letter is sent notifying the contractor is entered in the actual date field.</td>
<td></td>
</tr>
<tr>
<td>Completion Date</td>
<td>The Contract is Complete.</td>
<td>Final Completion Date</td>
<td>Construction-Close Out Distribution List Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>Construction Completion</td>
<td>Construction is complete and verified by the Corrective Action Inspection.</td>
<td>Between Substantial Completion Date and Final Completion Date.</td>
<td>Construction-Close Out Distribution List Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>Corrective Action Inspection</td>
<td>The corrective action inspection was held.</td>
<td>Substantial Completion Date</td>
<td>Construction-Close Out Distribution List Operations-Project Manager Recipient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The actual date field is to be populated with the date the first corrective action inspection took place.</td>
<td></td>
</tr>
<tr>
<td>DC 23 Tabulation of Working Days Comp.</td>
<td>DC 23 Tabulation of Working Days is complete.</td>
<td>Final Completion Date</td>
<td>Construction-Close Out Distribution List Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>DC 123 Final Certification of Compliance</td>
<td>DC 123 Final Certification of Compliance has been received.</td>
<td>Final Completion Date</td>
<td>Construction-Close Out Distribution List Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>Key Date Type</td>
<td>Message Text</td>
<td>Projected Date</td>
<td>Dist. List/ Recipt.</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------------------------------------</td>
<td>-------------------------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>Final Contract Status Memo Submitted</td>
<td>Final Contract Status Memo has been submitted by Close Out Engineer.</td>
<td>Final Completion Date</td>
<td>Construction-Close Out Distribution List Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>LB 95A Materials Cert</td>
<td>LB 95A has been sent to the Bureau of Materials.</td>
<td>Final Completion Date</td>
<td>Construction-Close Out Distribution List Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>Letter of Corrective Work to Contractor</td>
<td>The letter of corrective work has been sent to the contractor.</td>
<td>Substantial Completion Date</td>
<td>Construction-Close Out Distribution List Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>Mylars Submission</td>
<td>Mylars received from Contractor</td>
<td>Final Completion Date</td>
<td>Construction-Close Out Distribution List Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>Notice of Completion</td>
<td>Contractor notification that all work is complete has been received.</td>
<td>Final Completion Date</td>
<td>Construction-Close Out Distribution List Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>Pavement As-Built Data</td>
<td>Pavement as-built data form has been submitted.</td>
<td>Final Completion Date</td>
<td>Construction-Close Out Distribution List Operations-Project Manager Recipient</td>
</tr>
<tr>
<td>RE Estimated Completion Date</td>
<td>This is the Resident Engineer’s estimated completion date. RE should determine this date on a Contract basis. The RE enters the Projected Date with his estimated completion date during the activation process. If the estimated date changes, then the projected date is modified accordingly. The Actual Date field remains blank.</td>
<td>Final Completion Date</td>
<td>Construction – Field Manager Operations – Project Manager</td>
</tr>
</tbody>
</table>

- **Key Date Settings**

  - **Final Contract Status Memo Submitted**: Final Contract Status Memo has been submitted by Close Out Engineer.
  - **LB 95A Materials Cert**: LB 95A has been sent to the Bureau of Materials.
  - **Letter of Corrective Work to Contractor**: The letter of corrective work has been sent to the contractor.
  - **Mylars Submission**: Mylars received from Contractor.
  - **Notice of Completion**: Contractor notification that all work is complete has been received.
  - **Pavement As-Built Data**: Pavement as-built data form has been submitted.
  - **RE Estimated Completion Date**: This is the Resident Engineer’s estimated completion date. RE should determine this date on a Contract basis. The RE enters the Projected Date with his estimated completion date during the activation process. If the estimated date changes, then the projected date is modified accordingly. The Actual Date field remains blank.
## Key Date Settings

<table>
<thead>
<tr>
<th>Key Date Type</th>
<th>Message Text</th>
<th>Projected Date</th>
<th>Dist. List/ Recipt.</th>
</tr>
</thead>
<tbody>
<tr>
<td>RE Memo of Corrective Work</td>
<td>The memo indicating corrective work is complete has been sent.</td>
<td>Final Completion Date</td>
<td>Construction-Close Out Distribution List Operations-Project Manager Recipient</td>
</tr>
</tbody>
</table>

Table 3-1. NJDOT Key Dates

![Key Dates Window](image)

Figure 3-10. The Key Dates Window
The Resident Engineer or his designee schedules projected dates and enters actual dates for Key Dates.

All default Key Dates will appear for the Contract when the Contract is loaded into SiteManager. Prior to the first estimate, the Resident Engineer or his designee performs the following functions:

Delete the Key Dates that do not apply to the Contract.

Enter the Projected Date.

Enter the Recipient or Distribution List.

The Resident Engineer or his designee updates the projected date for the RE Estimated Completion date throughout the life of the Contract as necessary and enters the actual date for each Key Date as it occurs.

Exercise 3-9
Main Panel > Contract Administration > Contract Records > Key Dates

In the following exercise, you will establish the Key Dates for the Contract.

Login: tpxxxx Group: RE Contract: ID

1. Double-click the Key Dates icon.

2. In the Key Date Type list, click RE Estimated Completion Date.

3. In the Projected Date field, type 102708.

4. In the Recipient field, perform a Search and double-click User ID tpswarr, User Name Warren, Jackie.

5. Click the Save button.

6. In the Key Date Type list, click All ROW Issues Resolved.

7. Click the Delete button.

8. Click the Yes button.
9. Click the **Save** button.

10. In the **Key Date Type** list, click **Acceptance Inspection**.

11. In the **Projected Date** field, type **110508**.

12. In the **Distribution List** field, perform a **Search** and double-click **Close Out North**. Depending on previous steps, the Distribution List field may be gray. You may still update this field.

13. Click the **Save** button.

14. In the **Key Date Type** list, click **All Required Material Certs and Drawings**.

15. In the **Projected Date** field, type **110508**.

16. In the **Distribution List** field, perform a **Search** and double-click **Close Out North**. Typically, all Key Dates should be reviewed. We are only reviewing a few dates due to time constraints of the Training class.

17. Click the **Save** button.

18. Click the **Close** button.
Establishing the Checklist Event Schedule

The Checklist Scheduled Events panel lists the scheduled events for the selected Contract. The data for the event selected in the top data window is displayed in the bottom data window. The Event Types are pre-defined in the SiteManager code tables. SiteManager adds a set of default Checklist Events automatically to each new Contract. The user creates the Checklist Event schedule on this panel. The user can add, modify, and delete the Checklist Events.

When an event is scheduled on this panel, a subsequent batch process creates a record for each projected date. After the batch process runs, the user can record the Actual Date of each occurrence of an event on the Checklist Event Dates panel. The batch process and/or an estimate discrepancy may notify the recipient(s) when a Checklist Event is overdue.

When establishing the schedule for a One Time Only event, a 1 must be entered in the Nbr of Occurrences field. If this field is gray, select a different frequency type such as Quarterly, enter a 1 in the Nbr of Occurrences field, and then return the Frequency Type to One Time Only.

This paragraph explains the work around for the One Time Only checklist events.
<table>
<thead>
<tr>
<th>Checklist Event Type</th>
<th>Event Group Type</th>
<th>Freq.</th>
<th>Event Day</th>
<th>Recipient</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>1391</td>
<td>EEO</td>
<td>Annual</td>
<td>August 12th</td>
<td>Civil Rights Compliance Unit</td>
<td>&quot;The July Report&quot; (1391) has not been received.</td>
</tr>
<tr>
<td>AD 267</td>
<td>EEO</td>
<td>Monthly</td>
<td>Estimate Day - 1</td>
<td>Civil Rights DBE Unit</td>
<td>Monthly DBE Utilization Report has not been received.</td>
</tr>
<tr>
<td>AD 268</td>
<td>EEO</td>
<td>One Time Only</td>
<td>Contract completion Date plus 2 months</td>
<td>Civil Rights DBE Unit</td>
<td>Final DBE Utilization Report has not been received.</td>
</tr>
<tr>
<td>DC 127</td>
<td>EEO</td>
<td>Monthly</td>
<td>Estimate Day - 1</td>
<td>Civil Rights Compliance Unit</td>
<td>DC 127 has not been completed.</td>
</tr>
<tr>
<td>FHWA 1409</td>
<td>EEO</td>
<td>Quarterly</td>
<td>Week after quarter begins</td>
<td>Civil Rights Compliance Unit</td>
<td>Quarterly Training Report has not been received.</td>
</tr>
<tr>
<td>Ins- Comprehensive Auto Liab.</td>
<td>Insurance</td>
<td>Annual</td>
<td>2 months prior to expiration</td>
<td>Construction – Field Manager Operations – Project Manager</td>
<td>Policy has not been renewed</td>
</tr>
<tr>
<td>Ins- Comprehensive General Liab.</td>
<td>Insurance</td>
<td>Annual</td>
<td>2 months prior to expiration</td>
<td>Construction – Field Manager Operations – Project Manager</td>
<td>Policy has not been renewed</td>
</tr>
<tr>
<td>Ins- Excess Liab.</td>
<td>Insurance</td>
<td>Annual</td>
<td>2 months prior to expiration</td>
<td>Construction – Field Manager Operations – Project Manager</td>
<td>Policy has not been renewed</td>
</tr>
<tr>
<td>Ins- Marine General Liab.</td>
<td>Insurance</td>
<td>Annual</td>
<td>2 months prior to expiration</td>
<td>Construction – Field Manager Operations – Project Manager</td>
<td>Policy has not been renewed</td>
</tr>
<tr>
<td>Ins- Owner and Cont. Protective Liab.</td>
<td>Insurance</td>
<td>Annual</td>
<td>2 months prior to expiration</td>
<td>Construction – Field Manager Operations – Project Manager</td>
<td>Policy has not been renewed</td>
</tr>
<tr>
<td>Ins- Pollution Liab.</td>
<td>Insurance</td>
<td>Annual</td>
<td>2 months prior to expiration</td>
<td>Construction – Field Manager Operations – Project Manager</td>
<td>Policy has not been renewed</td>
</tr>
</tbody>
</table>
# NJDOT Checklist Events

<table>
<thead>
<tr>
<th>Checklist Event Type</th>
<th>Event Group Type</th>
<th>Freq.</th>
<th>Event Day</th>
<th>Recipient</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ins.- Railroad Protective Liab.</td>
<td>Insurance</td>
<td>Annual</td>
<td>2 months prior to expiration</td>
<td>Construction – Field Manager Operations – Project Manager</td>
<td>Policy has not been renewed</td>
</tr>
<tr>
<td>Ins- Workers Comp and Employers Liab.</td>
<td>Insurance</td>
<td>Annual</td>
<td>2 months prior to expiration</td>
<td>Construction – Field Manager Operations – Project Manager</td>
<td>Policy has not been renewed</td>
</tr>
<tr>
<td>Monthly Training Report</td>
<td>EEO</td>
<td>Monthly</td>
<td>Second Monday of the Month</td>
<td>Civil Rights Compliance Unit</td>
<td>Monthly Training Report has not been received.</td>
</tr>
<tr>
<td>TAD 1276/CC257</td>
<td>EEO</td>
<td>Monthly</td>
<td>Estimate Day - 1</td>
<td>Civil Rights Compliance Unit</td>
<td>Monthly Workforce Utilization Report for Prime and subs has not been received.</td>
</tr>
</tbody>
</table>

Table 3-2. NJDOT Checklist Event Dates

![Checklist Scheduled Events](image)

Figure 3-11. The Checklist Scheduled Events Window
The Resident Engineer or his designee creates the checklist event schedule.

All default checklist events will appear for the Contract when the Contract is loaded into SiteManager. Prior to the first estimates, the Resident Engineer or his designee will perform the following functions:

- Delete the checklist events that do not apply to the Contract.
- Enter the Next Projected Date.
- Enter the Recipient or Distribution List
- Enter the Number of Occurrences as 999 for Monthly, annual, and quarterly events.
Exercise 3-10
Main Panel > Contract Administration > Contract Records > Checklist Scheduled Events

In the following exercise, you will establish the Checklist Event Schedule for the Contract.

Login: tpxxxxx    Group: RE    Contract: ID

1. Double-click the Checklist Scheduled Events icon.
2. In the Event Type list, click Ins-Railroad Protective Liab.
3. Click the Delete button.
4. Click the Yes button.
5. Click the Save button.
6. In the Event Type list, click Ins-Marine General Liab.
7. Click the Delete button.
8. Click the Yes button.
9. Click the Save button.
10. In the Event Type list, click AD 268.
11. In the Next Proj Date field, type 010509.
12. In the Frequency Type drop-down list, click the expand arrow and click Quarterly.
13. In the Number of Occurrences field, type 1.
14. In the Frequency Type drop-down list, click the expand arrow and click One Time Only.
15. In the Recipient field, perform a Search and double-click tpsreed, User Name Reed, Logan.
16. Click the Save button.
17. In the Event Type list, click DC 127.
18. In the Next Proj Date field, type 090408.

The steps for AD 268 show the work around for the One Time Only checklist events.
19. In the **Number of Occurrences** field, type **999**.

20. In the **Recipient** field, perform a Search and double-click **tpsmorr**, User Name **Morris, Jaime**.

21. Click the **Save** button.

22. In the **Event Type** list, click **Ins-Comprehensive Auto Liab**.

23. In the **Next Proj Date** field, type **010509**.

24. In the **Number of Occurrences** field, type **999**.

25. In the **Recipient** field, perform a Search and double-click User ID **tpswarr**, User Name **Warren, Jackie**.

26. Click the **Save** button.

27. Click the **Close** button.

28. Click the **Contract Administration** folder tab.

---

The number 999 can be entered in the gray field.

All additional fields should be left blank.

Typically, all Checklist Events should be reviewed. We are only reviewing a few events due to time constraints of the Training class.
Viewing Subcontracts

The Subcontract panel lets the user add, modify, and delete Subcontracts and Subcontract data. The panel also displays calculated DBE commitment amounts.

Viewing a Subcontract Description

The user enters the Subcontractor and DBE commitments on the Description folder tab. To be selected as a Subcontractor, a contractor must first be entered as a vendor in the Vendor reference tables. When a new Subcontract is saved, the system adds the Subcontract amount to the total amount of uncompleted work for the Subcontractor. This value is displayed on the Vendors panel in Reference Tables (CA). The Contract’s Prime Contractor can not be selected as a Subcontractor on the Contract.

The percentage of the Subcontract that can be counted towards the Contract’s DBE goal depends on the Subcontract’s level, the Subcontractor’s DBE status, and whether or not the Subcontract includes Items. A Subcontract with a DBE Subcontractor and Items is always counted 100 percent towards the Contract’s DBE goal. If the Subcontract has no Items (i.e., the Subcontractor is a supplier/hauler), the user enters the percentage counted towards the DBE goal.

If the Subcontractor is not a supplier or hauler, Items must be added to the Subcontract.

![Subcontracts Table]

Figure 3-12. The Subcontract Description Folder Tab
The Subcontract Coordinator enters subcontracts in SiteManager once the subcontract has been approved by Construction Services.

The Subcontract must be entered in SiteManager with an approval date before work can be recorded to the Subcontractor on a Daily Work Report.

Subcontracts can be added at any point in the Contract.

Exercise 3-11

Main Panel > Contract Administration > Contractor Management > Subcontracts

In the following exercise, you will view a Subcontract to the Contract.

1. Double-click the Contractor Management icon.
2. Double-click the Subcontracts icon.
3. In the Subcontract list box, scroll to and double-click subcontract Nbr 001, subcontractor AMERICAN SAFETY SVS INC.
4. Is this subcontractor a DBE? No
5. What is the approval Date? 08/07/08
**Viewing Subcontract Items**

The Subcontract Items folder tab lets the user add, modify, and delete Subcontract Items. If the Subcontractor is a hauler or supplier only, the Subcontract will not have Items. If the Subcontract has no Items, the user must enter the Subcontract Amount manually. If the Subcontract has Items, the Subcontract Amount is the sum of all of the Item amounts and the user can not modify it.

![Subcontracts Table](image)

**Figure 3-13. The Subcontract Items Panel**

Only items listed on the Items folder tab are available to record to the Subcontractor on the Daily Work Report.

If a portion of the item unit is subcontracted to more than one subcontractor, (ie. one subcontractor installs the item and another subcontractor paints the item) the actual quantity is assigned to both subcontractors.
Exercise 3-12
Main Panel > Contract Administration > Contractor Management > Subcontracts

In the following exercise, you view subcontracted items.

Login: tpxxxxx  Group: RE  Contract: ID

1. Click the Items folder tab.

2. How many items have been subcontracted on this subcontract?

________________

3. In the list box, scroll to and click Line Nbr 0010, Item Code 159003M, Description Breakaway Barricade.

4. What quantity has been subcontracted? ______________

5. Click the Close button.

6. Click the Main Panel folder tab.
Creating the Contract’s Master List of Equipment, Personnel Types, and NJDOT Activities

The Contract Master List allows the active Equipment, Personnel Types, and NJDOT Work Activities on the Vendor’s Master List to be associated to specific Contract. Each Contract can have one or more approved vendors. The Vendor Master List data for the prime Contractor and any approved Subcontractors will be available to associate with the Contract.

The Work Activities area of the Contract Master list is used to capture the different work activities performed by NJDOT staff and consultants. DWR creators should record their work regular and overtime work hours to the appropriate work activity code. This information should then be manually transferred to the Contract Manpower Program for reporting on the Weekly Progress Report.

Only the Equipment and Personnel Types associated with the Vendor will be available to add to the Contract. NJDOT work activities associated to any vendor on the Contract in the Work Activities area will be available for all vendors on the Contract.

Supervisors will be tracked as Personnel Types. NJDOT

Work Activities are associated to all Contractors on the Contract once they are associated to just one Contractor.

Figure 3-14. The Contract Master List Icon

NJDOT is not using the Supervisor section in the Contract Master List window.

Associating Vendor Equipment to the Contract

Only the active equipment that has been added to the Vendor’s Master List can be associated to the Contract.
The Resident Engineer or his designee are to associate equipment for the Prime Contractor as well as all Subcontractors for the Contract prior to the creation of the first Daily Work Report.

The Resident Engineer or his designee may add only specific pieces of equipment or use the ‘Add All’ function.
Exercise 3-13
Main Panel > Daily Work Reports > Reference Tables (DWR+) > Contract Master List

In the following exercise, you will associate equipment types the Prime Contractor on the Contract.

Login: tpxxxxx  Group: RE  Contract: ID

1. Double-click the Daily Work Reports icon.

2. Double-click the Reference Tables (DWR+) icon.

3. Double-click the Contract Master List icon.

4. In the Contract ID list box, scroll to and double-click Contract ID ID.

5. In the Vendor ID list box, scroll to and double-click Vendor I2943, Vendor Name IEW CONSTR GP.

6. Verify that the Equipment radio button has been selected.

7. Click the Add All button to add all options.

8. Click the Save button.

Associating Vendor Personnel Types to the Contract

Only active Personnel Types that have been added to the Vender Master List may be associated with the Contract.
The Resident Engineer or his designee are to associate personnel types for the Prime Contractor as well as all Subcontractors for the Contract prior to the creation of the first Daily Work Report. Supervisor names are not maintained in SiteManager. Instead, Supervisor Types such as ‘Foreman’ are included in the Personnel Types List.

**Exercise 3-14**
Main Panel > Daily Work Reports > Reference Tables (DWR+) > Contract Master List

In the following exercise, you will associate personnel types to the Prime Contractor on the Contract.

Login:  **tpxxxx**  Group:  **RE**  Contact:  **ID**

1. Click the **Personnel** radio button.

2. Click the **Add All** button to add all options.

3. Click the **Save** button.
Associating NJDOT Work Activities to the Contract

NJDOT work activity codes are listed in the Work Activities section of the Contract Master List window. The NJDOT work activity codes should be added to at least one Contractor on the Contract. SiteManager will automatically add the NJDOT work activity codes to all contractors (prime and subcontractors) on the Contract.

![Contract Master List](image)

Figure 3-17. The Vendor Staff Member Master List

The Resident Engineer or his designee are to associate NJDOT work activities for any vendor on the Contract prior to the creation of the first Daily Work Report.
Exercise 3-15
Main Panel > Daily Work Reports > Reference Tables (DWR+) > Contract Master List

In the following exercise, you will associate NJDOT work activities to all vendors on the Contract.

   Login: tpxxxx      Group: RE      Contract: ID

1. Click the Work Activities radio button.

2. Click the Add All button to add all options.

3. Click the Save button.

Associating Subcontract Equipment and Personnel Types to the Contract

Equipment and Personnel Types need to be added for each subcontractor. The NJDOT work activities in the Staff Member section of the Contract Master List window do not need to be associated to subcontractors if they were previously associated to the Prime Contractor.

![Figure 3-18. The Subcontract Vendor Master List](image-url)
The Resident Engineer or his designee are to associate equipment and personnel types to each subcontractor once the subcontractor is entered in SiteManager.

The Contract Master List may be modified at any point in the Contract.

**Exercise 3-16**
Main Panel > Daily Work Reports > Reference Tables (DWR+) > Contract Master List

In the following exercise, you will associate personnel types and equipment types to a subcontractor Contractor on the Contract.

Login: **tpxxxxx**  Group: **RE**  Contract: **ID**

1. Click the **Open** button.

2. In the **Vendor ID** list box, scroll to and double-click Vendor ID **A5768**, Vendor Name **AMERICAN SAFETY SVS INC**.

3. Click the **Equipment** radio button.

4. Click the **Add All** button to add all options.

5. Click the **Save** button.

6. Click the **Personnel** radio button.

7. Click the **Add All** button to add all options.

8. Click the **Save** button.

9. Click the **Close** button.

10. Click the **Daily Work Reports** folder tab.

**NJDOT work activities are not associated to the subcontractor since they were already associated to the Prime contractor on this Contract.**
Associating DWR Templates

After a DWR Template has been created it must be associated with an item on the Master List and with a Contract item in order to record data to it for the Daily Work Report. The DWR Template must first be associated to an Item in the Master List before it can be associated to a Contract Item. This is done on the Item - DWR Template Association panel from the Daily Work Reports panel. This panel displays all of the items on the Master List at the top and all of the templates that have been created and are active on the bottom left in the Templates List window. Templates that are associated to items are moved to the Associated Templates window on the bottom right of the panel.

The Generate button allows all items that have templates to be associated to the items templates.

![Contract Item - DWR Template Association](image)

**Figure 3-19.** Associating A DWR Template to a Master Item

The Resident Engineer or his designee are to associate the appropriate DWR templates to be used on the Contract to the Contact Item in the Contract Item – DWR Template Associated window.

As of October 2008, the following templates are available:

- DC 29B
- DC 29C
- DC 29D
- DC 92
- Lane Occupancy
- Asphalt Percentage
Exercise 3-17
Main Panel > Daily Work Reports > Contract Item – DWR Template

In the following exercise, you will associate DWR templates to the Contract.

Login: tpxxxx Group: RE Contract: ID

1. Double-click the Contract Item – DWR Template icon.
2. In the Project Nbr list box, scroll to and double-click PCN ID.
3. Click the Generate button.
4. Click the Save button.
5. Click the Close button.
6. Click the Main Panel folder tab.
Entering the Work Begin Date and the Official Contract Start Date

Once the Contractor begins work on the Contract, the Work Begin Date should be entered in the Contracts window on the Critical Dates folder tab. The Regional Construction Engineer or Maintenance Engineer should be entered as a recipient for the Work Begin Date so that SiteManager will generate an inbox message notifying the individual of the Contractor’s Work Begin Date.

The Official Contract Start Date in the Contracts window on the Critical Dates folder tab should be entered according to the following:

- **Fixed Completion Date**: Execution Date + 25 days
- **Working Day/Calendar day**: 25 days after execution or the first day the Contractor begins work

The Official Contract Start Date starts counting time on the Contract and is the first Estimate’s begin date.

![Figure 3-20. Official Contract Start Date](image)
The Resident Engineer or his designee is to enter the date the contractor begins work in the Contracts window on the Critical Dates folder tab in the Actual Occurrence Date field for the Work Begin Date.

The Resident Engineer or designee is to enter the date time charges begin or the date the contractor begins work, whichever is first, in the Contracts window on the Critical Dates folder tab in the Actual Occurrence Date field for the Official Contract Start Time.

Exercise 3-18

Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will enter the Work Begin Date and the Official Contract Start Date.

Login:  tpxxxxx  Group: RE  Contract: ID

1. Double-click the Contract Administration icon.
2. Double-click the Contract Records icon.
3. Double-click the Contracts icon.
4. Click the Critical Date folder tab.
5. In the Critical Date Description list, click Work Begin Date.
6. In the Actual Occurrence Date field, type 080708.
7. In the Recipient field, perform a Search and double-click tpsclay, User Name Clay, Andy.
8. Click the Save button.
9. In the Critical Date Description list, click Official Contract Start Date.
10. In the Actual Occurrence Date field, type 080708.
11. Click the Save button.
12. Click the Close button.

The RCE/RMM should be notified when the Work Begin Date is entered.
13. Click the Main Panel folder tab.
Review for Section 3

To create the DC 34:

1. Click the **Contract Administration** icon.
2. Click the **Contract Records** icon.
3. Double-click the **Contracts** icon.
4. Click the **Open** button.
5. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
6. Click the **Services** menu, and then click the **Custom Record** choice.
7. Using the right mouse button, click the **Template ID** field.
8. From the object menu, click the **Search** choice.
9. In the list box, scroll to and double-click **Template ID DC 34 Key Contact Personnel**.
10. In the **Revision Number** field, type the Revision Number.
11. In the **Project Superintendent** field, type the name of the Project Superintendent.
12. In the **Project Superintendent Home Phone** field, type the home phone number.
13. In the **Project Superintendent Cellular** field, type the cellular phone number.
14. In the **1st Alternative** field, type the alternative person’s name.
15. In the **1st Alternative Home Phone** field, type the home phone number.
16. In the **1st Alternative Cellular** field, type the cellular phone number.
17. In the **Traffic Coordinator (1)** field, type the Traffic Coordinator (1)’s name.
18. In the **Traffic Coordinator (1) Home Phone** field, type the home phone number.
19. In the **Traffic Coordinator (1) Cellular** field, type the cellular phone.
20. In the **Traffic Coordinator (2)** field, type the Traffic Coordinator (2)’s name.
21. In the **Traffic Coordinator (2) Home Phone** field, type the home phone.
22. In the **Traffic Coordinator (2) Cellular** field, type the cellular phone.
23. In the **Resident Engineer Alternative** field, type the Resident Engineer Alternative’s name.
24. In the **Resident Engineer Alternative Title** field, type the title.
25. In the **Resident Engineer Alternative Home Phone** field, type the home phone.
26. In the **Resident Engineer Alternative Cellular** field, type the cellular phone.
27. In the **Field Manager** field, type the Field Manager’s name.
28. In the **Field Manager Office Phone** field, type office phone.
29. In the **Field Manager Office Fax** field, type office fax.
30. In the **Field Manager Home Phone** field, type home phone.
31. In the **Field Manager Cellular** field, type the cellular phone.
32. In the **Traffic Operations** field, type the Traffic Operations’ name.
33. In the **Traffic Operations Office Phone** field, type the office phone.
34. In the **Traffic Operations Office Fax** field, type the office fax.
35. In the **Traffic Operations Home Phone** field, type home.
36. In the **Traffic Operations Cellular** field, type cellular phone.
37. In the **NJDOT Field Office Address** field, type the address.
38. In the **NJDOT Field Office City** field, type the city.
39. In the **NJDOT Field Office State** field, type NJ.
40. In the **NJDOT Field Office Zip Code** field, type the zip code.
41. In the **NJDOT Field Office Phone** field, type office phone.
42. In the **NJDOT Field Office Fax** field, type the fax.
43. In the **Contractor Field Office Address** field, type the address.
44. In the **Contractor Field Office City** field, type the city.
45. In the **Contractor Field Office State** field, type NJ.
46. In the **Contractor Field Office Zip Code** field, type the zip code.
47. In the **Contractor Field Office Phone** field, type the office phone.
48. In the **Contractor Field Office Fax** field, type the office fax.
49. In the **Site No 1 Local Name/Desc** field, type the local name or description.
50. In the **Location(s) Town and County** field, type the locations.
51. In the **Type of Construction** field, type the type of Construction.
52. In the **From Milepost** field, type the beginning milepost.
53. In the **To Milepost** field, type the ending milepost.
54. Repeat steps 49-53 for up to 5 sites.
55. Click the **Save** button.
56. Click the **Close** button.

To view Crystal Reports:
1. Double-click the **Reports** icon.
2. In the **System** field, type **snj 187:6400**.
3. In the **User Name** field, type **TSP_Construction**.
4. In the **Password** field, type **pave09**.
5. In the **Authentication** drop-down list, click the expand arrow and click **Enterprise**.
6. Click **Folders**.
7. Click the **TSP_Construction** folder.
8. Click the desired report.
9. Enter the required Parameters.
10. Click the **OK** button.
11. View, Print, or Save the report.

To export a Crystal Report to PDF format:
1. Generate the desired report.
2. Click the **Export this Report** button.
3. In the **File** Format drop-down list, click the expand arrow and click **Adobe Acrobat (PDF)**.
4. Click the **OK** button.
5. Click the **Save** button.
6. Save the report in the desired location.
7. Exit Crystal Reports.

To identify items to be excluded from the Construction Layout calculations:
1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Contracts** icon.
4. Click the **Open** button.
5. In the **Contract** list box, scroll to and double-click the desired Contract ID.
6. Click the **Attachments** button.
7. Double-click the **Construction Layout Program** attachment.
8. Scroll to and click the **Exclude** check box for all items to be excluded from the Construction Layout Calculations.
9. Click the **Save** button.
10. Click the **Close** button.

To view the planned man hours for a Contract:
1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Contracts** icon.
4. Click the **Open** button.
5. In the **Contract** list box, scroll to and double-click the desired Contract ID.
6. Click the **Attachments** button.
7. Double-click the **Contract Manpower Program** attachment.
8. Click the **Planned Hours** folder tab.
9. Click the **Close** button.

To add personnel to the Contract Manpower Program:
1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Contracts** icon.
4. Click the **Open** button.
5. In the **Contract** list box, scroll to and double-click the desired Contract ID.
6. Click the **Attachments** button.
7. Click the **Contract Personnel** folder tab.
8. In the **Available Personnel** List, scroll to and click the desired personnel.
9. Click the **Add** button.
10. Repeat steps 8 and 9 until all personnel are added.
11. In the **Firm** list box, double-click the desired firm.
12. Click the **Close** button.
13. Click the **Close** button.
To view the Contract Authority window:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Contract Authority** icon.
4. In the **User Identification** list box, scroll to and click the desired User.
5. View the **Contract Authority** information in the bottom portion of the window.
6. Click the **Close** button.

To create a Correspondence Log record with an attachment:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Correspondence Log** icon.
4. Click the **Services** menu, and then click the **Choose Keys** choice.
5. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
6. In the **Correspondence Type** drop-down list, click the expand arrow and click the desired correspondence type.
7. In the drop-down list, click the expand arrow and click **Received** or **Sent**.
8. In the **On** field, type the date the correspondence was received or sent.
9. In the **Sent From** field, type who sent the correspondence.
10. In the **Sent To** field, type to whom the correspondence was sent.
11. In the **Document Category** drop-down list, click the expand arrow and click the desired document category.
12. In the **Major Topics** field, type the major topics.
13. Click the **Save** button.
14. Click the **Attachments** button.
15. Click the **New OLE** button.
16. Click the **Create from File** button
17. Browse to the desired document.
18. Click the **Open** button.
19. Click the **OK** button.
20. In the **Name** field, type the name of the attachment.
21. In the **Description** field, type the description of the attachment.
22. In the **Attachment Security** box, click the **Add All** button.
23. Click the **Add** button.
24. Click the **Save** button.
25. Click the **Close** button.

To add a permit:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Contracts** icon.
4. Click the **Services** menu, and then click the **Choose Keys** choice.
5. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
6. Double-click the **Permits** icon.
7. In the **Permit Type** drop-down list, click the expand arrow and click the desired permit.
8. In the **Submitted Date** field, type the desired date.
9. In the **Effective Date** field, type the desired date.
10. In the **Expiration Date** field, type the desired date.
11. In the **Permit Number** field, type the permit number.
12. Click the **Save** button.
13. Click the **Close** button.

To delete a Key Date:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Key Dates** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Key Date Type** list, click the desired Key Date.
6. Click the **Delete** button.
7. Click the **Yes** button.
8. Click the **Save** button.
9. Click the **Close** button.
To modify a Key Date:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Key Dates** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Key Date Type** list, click the desired Key Date.
6. In the **Projected Date** field, type the projected date.
7. In the **Actual Date** field, type the actual date.
8. In the **Recipient** or **Distribution List** field, perform a Search and double-click the desired person or distribution list.
9. Click the **Save** button.
10. Click the **Close** button.

To delete a Checklist Event Date:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Checklist Scheduled Events** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Event Type** list, click the desired event.
6. Click the **Delete** button.
7. Click the **Yes** button.
8. Click the **Save** button.
9. Click the **Close** button.

To schedule a Checklist Event Date:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Checklist Scheduled Events** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Event Type** list, click the desired event.
6. In the **Next Proj Date** field, type the desired date.
7. In the **Number of Occurrences** field, type the number of occurrences.
8. In the **Recipient** or **Distribution List** field, perform a Search and double-click the desired person or distribution list.
9. Click the **Save** button.
10. Click the **Close** button.

To view a subcontract:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contractor Management** icon.
3. Double-click the **Subcontracts** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Subcontract** list box, scroll to and double-click the desired SubCont Nbr.
6. Click the **Items** folder tab.
7. Click the **Close** button.

To create the Contract Master List:

1. Click the **Daily Work Reports** icon.
2. Click the **Reference Tables** icon.
3. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
4. In the **Vendor ID** list box, scroll to and double-click the desired vendor.
5. Click the **Equipment** radio button.
6. Click the **Add All** button to add all options.
7. Click the **Save** button.
8. Click the **Personnel** radio button.
9. Click the **Add All** button to add all options.
10. Click the **Save** button.
11. Click the **Staff Member** radio button.
12. Click the **Add All** button to add all options.
13. Click the **Close** button.

To associate DWR Templates:

14. Click the **Daily Work Reports** folder tab.
15. Click the **Daily Work Reports** folder tab.
16. Double-click the **Contract Item – DWR Template** icon.
17. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
18. In the **Project Nbr** list box, scroll to and double-click the desired PCN.
19. Click the **Generate** button.
20. Click the **Save** button.
21. Click the **Close** button.
To enter the Work Begin and Official Contract Start Date:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Contracts** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. Click the **Critical Date** folder tab.
6. In the **Critical Date Description** list, click **Work Begin Date**.
7. In the **Actual Occurrence Date** field, type the desired date.
8. In the **Recipient** field, perform a **Search** and double-click the desired recipient.
9. Click the **Save** button.
10. In the **Critical Date Description** list, click **Official Contract Start Date**.
11. In the **Actual Occurrence Date** field, type the desired date.
12. Click the **Save** button.
13. Click the **Close** button.
Summary for Section 3

In the following exercise you will prepare the Contract 8888B for work.

Login: tpxxxxx  Group: RE  Contract: 8888B

1. Navigate to the Contracts window and open Contract ID 8888B.

2. Review the DC 34 Key Contact Personnel template. (Hint – Services Menu, Custom Record Choice)

3. Who is the Project Superintendent? Daryl Harms

4. Identify that the following items should be excluded from the Construction Layout adjustment calculations (Hint – Contracts window, Attachments button):
   - Category Nbr 0001, Line Nbr 0001, Item Code 151003M, Description Performance Bond and Payment Bond
   - Category Nbr 0001, Line Nbr 0003, Item Code 153003P, Description Progress Schedule
   - Category Nbr 0001, Line Nbr 0042, Item Code 157003M, Description Construction Layout

5. Associate the following Personnel to the Contract in the Contract Manpower Program (Hint – Contracts window, Attachments button):
   - Brown, Sam
   - Jones, Kelly
   - Lewis, Tyler
   - Rodriguez, Angel

6. What window in SiteManager displays the Contracts which can be accessed by each SiteManager User? Contract Authority

7. What window in SiteManager should be used to record correspondence between NJDOT and the Contractor? Correspondence Log

8. Add the following permit to Contract ID 8888B:
   - Permit Type: NJDEP Stormwater Management
   - Expiration Date: 07/31/09
   - Submitted Date: 07/25/08
   - Effective Date: 08/01/08
   - Permit Number: HPA-115-2008
9. Modify the following Key Dates:

Delete Key Date Type: Mylars Submission

Enter the Projected Date for the RE Estimated Completion Date as 10/27/08 and Warren, Jackie as the Recipient.

10. Schedule the following Checklist Events:

Delete Checklist Event: Ins-Pollution Liab.

For Event Type AD 267, enter the following information:

- Next Projected Date: 09/04/08
- Number of Occurrences: 999
- Recipient: Reed, Logan

11. Navigate to the Subcontracts window. How many Subcontractors are on Contract ID 8888B? 2

12. Navigate to the Contract Master List window and association all equipment, personnel types, and NJDOT work activities to IEW Contr. Group.

13. Associate all DWR Templates to Contract ID 8888B.

14. Navigate to the Contracts window.

15. Enter the Work Begin Date as 08/11/08 and Clay, Andy as the Recipient.

16. Enter the Official Contract Start Date as 08/11/08.

17. Exit SiteManager.
4 Maintaining Contracts

By the end of this section, you will be able to:

- Record a Checklist Event
- Start a Milestone
- Record Stockpiled Material Information
- Record a Force Account
- Record a Claim in SiteManager
Recording a Checklist Event

The Checklist Event Dates panel lists the scheduled events for the selected Contract. The data for the event selected in the top datawindow is displayed in the bottom datawindow. The data shows a chronological history of each occurrence of a repetitive scheduled event, and the Actual Date recorded by the user for each occurrence. This panel lets the user record the actual dates of the Checklist Scheduled Events, and add or delete Checklist Event Date records.

![Checklist Event Dates](image)

**Figure 4-1. The Checklist Event Dates Window**

The Resident Engineer or his designee are to enter the actual date for each Checklist Event as it occurs. Missed Checklist Events will generate an estimate discrepancy.
Exercise 4-1
Main Panel > Contract Administration > Contract Records>
Checklist Event Dates

In the following exercise, you will record the actual date for a checklist event.

Login: tpxxxxx Group: OENGR Contract: ID

1. Double-click the SiteManager icon on your desktop.
2. In the User ID field, type tpxxxxx.
3. Press the Tab key.
4. In the Password field, type pass.
5. Press the Enter key.
6. Double-click the Contract Administration icon.
7. Double-click the Contract Records icon.
8. Double-click the Checklist Event Dates icon.
9. In the Contract ID list box, scroll to and double-click ID.
10. In the Event Type list, scroll to and click AD 267.
11. Click the Actual Date field for Project Date 09/04/08 and type 090308.
12. Click the Save button.
13. Click the Close button.
Starting a Milestone

The Milestone panel lets the user add, modify, and delete Contract Milestones. The user can enter an incentive or disincentive rate for each milestone, and specify either days or hours to be used in calculating the amount to be paid or withheld. The user also enters the dates the milestone work was started and completed.

The user can not enter values for Milestone Number, Current Milestone Completion Date, and Current Milestone Completion Time

![Milestones Panel](image)

**Figure 4-2.** The Milestones Panel

The SiteManager Coordinator is to enter milestones in the Milestones window during the Contract Activation Process.

The Resident Engineer or his designee are to enter the Work Start and Actual Completion dates as determined by the milestone.

An estimate discrepancy is generated by SiteManager if the Actual Completion field is not entered by the expected completion date.

A Time Adjustment Change Order must be created to increase or decrease the allotted milestone time.
Exercise 4-2
Main Panel > Contract Administration > Contract Records> Milestones

In the following exercise, you will start a Milestone for the Contract.

Login: tpxxxxx Group: OENGR Contract: ID

1. Double-click the Milestone icon.
2. Click Milestone 01 Stage 1a.
3. In the Work Start field, type 080708.
4. Click the Save button.
5. Click the Close button.
Recording Stockpiled Material Information

The Stockpiled Materials panel lets the user select materials to be stockpiled for the Contract and enter invoice data for the materials. The panel displays Contract Line Item data in the top datadwindow and stockpiled material data in the bottom datadwindow. This data is used during estimate generation to determine the amount to be paid for the Items installed. The estimate process enters the installed quantity and the amount paid to date on the Stockpiled Materials panel. The estimate process also closes out the stockpiled material balance when the remaining quantity is zero, or the user can close out the balance manually and transfer it to another Contract.

Changing the Conversion Factor gives the user the ability to change payment item adjustments based on how stockpile materials are used during a given estimate period. When the Conversion Factor is set to zero, line item adjustments are not calculated during the estimate process.

Figure 4-3. Stockpiled Materials Window
Creating Stockpile

SiteManager calculates payments for Stockpiled Materials based on the quantity of Material used per Contract Item. SiteManager does not automatically apply portions of the invoiced Material quantity and payment amount to different Contract Items. This means that the user must decide how to allocate the invoiced amounts for a Stockpiled Material. Before adding invoice data to SiteManager, the user must determine the following:

- Which Items include the invoiced Material
- Which Contracts include these Items
- How much of the total invoiced Material to allocate to each Item
- If an initial payment amount is due, which Contracts or Contract Items pay this amount

From these numbers, the user can calculate the values to enter in the Quantity field of the Stockpiled Materials panel.

The Resident Engineer or his designee are to enter stockpiled materials in SiteManager, ensuring that the initial payment information is correct and does not exceed 85% of the bid amount for the item.

Each Invoice must be added individually and to the correct Project Line Item Number. The Initial Invoice Amount is the amount that is paid for the stockpiled material on the next estimate.

Stockpiled material reductions or additions to the pay amount on an estimate are calculated and applied automatically in SiteManager. Details regarding the stockpiled materials that have been applied to the estimate can be seen in the Line Item Adjustment window.
Exercise 4-3
Main Panel > Contract Administration > Contract Records > Stockpiled Materials

In the following exercise, you add a stockpiled material.

Login: tpxxxxx  Group: OENGR  Contract: ID

1. Double-click the Stockpiled Materials icon.

2. Click the Services menu, and then click the Choose Keys choice.

3. In the Contract Projects list box, scroll to and double-click PCN ID.

4. In the Contract Item list box, scroll to and double-click Category Nbr 0004, Line Nbr 0046, Item Code 507002P, Description Elastomeric Concrete Bridge Joint System.

5. In the Stockpiled Desc field, type Elastomeric Concrete Bridge Joint System.

6. In the Invoice Date field, type 080708.

7. In the Invoice Number field, type 0001.

8. In the Quantity field, type 120.

9. In the Units drop-down list, click the expand arrow and click Linear Foot.

10. In the Unit Price field, type 1.70.

11. In the Conv Factor field, type 1.00.

12. Press the Tab key.

13. In the Initial Invoice Payment field, type 204.00.

14. Click the Save button.
Replenishing a Stockpile

The Stockpiled Materials window also allows you to add to an existing stockpile by replenishing it. After opening the existing stockpile, you use the Services menu’s Replenish Stockpile choice to add to the existing stockpile. The menu selection only blanks out the Quantity field, so care should be taken to modify the other fields appropriately, particularly the Initial Invoice Payment field because this is the value that is paid on the next estimate.

![Stockpiled Materials Window](image)

**Figure 4-4. Stockpiled Materials Window**

The Resident Engineer or his designee are to replenish the stockpiled materials as necessary. Each Invoice must be added individually and to the correct Project Line Item Number.
Exercise 4-4
Main Panel > Contract Administration > Contract Records > Stockpiled Materials

In the following exercise, you replenish a stockpiled material.

| Login: tpxxxxx | Group: OENGR | Contract: ID |

1. Click the Services menu, and then click the Replenish Material choice.

2. In the Invoice Date field, type 081808.

3. In the Invoice Number field, type 0002.

4. In the Quantity field, type 100.

5. In the Unit Price field, type 1.70.

6. Press the Tab key.

7. In the Initial Invoice Payment field, type 170.00.

8. Click the Save button.
Closing a Stockpile

The Stockpiled Materials window also allows you to close an existing stockpile. After opening the existing stockpile, you use the Services menu’s Close Out Balance choice to remove remaining quantity in the existing stockpile. SiteManager will create a deduction on the next estimate for the remaining quantity times the unit price of the material that remained in the stockpile prior to closing it out.

The Resident Engineer or his designee are to close out active stockpiles during the Contract Finalization Process.

If necessary the Resident Engineer or his designee is to then initiate a Change Order to balance the recouped payment if possession of the material is retained by NJDOT.
Exercise 4-5
Main Panel > Contract Administration > Contract Records > Stockpiled Materials

In the following exercise, you close out a stockpiled material.

Login: tpxxxxx  Group: OENGR  Contract: 7777E

1. Click the Open button.
2. Click the Contract ID button.
3. In the Contract list box, scroll to and double-click Contract ID 7777E.
4. In the Stockpiled Materials list box, scroll to and double-click Category Nbr 0004, Line Nbr 0046, Invoice Number 0002.
5. Click the Services menu, and then click the Close Out Balance choice.
6. Click the Save button.
7. Click the Close button.
Recording a Force Account

In NJDOT, the Resident Engineer or his designee should create the force account record in SiteManager as necessary. The Inspector should record the hours the equipment was used, the hours personnel worked, and the amount of material used on the Force Account folder tab in the Daily Work Report window. The Inspector should contact the Resident Engineer or his designee if updates are needed to the Force Account window to accurately reflect the equipment, personnel types, and material used on the Force Account. The daily record of the Force Account work submitted by the contractor should be attached to the Daily Work Report.

To initiate payment for the Force Account, the Resident Engineer or his designee should create a Change Order which should be linked to the Force Account to pay the Contractor. A Force Account item with a supplemental description which coincides with the number of the Force Account will be added to the Contract for the approximate amount of the Force Account as determined by the Contractor’s and Resident Engineer’s estimate. For example, Force Account #1 should be paid with the Force Account Item with a supplemental description of Force Account #1 and Force Account #2 should be paid the Force Account Item with a supplemental description of Force Account #2, etc.

Once the Force Account is complete, the total amount of the Force Account should be paid on the Daily Work Report with the appropriate Force Account item. An adjusting Change Order should be created so that the Force Account Item’s final quantity reflects the amount of the Force Account.
Adding Force Account Equipment

The Equipment folder tab lets you create new Force Accounts and add equipment and usage rates.

When a new Force Account is created, the equipment, labor, and materials can be listed generically so that the inspector can begin recording usage data in Daily Work Reports.

![Force Account Panel](image)

Only equipment, labor, and material established in the Force Account window will be available on a DWR.

The Resident Engineer or his designee is to enter the description and purpose of the Force Account on the Equipment folder tab.

Equipment to be used for the Force Account is to also be established on the Equipment folder tab. Additional equipment may be added to the Force Account at any time.
Exercise 4-6
Main Panel > Contract Administration > Contract Records > Force Accounts

In the following exercise, you will add a Force Account and Force Account equipment.

Login: tpxxxxx   Group: OENGR   Contract: ID

1. Double-click the Force Accounts icon.

2. Click the Services menu, and click the Choose Keys choice.

3. Click the NO button.

4. In the Contract ID list box, scroll to and double-click Contract ID ID.

5. In the Description field, type Inlet Reconstruction.

6. In the Purpose field, type Repair Deteriorated Inlet.

7. Click the Force Account Equipment Description area.

8. Click the New button.

9. In the Force Account Equipment Description field, type Combination Backhoe.

10. In the Used Rate field, type 38.20.

11. In the Idle Rate field, type 7.23.

12. In the Owned or Rented Type drop-down list, click the expand arrow and click Contractor Owned.

13. Click the Save button.

14. Click the New button.

15. In the Force Account Equipment Description field, type 150 CFM Diesel Air Compressor.

16. In the Used Rate field, type 12.14.

17. In the Idle Rate field, type 1.55.
18. In the **Owned or Rented Type** drop-down list, click the expand arrow and click **Contractor Owned**.

19. Click the **Save** button.

20. Click the **New** button.

21. In the **Force Account Equipment Description** field, type **90 # Jackhammer**.

22. In the **Used Rate** field, type **.81**.

23. In the **Idle Rate** field, type **.21**.

24. In the **Owned or Rented Type** drop-down list, click the expand arrow and click **Contractor Owned**.

25. Click the **Save** button.
Adding Force Account Labor

The Labor folder tab lets you create and maintain a list of Force Account workers and their wage rates.

![Force Accounts Tab](image)

Figure 4-7. Force Account Labor Folder Tab

The Resident Engineer or his designee is to enter the names of each person working on the Force Account. Additional workers may be added to the Force Account at any time.

If the Force Account work is performed by a subcontractor, the Resident Engineer or his designee is to manually calculate the additional 5% due to the Contractor and enter the amount in the Other Adjustment field. Supporting documentation is to be attached to the Force Account.
Exercise 4-7
Main Panel > Contract Administration > Contract Records > Force Accounts

In the following exercise, you will add Force Account labor.

Login: tpxxxxx  Group: OENGR  Contract: ID

1. Click the Labor folder tab.
2. In the Labor Adj % field, type 25.
3. Click the Worker Name area.
4. Click the New button.
5. In the Worker Name field, type Joe Digger.
6. In the Class drop-down list, click the expand arrow and click Operator-Backhoe.
7. In the Regular Rate field, type 42.00.
8. In the Overtime Rate field, type 63.00.
9. Click the Save button.
10. Click the New button.
11. In the Worker Name field, type Manuel Ortega.
12. In the Class drop-down list, click the expand arrow and click Labor-Powertool.
13. In the Regular Rate field, type 32.00.
14. In the Overtime Rate field, type 48.00.
15. Click the Save button.
16. Click the New button.
17. In the Worker Name field, type Joseph Lombardi.
18. In the Class drop-down list, click the expand arrow and click Laborer.
19. In the **Regular Rate** field, type **28.00**.

20. In the **Overtime Rate** field, type **42.00**.

21. Click the **Save** button.
Adding Force Account Materials

The Material folder tab lets you create and maintain a list of Force Account materials and related invoice quantities and costs.

![Figure 4-8. Force Account Materials Folder Tab](image)

The Resident Engineer or his designee is to enter the invoice information for materials used on the Force Account. Additional material may be added to the Force Account at any time.
Exercise 4-8
Main Panel > Contract Administration > Contract Records > Force Accounts

In the following exercise, you will add Force Account materials.

Login:  tpxxxxx   Group: OENGR   Contract: ID

1. Click the Material folder tab.
2. In the Material Adj % field, type 25.
3. Click the Invoice ID area.
4. Click the New button.
5. In the Invoice ID field, type 100-01.
6. In the Invoice Dt field, type 080708.
7. In the Contract FA Material Description field, type Concrete Inlet Block.
8. In the Delivered Qty field, type 100.
9. In the Units Type drop-down list, click the expand arrow and click Unit.
10. In the Unit Price field, type 3.50.
11. Click the Save button.
12. Click the New button.
13. In the Invoice ID field, type 100-01.
14. In the Invoice Dt field, type 080708.
15. In the Contract FA Material Description field, type Type 3 Cement.
16. In the Delivered Qty field, type 50.
17. In the Units Type drop-down list, click the expand arrow and click Bag.
18. In the **Unit Price** field, type **10.00**.

19. Click the **Save** button.

20. Click the **New** button.

21. In the **Invoice ID** field, type **100-01**.

22. In the **Invoice Dt** field, type **080708**.

23. In the **Contract FA Material Description** field, type **Sand**.

24. In the **Delivered Qty** field, type **1.0**.

25. In the **Units Type** drop-down list, click the expand arrow and click **Ton**.

26. In the **Unit Price** field, type **25.00**.

27. Click the **Save** button.
Viewing Force Account Totals

This is a view-only panel. The Force Account Summary folder tab calculates and displays the total actual cost of the Force Account and the actual costs per type and per day. The total actual costs are derived from the hours and quantities reported on Daily Work Reports. The user can access the Daily Work Reports from this panel.

![Force Accounts Panel]

**Figure 4-9. The Force Account Summary Folder Tab**

The Resident Engineer or his designee are to view the Summary folder tab to obtain the total amount of the Force Account recorded on Daily Work Reports. This amount is then compared to the Change Order to be sure the funding is accurately secured and the Force Account work is accurately paid.
Exercise 4-9
Main Panel > Contract Administration > Contract Records > Force Accounts

In the following exercise, you will view the Force Account totals.

Login: tpxxxxx   Group: OENGR   Contract: 7777G

1. Click the Open button.

2. Click the Contract ID button.

3. In the Contract ID list box, double-click Contract ID 7777G.

4. In the Force Acct Id list box, scroll to and double-click Force Account ID 1.

5. Click the Summary folder tab.

6. Verify the Force Account Adjustment Total.

7. What is the Force Account total? $931.20

8. Click the Close button.
**Recording a Claim in SiteManager**

The Dispute/Claim window allows the user to track claims related to a Contract. The user may add, modify, and delete claim records. In NJDOT, the Resident Engineer or his designee should maintain the Disputes/Claims window.

In NJDOT, once the contractor submits form DC 161, the Resident Engineer or his designee should enter the claim information in SiteManager in the Disputes/Claims window. A record of the correspondence should also be created in the Correspondence Log window, and the DC 161 should be attached to the Correspondence record. The Resident Engineer or his designee should then use the Forward To function in the Services menu of the Correspondence Log window to notify the Project Manager of the pending claim. The Project Manager should use the information in the SiteManager Disputes/Claims window and the DC 161 to enter claim tracking information in PRS. As the claim proceeds through the claims tracking process, the Resident Engineer should update the Description folder tab with the Status and Resolution Level of the claim.
Creating a Claim Record

The Description folder tab displays the basic description data that can be added, deleted, updated, or viewed.

In NJDOT, all records should be entered as a Claim with the following fields completed:

- Status
- Category Type
- Requested Days - Number of days requested by the Contractor in the claim. Either Requested Amt or Requested Days is required. If this is not known at the time of claim notice, this field should be left blank and the requested number of days entered once this is known.
- Requested Amt - Dollar amount requested by the Contractor in the claim. Either Requested Amt or Requested Days is required. If this is not known at the time of the claim notice, $1.00 should be entered in this field, and then changed to the actual requested amount once the amount is known.
- Settled Days - Days settled for the claim, if the settlement is directly linked to this claim. If a settlement includes multiple claims, this field should be left blank and the decision should be entered in the Remarks field.
- Settled Amt - Amount settled for the claim, if the settlement is directly linked to this claim. If a settlement includes multiple claims, this field should be left blank and the decision should be entered in the Remarks field.
- Received Date - Date the claim was received by NJDOT. This is a required field
- Contractor Accepted Date - Date the Contractor accepted the NJDOT offer in writing. Cannot be after the current date or equal to the Dept Resolved Date.
- Dept Resolved Date - Date the claim was resolved. Cannot be after the current date. On active Contracts this date will be entered by the Resident Engineer and will be one of the following:
  - The date the Change Order is executed
  - The date the claim is withdrawn
• The date of the unconditioned final certificate
• On Contracts that are no longer active, this date will be entered by the Project Manager and will one of the following:
  • The date the AD-12 is executed
  • The date the claim is withdrawn
  • The date of the final court decision (when a zero dollar decision is made by the courts, otherwise an Ad-12 needs to be executed to pay for the settlement)
  • Details should be entered in the Remarks field as appropriate.

  - Resolution Level
  - Remark - At a minimum this field will include the following:
    • Description of the Claim
    • Contractor Reference Number
    • Claim Event Date
    • Multiple Claim settlement amount/days details, if applicable

Before a Contract should be considered complete, all Claims must have a date in the Dept Resolved Date field. If the claim proceeds to litigation, the date the claim was escalated to litigation should be entered in this field and comments should be entered in Remarks that the claim is in litigation.

Figure 4-10. The Dispute/Claim Description Folder Tab
The Resident Engineer or his designee are to create and update claim information in SiteManager.

**Exercise 4-10**
Main Panel > Contract Administration > Contract Records > Disputes/Claims

In the following exercise, you will add a claim to the Contract.

Login: tpxxxxx  Group: OENGR  Contract: ID

1. Double-click the Disputes/Claims icon.
2. Click the Services menu, and then click the Choose Keys choice.
3. In the Contract ID list box, scroll to and double-click Contract ID ID.
4. In the Type Ind drop-down list, click the expand arrow and click Claim.
5. In the Status drop-down list, click the expand arrow and click Claim Notice Only.
6. In the Category Type drop-down list, click the expand arrow and click Character of Work.
7. In the Requested Days field, type 10.
8. In the Received Date field, type 082008.
9. In the Remarks field, type Additional time is requested based on lane occupancy restriction initiated by the Department that were not in the Contract’s Traffic Control Plans. Contractor’s Reference Number: IEW-ID-01. Claim Event Date: 08/01/08.
10. Click the Save button.
11. Click the Close button.
Forwarding a Correspondence Log Record for Review

All correspondence relating to claims should be entered in the Correspondence Log window with a Category Type of Claims/Disputes. The correspondence, including the DC 161 should be attached to the Correspondence record. Additionally, the Project Manager should be notified via the Forward To function of all Correspondence relating to the Claim.

Figure 4-11. The Dispute/Claim Description Folder Tab

The Resident Engineer or his designee are to create a Correspondence Log record to document all claim related correspondence, and are to then forward the claim information to the Project Manager via the Forward To option in the Correspondence Log window. The Correspondence Log record is then linked to the appropriate claim in the Dispute ID field.

NJDOT is not using the Recipients folder tab. SiteManager records linked to the Claim can be viewed on the Related Records folder tab.
**Exercise 4-11**
Main Panel > Contract Administration > Contract Records > Correspondence Log

In the following exercise, you will create a Correspondence Log to document a claim, attach Form DC 161, and forward the Correspondence to the Project Manager.

Login: tpxxxxx   Group: OENGR   Contract: ID

1. Double-click the **Correspondence Log** icon.

2. In the **Correspondence Type** drop-down list, click the expand arrow and click **Form**.

3. In the drop-down list, click the expand arrow and click **Received**.

4. In the **On** field, type 082008.

5. In the **Sent From** field, type IEW CONSTR GP.

6. In the **Sent To** field, type Kelly Jones.

7. In the **Document Category** drop-down list, click the expand arrow and click **Claims/Disputes**.

8. In the **Major Topics** field, type **DC 161, claim on lane restrictions established by department**.

9. In the **Dispute** field, perform a **Search** and double-click Dispute ID 1.

10. Click the **Save** button.

11. Click the **Attachments** button.

12. Click the **New OLE** button.

13. Click the **Create from File** button.

14. Click the **Browse** button.

15. Click the **DC161** file to be attached in the following location: c:\$MTRAINS\$MFFILES.
16. Click the **Open** button.
17. Click the **OK** button.
18. In the **Name** field, type *20080820DC161*.
19. In the **Description** field, type *DC 161 Submitted by Contractor*.
20. In the **Attachment Security** box, click the **Add All** button.
21. Click the **Add** button.
22. Click the **Save** button.
23. Click the **Services** menu, and then click the **Forward To…** choice.
24. In the **User Name** list box, scroll to and click User Name *Jackson, Bailey*.
25. Click the **OK** button.
26. Click the **OK** button.
27. Click the **Save** button.
28. Click the **Close** button.
29. Click the **Main Panel** folder tab.
Review for Section 4

To record the actual date for a checklist event:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Checklist Event Dates** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Event Type** list, scroll to and click the desired Event.
6. Click the **Projected Date/Actual Date** area.
7. Click the **Actual Date** field and type the actual date.
8. Click the **Save** button.
9. Click the **Close** button.

To start a milestone for a Contract:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Milestone** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. Click the Milestone.
6. In the **Work Start** field, type the milestone date.
7. Click the **Save** button.
8. Click the **Close** button.

To add a stockpiled material:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Stockpiled Materials** icon.
4. Click the **Services** menu, and then click the **Choose Keys** choice.
5. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
6. In the **Contract Projects** list box, scroll to and double-click the desired PCN.
7. In the **Contract Item** list box, scroll to and double-click the desired Contract Item.
8. In the **Stockpiled Desc** field, type the description of the Stockpile.
9. In the **Invoice Date** field, type the date.
10. In the **Invoice Number** field, type the invoice number.
11. In the **Quantity** field, type the quantity.
12. In the **Units** drop-down list, click the expand arrow and click the unit of measurement.
13. In the **Unit Price** field, type price per unit.
14. In the **Conv Factor** field, type the conversion factor.
15. Press the **Tab** key.
16. In the **Initial Invoice Payment** field, type the initial payment.
17. Click the **Save** button.
To replenish a stockpiled material:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Stockpiled Materials** icon.
4. Click the **Open** button.
5. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
6. In the **Stockpiled Materials** list box, scroll to and double-click the desired stockpiled material.
7. Click the **Services** menu, and then click the **Replenish Material** choice.
8. In the **Invoice Date** field, type the date.
9. In the **Invoice Number** field, type the invoice number.
10. In the **Quantity** field, type the stockpile quantity.
11. In the **Unit Price** field, type price per unit.
12. Press the **Tab** key.
13. In the **Initial Invoice Payment** field, type the initial payment.
14. Click the **Save** button.
15. Click the **Close** button.

To add a Force Account:

1. Double-click the **Contract Records** icon.
2. Double-click the **Force Accounts** icon.
3. Click the **Open** button.
4. In the **Contract ID** list box, scroll to and double-click the Contract ID.
5. In the **Description** field, type the Force Account description.
6. In the **Purpose** field, type the purpose of the Force Account.
7. Click the **Force Account Equipment Description** area.
8. Click the **New** button.
9. In the **Description** field, type the Force Account description.
10. Click the **New** button.
11. In the **Equipment** field, type the equipment.
12. In the **Used Rate** field, type the equipment rate.
13. In the **Idle Rate** field, type the idle rate.
14. Click the **Save** button.
15. Click the **Close** button.
16. In the **Labor Adj %** field, type the labor adjustment percentage.
17. Click the **New** button.
18. In the **Material Adj %** field, type the material adjustment percentage.
19. Click the **New** button.
20. In the **Invoice ID** field, type the invoice ID.
21. In the **Invoice Dt** field, type the invoice date.
22. In the **Contract FA Material Description** field, type the name of the material.
23. In the **Delivered Qty** field, type quantity delivered.
24. In the **Units Type** drop-down list, click the expand arrow and click the unit.
25. In the **Unit Price** field, type price per unit.
26. Click the **Save** button.
27. Click the **Close** button.

To close out a stockpiled material:

1. Double-click the **Stockpiled Materials** icon.
2. Click the **Open** button.
3. In the **Contract ID** list box, scroll to and double-click the Contract.
4. In the **Stockpiled Materials** list box, scroll to and double-click the stockpiled material.
5. Click the **Services** menu, and then click the **Close Out Balance** choice.
6. Click the **Save** button.
7. Click the **Close** button.
To view Force Account totals:
1. Double-click the **Contract Records** icon.
2. Double-click the **Force Accounts** icon.
3. Click the **Open** button.
4. In the **Contract ID** list box, double-click the Contract ID.
5. In the **Force Account ID** list box, scroll to and double-click the **Force Account**.
6. Click the **Summary** folder tab.
7. Verify the **Force Account Adjustment Total**.
8. Click the **Close** button.

To add a claim to a Contract:
1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Disputes/Claims** icon.
4. Click the **Services** menu, and then click the **Choose Keys** choice.
5. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
6. In the **Type Ind** drop-down list, click the expand arrow and click **Claim**.
7. In the **Status** drop-down list, click the expand arrow and click the status.
8. In the **Category Type** drop-down list, click the expand arrow and click the category.
9. In the **Requested Days** field, type the number of days.
10. In the **Received Date** field, type the received date.
11. In the **Remarks** field, type the remarks.
12. Click the **Save** button.
13. Click the **Close** button.

To create a Correspondence Log to document a claim, attach Form DC 161, and forward the Correspondence to the Project Manager:
1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Correspondence Records** icon.
4. Click the **Service** menu, and then click the **Choose Keys** choice.
5. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
6. In the **Correspondence Type** drop-down list, click the expand arrow and click **Form**.
7. In the **On** field, type the received date.
8. In the **Sent From** field, type the Contractor’s name.
9. In the **Sent To** field, type the Project Manager’s name.
10. In the **Document Category** drop-down list, click the expand arrow and click **Claims/Disputes**.
11. In the **Major Topics** field, type the major topics.
12. In the **Dispute** field, perform a Search and double-click the desired claim.
13. Click the **Save** button.
14. Click the **Attachments** button.
15. Click the **New OLE** button.
16. Click the **Create from File** button.
17. Browse to the desired document.
18. Click the **Open** button.
19. Click the **OK** button.
20. In the **Name** field, type the name of the attachment.
21. In the **Description** field, type the description of the attachment.
22. In the **Attachment Security** box, click the **Add All** button.
23. Click the **Add** button.
24. Click the **Save** button.
25. Click the **Services** menu, and then click the **Forward To...** choice.
26. In the **User Name** list box, scroll to and click the desired Project Manager.
27. Click the **OK** button.
28. Click the **OK** button.
29. Click the **Save** button.
30. Click the **Close** button.
Summary for Section 4

In the following exercise, you will maintain Contract 8888C in SiteManager.

Login: tpxxxxx    Group: OENGR    Contract: 8888C

1. Navigate to the Checklist Event Dates window.

2. Open the Checklist Events for Contract 8888C and enter actual date 09/03/08 for TAD 1276/CC257.

3. Enter the Start Date of 08/11/08 for Milestone 01 Stage 1a.

4. Navigate to the Stockpiled Materials window and add a stockpiled material using the following information (Hint – You will need to use Choose Keys)

   - Category Nbr 0004, Line Nbr 0046, Item Code 507002P, Description Elastomeric Concrete Bridge Joint System.
   - Stockpiled Desc: Elastomeric Concrete Bridge Joint System
   - Invoice Date: 08/12/08
   - Invoice Number: 0010
   - Quantity: 220
   - Units: Linear Foot
   - Unit Price: 10.00
   - Conv Factor: 1.00
   - Initial Invoice Payment: 2200.00

5. Navigate to the Force Accounts window and add the a Force Account to Contract ID 8888C using the following information:

   - Description: Deteriorating Bearings
   - Purpose: Replaced Deteriorating Bearings
   - Equipment:

<table>
<thead>
<tr>
<th>Description</th>
<th>Used Rate</th>
<th>Idle Rate</th>
<th>Owned/Rented</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crane</td>
<td>30.00</td>
<td>25.00</td>
<td>Contractor Owned</td>
</tr>
<tr>
<td>150 CFM Diesel Air Compressor</td>
<td>12.14</td>
<td>1.55</td>
<td>Contractor Owned</td>
</tr>
</tbody>
</table>
• Laborers:

Labor Adj %: **25.**

<table>
<thead>
<tr>
<th>Worker Name</th>
<th>Class</th>
<th>Regular Rate</th>
<th>Overtime Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joe Digger</td>
<td>Operator – Crane</td>
<td>41.00</td>
<td>63.00</td>
</tr>
<tr>
<td>Manuel Ortega</td>
<td>Laborer</td>
<td>31.00</td>
<td>46.00</td>
</tr>
</tbody>
</table>

• Materials

Material Adj %: **25.**

<table>
<thead>
<tr>
<th>Invoice ID</th>
<th>Invoice Dt</th>
<th>Material Description</th>
<th>Delivered Qty</th>
<th>Units Type</th>
<th>Unit Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>100-25</td>
<td>08/12/08</td>
<td>Epoxy Paint</td>
<td>1</td>
<td>Gallon</td>
<td>50.00</td>
</tr>
<tr>
<td>100-25</td>
<td>08/12/08</td>
<td>Bearing</td>
<td>10</td>
<td>Unit</td>
<td>500.00</td>
</tr>
</tbody>
</table>

6. Navigate to the **Disputes/Claims** window and enter that a Claim has been received with the following information:

• Type Ind: **Claim**

• Status: **Claim Notice Only**

• Category Type: **New Work**

• Requested Days: **20**

• Requested Amt: **40,000**

• Received Date: **08/25/08**

• Remarks: Additional construction work not in the Contract. Contractor’s Reference Number: IEW-8888C-01. Claim Event Date: 08/15/0
5 Creating Daily Work Reports

By the end of this section, you will be able to:

- Understand the Basic Concepts of Daily Work Reports
- Enter Basic Daily Work Report Information
- Enter Prime and Subcontractors on Site
- Enter Contractor Personnel
- Enter Contractor Equipment
- Enter NJDOT Daily Activity Hours
- Select and Record Work Items
- Record Daily Force Account Information
Understanding the Basic Concepts of Daily Work Reports

The Inspector creates daily records of construction activity in Daily Work Reports. Typically, for each Contract, each Inspector submits one Daily Work Report per day to the Resident Engineer. Only the Inspector who creates the DWR may modify it.

The Daily Work Report Select panel lets the User open a Daily Work Report. The User can open any DWR in the database, but the User cannot modify a report the User did not create. The DWR opens as Read Only if the system finds one of the following:

- The Daily Work Report has been transferred to the Project Manager
- The Daily Work Report has been authorized
- The Daily Work Report was authored by another user

The Daily Work Report window has the following folder tab:

DWR Info

The DWR Info folder tab lets the User create a new DWR and collect information about the day for which the report was created.

Contractors

The Contractors folder tab lets the User enter daily data about the Prime and Subcontractor(s), Supervisor(s), and variable labor (by personnel type).

Contractors Equip

The Contractor Equip folder tab lets the User document the daily presence and use of equipment on the job site for selected Contractor.

Work Activities

The Work Activities folder tab lets the User document his or her daily activities on the Contract. This information is later transferred to the Contract Manpower Program and reported on the Weekly Progress Report.
**Work Items**

The Work Items folder tab lets the User view and add daily usage data for installed Work Items.

**Force Accounts**

The Force Accounts folder tab lets the User record force account equipment, labor, and materials.

---

In NJDOT, Resident Engineers, Office Engineers, and Inspectors are to create Daily Work Reports to record the daily construction activity. The first DWR for the Contract is to be created for the date of the Official Contract Start Date or when the Contractor begins work, whichever is first.

The Resident Engineer is to ensure that a DWR is created for each day of the Contract with the exception of Saturdays, Sundays, and Holidays, unless work was performed on those days until the Contract is complete.

Only one Daily Work Report is to be created per person, per day, per Contract.

---

The purpose of the DWR at the point of the Official Contract Start Date if the Contractor has not yet begun working is to record that the Contractor is not on site.

This is identified in SiteManager as the Completion Date Key Date.
Exercise 5-1
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will open the Daily Work Report window.

Login: tpxxxxx    Group: INSP    Contract: ID

1. Double-click the SiteManager icon on your desktop.
2. In the User ID field, type tpxxxxx.
3. Press the Tab key.
4. In the Password field, type pass.
5. Press the Enter key.
6. Double-click the Daily Work Reports icon.
7. Double-click the Daily Work Reports icon.
8. Click the Services menu, and then click the Choose Keys choice.
9. In the Contract ID list box, scroll to and double-click Contract ID ID.
Entering Basic Daily Work Report Information

The DWR Info folder tab lets the User create a new DWR and collect information about the day for which the DWR was created. For example, the User enters the weather conditions and high and low temperatures for the day here. The name of the author of this report is displayed in the Inspector field. The date covered by this report is displayed in the DWR Date field. The Locked and Authorized fields indicate the state of the DWR. An authorized DWR has been approved for payment. If either the Locked or Authorized field displays Yes, the User can not modify the DWR.

This folder tab has three check boxes - No Contractors On Site, No Daily Staff On Site, and No Work Items Installed - that indicate there is no data for the subject. These boxes are checked by default. When the User enters data for the subject on another folder tab, the corresponding check box is cleared automatically.

General remarks are also recorded on this folder tab. To record a remark, the User must first select a remark type. If a remark has already been entered for the selected type, as indicated by a check mark next to the type, the remark appears in the Remarks field. A remark does not have a size limit, and can be pasted to and from a word processor.

Figure 5-2. DWR Info Tab
The DWR is to be created for the date in which the work was performed and created in SiteManager no later than the close of business the day after the work was performed.

If the work takes place overnight, then the DWR is to be created for the day the work was initiated.

At a minimum, the following information is to be entered on the DWR Info. folder tab:

- DWR Date
- Temperature
- AM and PM Weather Conditions
- Environmental and Safety Remarks
Exercise 5-2
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will enter the basic information for a Daily Work Report.

Login: tpxxxxx  Group: INSP  Contract: ID

1. In the DWR Date field, type 080708.

2. Press the Tab key.

3. In the High Temperature field, type 92 degrees.

4. In the Low Temperature field, type 87 degrees.

5. In the A.M. field, click the expand arrow and click Sunny.

6. In the P.M. field, click the expand arrow and click Partly Sunny.

7. In the Remarks Type list box, scroll to and click -Environmental.

8. In the Remarks text box, type No environmental issues as of today.

9. In the Remarks Type list box, scroll to and click -Safety.

10. In the Remarks text box, type All safety devices clean and installed in accordance with the TCP.

11. Click the Save button.
Entering Prime and Subcontractors on Site

The Contractor drop-down list will contain the Prime Contractor and any qualified Subcontractors. Subcontractors are qualified for specific work items in the Subcontract window of the Contract Administration component.

![Daily Work Reports]

Figure 5-3. The Contractors Folder Tab

All Contractors (prime and subcontractors) on site for the day are to be identified.

If the Subcontractor on site is not available in the drop-down list, verify that the Subcontractor has been entered in the Subcontract window and contact the Regional Subcontract Coordinator.
Exercise 5-3
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will enter the Prime Contractor and a Subcontractor as on site for the day.

Login:  tpxxxxx    Group:  INSP    Contract:  ID

1. Click the Contractors folder tab
2. On the Contractors folder tab, click the Contractor area.
3. Click the New button. An empty row is added to the list.
4. In the Contractor drop-down list, click the expand and click IEW CONSTR GP **PRIME**.
5. Click the Save button.
6. Click the New button. An empty row is added to the list.
7. In the Contractor drop-down list, click the expand arrow and click AMERICAN SAFETY SVS INC.
8. Click the Save button.
# Entering Contractor Personnel

The personnel drop-down list will contain personnel types added to the Contract Master List.

![Daily Work Reports](image)

<table>
<thead>
<tr>
<th>Contract ID</th>
<th>Company Name</th>
<th>No. of Supervisors</th>
<th>No. of Workers</th>
<th>Contractor Hours Worked</th>
</tr>
</thead>
<tbody>
<tr>
<td>12345</td>
<td>American Safety System</td>
<td>2</td>
<td>5</td>
<td>100.00</td>
</tr>
<tr>
<td>12346</td>
<td>Example Constr GP</td>
<td>3</td>
<td>3</td>
<td>30.00</td>
</tr>
</tbody>
</table>

**Figure 5-4. The Contractors Folder Tab – Personnel**
The Personnel Type section of the window is to be used to record each Contractor’s staff on site for the day. For each personnel type selected, the number of people on site and the hours worked are to be entered. SiteManager will calculate the total number of hours for each Personnel Type.

The Vendor Master List contains personnel types listed multiple times such as Laborer, Laborer(1), and Laborer(2). When recording personnel types, record all personnel who worked the same number of hours to the same personnel type. For example, if there are three laborers on the job site and two laborers worked for eight hours and one laborer worked for 4 hours, the personnel are to be recorded as follows:

<table>
<thead>
<tr>
<th>Personnel Type</th>
<th>Nbr of Persons</th>
<th>Hours Worked</th>
<th>Total Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>Laborer</td>
<td>2</td>
<td>8</td>
<td>16</td>
</tr>
<tr>
<td>Laborer(1)</td>
<td>1</td>
<td>4</td>
<td>4</td>
</tr>
</tbody>
</table>

If the required personnel is not available in the drop-down list, contact the Resident Engineer.

NJDOT is not using the Supervisor/Foreman section of this window.
Exercise 5-4
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will enter Contractor personnel for the Prime and Subcontractor.

Login:  tpxxxxx    Group:  INSP    Contract:  ID

1. On the Contractors folder tab, click the IEW CONSTR GP **PRIME** contractor.

2. Click the Personnel Type area.

3. Click the New button. An empty row is added to the list.

4. In the Personnel Type drop-down list, click the expand arrow and click Labor Foreman.

5. In the Nbr of Persons field, type 1.

6. In the Hours Worked field, type 8.

7. Click the New button. An empty row is added to the list.

8. In the Personnel Type drop-down list, click the expand arrow and click Laborer.

9. In the Nbr of Persons field, type 1.

10. In the Hours Worked field, type 8.

11. Click the New button. An empty row is added to the list.

12. In the Personnel Type drop-down list, click the expand arrow and click Labor(1).

13. In the Nbr of Persons field, type 1.


15. Click the Save button.

16. On the Contractors folder tab, click the AMERICAN SAFETY SVS INC contractor.

17. Click the Personnel Type area.
18. Click the **New** button. An empty row is added to the list.

19. In the **Personnel Type** drop-down list, click the expand arrow and click **Traffic Control Coordinator (1)**.

20. In the **Nbr of Persons** field, type **1**.

21. In the **Hours Worked** field, type **8**.

22. Click the **Save** button.

23. Click the **Personnel Type** area.

24. Click the **New** button. An empty row is added to the list.

25. In the **Personnel Type** drop-down list, click the expand arrow and click **Truck Driver-Teamster**.

26. In the **Nbr of Persons** field, type **1**.

27. In the **Hours Worked** field, type **8**.

28. Click the **Save** button.
Entering Contractor Equipment

The Contractor Equip folder tab lets the User document the presence and use of equipment on the job site for the selected Contractor. The User enters the number of pieces of each equipment-type on the site on this date, the number of pieces used, and the number of hours each equipment-type was used. The User must select a Contractor before entering equipment information for the Contractor.

After the User selects a Contractor, the User can select Equipment IDs from the drop-down list in the Equipment ID-Description field. The records that appear on the drop-down list are stored in the User’s Master List. To add a record that does not appear on the drop-down list, the User must first add it to the Equipment Master List.

![Figure 5-5. The Daily Contractor Equipment Folder Tab](image)

Each piece of equipment on site for the day is to be recorded. The Number of Pieces, Number Used, and Hours Used are optional fields; however, these fields are to be entered in the event of a delay.

Additional information regarding equipment is to be recorded in Remarks.
Exercise 5-5
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will enter Contractor equipment for the Prime and Subcontractor.

Login: tpxxxxx  Group: INSP  Contract: ID

1. Click the Contractor Equipment folder tab.

2. Click the IEW CONSTR GP **PRIME** Contractor.

3. Click the Equipment ID-Description area.

4. Click the New button. An empty row is added to the list.

5. In the Equipment ID-Description drop-down list, click the expand arrow and click Pickup Truck-3/4T.

6. In the Nbr. of Pieces field, type 2.

7. In the Nbr Used field, type 2.

8. In the Hours Used field, type 8.

9. Click the New button. An empty row is added to the list.

10. In the Equipment ID-Description drop-down list, click the expand arrow and click Compressor-Diesel.

11. In the Nbr. of Pieces field, type 1.

12. In the Nbr Used field, type 1.

13. In the Hours Used field, type 4.

14. Click the Save button.

15. Click the AMERICAN SAFETY SVS INC Contractor.

16. Click the Equipment ID-Description area.

17. Click the New button. An empty row is added to the list.

18. In the Equipment ID-Description drop-down list, click the expand arrow and click Crash Attenuators-Truck Mounted.

19. In the Nbr. of Pieces field, type 1.
20. In the **Nbr Used** field, type **1**.

21. In the **Hours Used** field, type **8**.

22. Click the **Save** button.
**Entering NJDOT Daily Activity Hours**

The Work Activities folder tab lets the User record the number of regular and overtime hours performed by the DWR creator for that day and Contract. The hours reported on the Daily Staff folder tab will be transferred to the Contract Manpower Program and reported on the Weekly Report.

![Daily Work Reports](image)

**Figure 5-6. The Daily Staff Folder Tab**

The creator of the DWR is to enter the number of regular and overtime hours worked for each work activity performed on the selected Contract.

The Resident Engineer or his designee is to transfer the information entered on the Work Activities folder tab to the Contract Manpower Program.
**Exercise 5-6**
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will enter the activity and hours for the NJDOT Inspector.

- **Login:** tpxxxxx  **Group:** INSP  **Contract:** ID

1. Click the **Work Activities** folder tab.
2. Click the **New** button.
3. In the **Work Activities** drop-down list, click the expand arrow and click **Curb and Sidewalk**.
4. In the **Reg. Hours** field, type **8**.
5. Click the **Save** button.
Selecting and Recording Work Items

The Work Items folder tab lets the User view and add daily usage data for installed Work Items. Before entering Work Item data, the Contractor responsible for the Work Item must be entered on the Contractors folder tab. When the User first selects the Work Items folder tab, the Select Work Item list is displayed. The Record Work Item and Selects Work Item buttons let the User toggle between two different versions of the Work Items folder tab. To enter usage data, the User first selects the Work Item and then selects the Record Work Item button (or the Record Work Item option on the Edit menu). This displays the Record Work Items folder tab on which the User can view and add daily usage data.

![Image](image.png)

Figure 5-7. The Record Work Item and Selects Work Item Buttons

The User can toggle between two different versions of the Work Items folder tab. When the User first selects the Work Items folder tab, or when the Selects Work Item button is clicked, the Select Work Items folder tab lists Work Items for the selected Contract. The Work Items are listed in ascending order by Project Number then Item Code. The User can find, filter, and sort the list. If an Item has installed quantities for the selected DWR, the Installed (Instld) check box is checked (ON).

![Image](image.png)

Figure 5-8. The Select Work Items Folder Tab
When the Record Work Item button is clicked, the Record Work Items window displays usage information on the selected Item for the DWR. The Record Work Items window allows the User to view existing data for the Work Item or add new usage data.

![Record Work Items Window](image)

Figure 5-9. The Record Work Items Folder Tab

The Record Work Items window displays the following Item information:

- **Qty Reported to Date** – Total quantity reported on DWRs.
- **Qty Authorized to Date** – Total quantity reported on DWRs that were authorized in Diaries.
- **Units Type** - The unit of measure for the pay item.
- **Qty Installed to Date** – Total quantity reported on DWRs that were authorized in Diaries and included in approved and pending estimates.
- **Qty Paid to Date** – Total quantity reported on DWRs that were authorized in Diaries and included in an estimate of any status. This value will always be the same as the Qty Installed to Date when all estimates are approved.
- **Current Contract Qty** - Current contract quantity of the Contract line item including any Change Orders. Current Quantity is calculated by the sum of Bid Quantity and the net Change Order quantity.
In NJDOT, at a minimum, the following information is to be entered on the Record Work Items folder tab:

- **Placed Quantity**

- **Plan Page Number** – IAWD should be entered for if and where directed items. COP should be entered for Change of Plan.

- **Contractor**

- **Location**

- **Station Information**, if applicable.

The As-Built quantity is to be entered in the As-Built Qty field once the quantity is known. This information displays on the DC 104 As-Built Summary Report and is used in analyzing the as-built and paid to date quantities.

On Federal Contracts, retainage is not to be withheld on work performed by Subcontractors. Therefore, it is imperative to associate the Contractor performing the work to the correct placed quantities. If more than one contractor performs work on the same item, the Contractor performing the majority work is to be recorded.

Remarks are available for each item’s installation location sequence number. Remarks are to be entered as appropriate to document additional information regarding the placement of the item.

Attachments are also available for each item’s installation location sequence number. Attachments are to be created at the Inspector’s discretion or Resident Engineer’s direction in accordance to the NJDOT SiteManager attachment policy.

**SiteManager does not pay the quantities entered in the As-built Qty field.**

---

**Exercise 5-7**

Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will record a work item performed by the Prime Contractor in two locations on the same day.

**Login: tpxxxxx**  **Group: INSP**  **Contract: ID**
1. Click the **Work Items** folder tab.

2. Scroll to and click Line Item Number 0034, Category Number 0001, Item Code 602213M, Description **Curb Piece**.

3. Click the **Record Work Item** button. SiteManager displays the info on the **Work Items** panel.

4. Click the **New** button.

5. In the **Placed Qty** field, type 1.

6. In the **Plan Page Nbr** field, type 10.

7. In the **Contractor** drop-down list, click the expand arrow and click **IEW CONSTR GP **PRIME**.

8. In the **Location** field, type Rt. 8002.

9. In the **Station From** field, type 102 + .0 L 25.

10. In the **Station To** field, type 102 + .00 L 25.

11. Click the **Save** button.

12. Click the **New** button.

13. In the **Placed Qty** field, type 1.

14. In the **Plan Page Nbr** field, type 10.

15. In the **Contractor** drop-down list, click the expand arrow and click **IEW CONSTR GP **PRIME**.

16. In the **Location** field, type Rt. 8002.

17. In the **Station From** field, type 103 + 0 R 25.

18. In the **Station To** field, type 102 + 0 R 25.

19. Click the **Save** button.
Exercise 5-8
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will record a work item performed by the Subcontractor.

Login: tpxxxxx Group: INSP Contract: ID

1. Click the Selects Work Item button.

2. Scroll to and click Line Item Number 0011, Category Number 0001, Item Code 159006M, Description Drum.

3. Click the Record Work Item button. SiteManager displays the info on the Work Items panel.

4. Click the New button.

5. In the Placed Qty field, type 10.

6. In the Plan Page Nbr field, type 20.

7. In the Contractor drop-down list, click the expand arrow and click AMERICAN SAFETY SVS INC.

8. In the As-Built Qty field, type 10.00.

9. In the Location field, type Rt. 8002.

10. Click the Measured radio button ON.

11. In the Station From field, type 102 + 0 L 15.

12. In the Station To field, type 103 + 00 L 15.

13. Click the Save button.
Recording Daily Force Account Information

The Force Accounts folder tab allows the User to view or add daily information on a Force Account. The daily Force Account data can be viewed in Contract Administration after the Resident Engineer authorizes the DWRs.

When the User first selects the Force Accounts folder tab in DWRs, the folder tab lists the Force Accounts for the selected Contract. The User selects a Force Account on this list, selects the Record button on the toolbar, and selects the appropriate toolbar button to reach the folder tab:

- Force Account Equipment
- Force Account Labor
- Force Account Materials

The User can add daily Force Account data on these folder tabs. For example, to add equipment data related to a Force Account, the User first selects the Force Account. Then the User selects the Record button and the Equipment button. This opens the Daily Force Account Equipment folder tab.

Force Accounts are to be created and maintained by the Resident Engineer or his designee. If an additional piece of equipment, laborer, or material is needed, the Inspector is to contact the Resident Engineer so that it may be added to the Force Account window in the Contract Administration area.
Recording Daily Force Account Equipment Information

The Force Account tab, Equipment window lists all of the equipment authorized for the selected Force Account. It also includes the ownership information, the used rate, and the idle rate for each piece of equipment. The User can add the number of hours each piece of equipment was used and the number of hours it was idle.

![Daily Work Reports](image)

Figure 5-10. The Force Account Equipment Folder Tab

The Inspector is to record the number of hours used and number of hours idle for all Force Account equipment.

To add equipment to the Force Account, the Resident Engineer or his designee are to modify the Force Account Window in the Contract Administration area.
**Exercise 5-9**

Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will record Force Account equipment information.

Login: **tpxxxxx**  
Group: **INSP**  
Contract: **ID**

1. Click the Force Accounts folder tab.
2. Click Force Account ID 1 Inlet Reconstruction.
3. Click the Records FA Information button.
4. In the Combination Backhoe Hrs Used field, type 4.
5. In the 150 CFM Diesel Air Compressor Hrs Used field, type 2.
6. In the 90 # Jackhammer Hrs Used field, type 2.
7. Click the Save button.
Recording Daily Force Account Labor Information

The Force Account tab, Labor window lists all the workers authorized for the selected Force Account. It also includes the regular, overtime, and fringe rates for each worker. The User can add the number of regular and overtime hours worked by each worker in this window.

![Daily Work Reports](image)

<table>
<thead>
<tr>
<th>Worker Name</th>
<th>Class</th>
<th>Regular Hrs</th>
<th>Regular Rate</th>
<th>Fringe Rate</th>
<th>OT Hrs</th>
<th>OT Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joe Rogers</td>
<td>Operator-Ec</td>
<td>4.008200</td>
<td>30</td>
<td>0.008360</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manuel Ortiz</td>
<td>Labor-Forer</td>
<td>4.008200</td>
<td>30</td>
<td>0.008360</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Joseph Lombardi</td>
<td>Labor</td>
<td>2.008200</td>
<td>30</td>
<td>0.008360</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 5-11. Force Account Labor Folder Tab

The Inspector is to record the hours for all Laborers on the Force Account.

To add the laborers to the Force Account, the Resident Engineer or his designee are to modify the Force Account Window in the Contract Administration area.
Exercise 5-10
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will record Force Account labor information.

Login: tpxxxxx  Group: INSP  Contract: ID

1. Click the FA Labor button.

2. In the Joe Digger Regular Hrs field, type 4.

3. In the Manuel Ortega Regular Hrs field, type 4.

4. In the Joseph Lombardi Regular Hrs field, type 2.

5. Click the Save button.
Recording Daily Force Account Material Information

The DWR Force Account folder tab, Materials window lists all of the materials authorized for the selected Force Account. It also includes the invoice ID, the unit price, and the unit of measurement for each material. The User can add the quantity of each material that was used in this window.

<table>
<thead>
<tr>
<th>Invoice</th>
<th>Description</th>
<th>Quantity</th>
<th>Unit Price</th>
<th>Unit of Measure</th>
</tr>
</thead>
<tbody>
<tr>
<td>100.01</td>
<td>Concrete Inlet Block</td>
<td>10.000</td>
<td>$100.00</td>
<td>UNIT</td>
</tr>
<tr>
<td>100.02</td>
<td>Type 3 Cement</td>
<td>5.000</td>
<td>$1,000.00</td>
<td>BAG</td>
</tr>
<tr>
<td>100.03</td>
<td>Sand</td>
<td>1.000</td>
<td>$250.00</td>
<td>TON</td>
</tr>
</tbody>
</table>

Figure 5-12. Force Account Materials Folder Tab

The Inspector is to enter the quantities of materials used each day for the Force Account.

To add the materials to the Force Account, the Resident Engineer or his designee are to modify the Force Account Window in the Contract Administration area.
Exercise 5-11
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will record Force Account Material information.

Login: tpxxxxx Group: INSP Contract: ID

1. Click the FA Material button.
2. In the Concrete Inlet Block Quantity field, type 50.
3. In the Type 3 Cement Quantity field, type 5.
4. In the Sand Quantity field, type 1.
5. Click the Save button.
Attaching the Contractor’s Force Account Log to the DWR

In the SiteManager Daily Work Report window, attachments can be linked to the DWR. The Attachment functionality of SiteManager allows URL links, Plug-In applications, and OLE attachments to be attached to certain SiteManager records. Attachments are activated by clicking the attachment button, then double-clicking the attachment.

The Microsoft Windows’ Object Linking and Embedding standard (OLE) allows Windows programs like SiteManager to access the functionality of other OLE-compliant Windows applications. The Attachments feature choice will work with any properly-installed, OLE-compliant Windows application.

When you use the OLE functionality to create a new attachment, you are actually embedding the data and the connection to the application’s functionality in the SiteManager database. Even though the OLE object is assigned a name, *the data does not actually exist as an external file on your network or workstation hard drive.* It only exists as a named object in the SiteManager database. Anyone with access to the record can assess the embedded data *if the application that created the data is installed on their workstation.*

Attachments can be created for each installation sequence number on the Work Items folder tab and/or for the DWR as a whole on the DWR. Info folder tab.

![Image of Force Account Attachment on DWR Info Folder Tab](image)

Figure 5-13. Force Account Attachment on DWR Info Folder Tab.
The Inspector is to attach the Force Account Daily Summary submitted by the Contractor to the DWR Info folder tab.

Attachments are to only be made to attach files in PDF, WORD, or Excel formats. All other file formats including pictures are to be maintained as project documentation outside of SiteManager.

Attachments are to be named with the following naming convention: YYYYMMDDAAAA where AAAA is an abbreviation of the attached document.

A description is also to be included for each attachment. When selecting Security Groups for attachments, “Add All” should be selected.

**Exercise 5-12**
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will attach the Force Account documentation received from the Contractor to the DWR.

Login:  tpxxxxx  Group: INSP  Contract: ID

1. Click the DWR Info. folder tab.
2. Click the Attachments button.
3. Click the New OLE button.
4. Click the Create from File button.
5. Click the Browse button.
6. Click the FA1 file to be attached in the following location: C:\SMTRAINS\SMFILES.
7. Click the Open button.
8. Click the OK button.
9. In the Name field, type 20080807FA01.
10. In the Description field, type Contractor’s 08/07/08 daily record of Force Account 1 activity.
11. In the **Attachment Security** box, click the **Add All** button.

12. Click the **Add** button.

13. Click the **Save** button.

14. Click the **Attachments** button.

15. Click the **New** button.  

The final step is to set up the **Summary Exercise** to prevent students from getting the ‘copy’ message.
## Review for Section 5

To open the Daily Work Reports window:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Services** menu, and then click the **Choose Keys** choice.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.

To enter the basic information for a Daily Work Report:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Services** menu, and then click the **Choose Keys** choice.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **DWR Date** field, type the DWR’s date.
6. Press the **Tab** key.
7. In the **High Temperature** field, type the days high temperature.
8. In the **Low Temperature** field, type the days low temperature.
9. In the **A.M.** field, click the expand arrow and click the morning weather condition.
10. In the **P.M.** field, click the expand arrow and click the afternoon weather condition.
11. In the **Remarks Type** list box, scroll to and click **-Environmental**.
12. In the **Remarks** text box, type the day’s environmental issues.
13. In the **Remarks Type** list box, scroll to and click **-Safety**.
14. In the **Remarks** text box, type the day’s safety issues.
15. In the **Remarks Type** list box, scroll to and click the desired Remark Type.
16. In the **Remarks** text box, type the desired remarks.
17. Repeat steps 15 and 16 for all desired remarks.
18. Click the **Save** button.

To enter the Prime Contractor and Subcontractor as on site for the day:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Open** button.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract.
5. In the **Inspector** list box, scroll to and double-click the desired Inspector.
6. In the **Date** list box, scroll to and double-click the desired date.
7. Click the **Contractors** folder tab.
8. On the **Contractors** folder tab, click the **Contractor** area.
9. Click the **New** button. An empty row is added to the list.
10. In the **Contractor** drop-down list, click the expand and click the desired Contractor.
11. Click the **Save** button.
12. Repeat steps 9-11 until all desired Contractors are added.
13. Click the **Save** button.
To enter Contractor personnel for the Prime and Subcontractor:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Open** button.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Inspector** list box, scroll to and double-click the desired Inspector.
6. In the **Date** list box, scroll to and double-click the desired date.
7. Click the **Contractors** folder tab.
8. On the **Contractors** folder tab, click the desired Contractor.
9. Click the **Personnel Type** area.
10. Click the **New** button. An empty row is added to the list.
11. In the **Personnel Type** drop-down list, click the expand arrow and click the desired personnel type.
12. In the **Nbr of Persons** field, type the number of onsite person for the personnel type.
13. In the **Hours Worked** field, type the number of hours worked for the personnel type.
14. Repeat steps 8-13 for each Contractor.
15. Click the **Save** button.

To enter Contractor equipment for the Prime and Subcontractor:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Open** button.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Inspector** list box, scroll to and double-click the desired Inspector.
6. In the **Date** list box, scroll to and double-click the desired date.
7. Click the **Contractor Equipment** folder tab.
8. Click the desired Contractor.
9. Click the **Equipment ID-Description** area.
10. Click the **New** button. An empty row is added to the list.
11. In the **Equipment ID-Description** drop-down list, click the expand arrow and click the desired equipment.
12. In the **Nbr. of Pieces** field, type the equipment number of pieces onsite.
13. In the **Nbr Used** field, type the equipment number that was used.
14. In the **Hours Used** field, type the number of hours the equipment was used.
15. Repeat steps 8-14 for each Contractor.
16. Click the **Save** button.

To record NJDOT Daily Activity Hours:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Open** button.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract.
5. In the **Inspector** list box, scroll to and double-click the desired Inspector.
6. In the **Date** list box, scroll to and double-click the desired date.
7. Click the **Work Activities** folder tab.
8. Click the **New** button.
9. In the **Work Activities** drop-down list, click the expand arrow and click the activity.
10. In the **Reg. Hours** field, type the number of hours worked.
11. Click the **Save** button.
To record a work item performed in two locations on the same day:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Open** button.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract.
5. In the **Inspector** list box, scroll to and double-click the desired Inspector.
6. In the **Date** list box, scroll to and double-click the desired date.
7. Click the **Work Items** folder tab.
8. Scroll to and click the desired item.
9. Click the **Record Work Item** button.
   SiteManager displays the info on the Work Items panel.
10. Click the **New** button.
11. In the **Placed Qty** field, type the placed quantity.
12. In the **Plan Page Nbr** field, type plan page number.
13. In the **Contractor** drop-down list, click the expand arrow and click desired Contractor.
14. In the **As-Built Qty** field, type the As-Built Quantity, if available.
15. In the **Location** field, type the location.
16. In the **Station From** field, type stations from information.
17. In the **Station To** field, type stations to information.
18. Click the **Save** button.
19. Repeat steps 10-18 for the second location.
20. Click the **Save** button.

To record Force Account information:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Open** button.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract.
5. In the **Inspector** list box, scroll to and double-click the desired Inspector.
6. In the **Date** list box, scroll to and double-click the desired date.
7. Click the **Force Accounts** folder tab.
8. Click the desired Force Account ID.
9. Click the **Records FA Information** button.
10. In the **Hrs Used** field for each piece of equipment type the number of hours the equipment was used.
11. Click the **Save** button.
12. Click the **FA Labor** button.
13. In the **Hours Used** field for each laborer, type the number of hours.
14. Click the **Save** button.
15. Click the **FA Material** button.
16. In the **Quantity** field for each material, type the quantity used.
17. Click the **Save** button.
To attach the Force Account documentation received from the Contractor to the DWR:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Open** button.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract.
5. In the **Inspector** list box, scroll to and double-click the desired Inspector.
6. In the **Date** list box, scroll to and double-click the desired date.
7. On the **DWR Info** folder tab, click the **Attachments** button.
8. Click the **New OLE** button.
9. Click the **Create from File** button.
10. Click the **Browse** button.
11. Click the desired file to be attached.
12. Click the **Open** button.
13. Click the **OK** button.
14. In the **Name** field, type desired name.
15. In the **Description** field, type appropriate description.
16. In the **Attachment Security** box, click the **Add All** button.
17. Click the **Add** button.
18. Click the **Save** button.
19. Click the **Close** button.
Summary for Section 5

In the following exercise you will create a DWR for 8/11/08 for Contract 8888D, with the following information:

Login: tpxxxxx  Group: INSP  Contract: 8888D

Contract: 8888D
Date: 08/11/08

Weather conditions:
- High - 92 degrees
- Low - 72 degrees
- AM - Sunny
- PM – Cloudy / Overcast

Remarks:
- Environmental: No environmental issues as of today
- Safety: All Safety devices clean and installed in accordance with the TCP.

Contractors:
- IEW Constr Gp
- Parapet Constructors

IEW Personnel:
- 1 Labor Forman worked 8 hours
- 4 Laborers worked 8 hours each

Parapet Constructors Personnel:
- 3 Carpenters worked 8 hours each
- 3 Laborers worked 8 hours each
- 1 Carpenter foreman worked 8 hours

IEW Equipment:
- Traffic Line Remover – Truck Mtd.: 1 onsite and used for 8 hours.
- Pick-Up Truck – 1T: 1 onsite and used for 8 hours.

Parapet Constructors Equipment:
- Compressor – Diesel: 1 used onsite for 8 hours.

Work Activities:
- Sam Brown – Miscellaneous – 8 hours.

Work Items:
1. Line Item Number 0039, Category Number 0001, Item Code 610036M, Description Removal of Traffic Stripes
   - Placed Qty: 1000
   - Plan Page Nbr: 23
   - Contractor: IEW CONSTR GP
   - Location: Route 476 Northbound
   - Station From: 124 + 95 R 25
   - Station To: 125 + 75 R 25
2. Line Item Number 0050, Category Number 0004, Item Code 551030M, Description Curb Reconstruction, Curb
   - Placed Qty: 30
   - Plan Page Nbr: 10
   - Contractor: Parapet Constructors, Inc.
   - As-Built Qty: 30.00

Force Account 2 Bearing:
   - Crane - 6 hours
   - Air Compressor – 6 hours
   - Joe Digger – 6 hours
   - Manuel Ortega – 6 hours
   - Epoxy Paint – 1
   - Bearing – 10

Location: Rt. 476 Southbound right shoulder
- Station From: 125 + 0 R 50
- Station To: 125 + 30 R 50
- Measured Indicator: ON

What do you do with the Contractor’s Force Account Log?

Attach it to the DWR Info. Folder Tab

Navigate to the Main Panel.
This page intentionally left blank.
6 Copying Daily Work Reports

By the end of this section, you will be able to:

- Copy a DWR and Update the DWR Info Folder Tab
- Modify a Copied DWR
- Record Items on a DWR Template
Copying a DWR and Updating the DWR Info
Folder Tab

After creating the first Daily Work Report for a new Contract, it is easier to copy the existing DWR rather than creating a new one from scratch. A copied DWR includes copies of the following data to a new Daily Work Report:

- Contractor
- Personnel
- Equipment
- Work Activities

A copied DWR will not include the following data from the original Daily Work Report:

- Basic DWR Info
- Installed Work Items
- Force Accounts

To copy a DWR, the user simply changes the date on any existing DWR. This prompts the user to confirm the Contractor data should be copied to the new DWR date. You may use the calendar to indicate the new DWR date, or you may type the new date over the existing date in the date field.

The DWR being copied must have been authored by the user copying it.
At a minimum, the following information is to be entered on a copied DWR on the DWR Info. folder tab:

- DWR Date
- Temperature
- AM and PM Weather Conditions
- Environmental and Safety Remarks

**Exercise 6-1**
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you copy a DWR and modify the basic DWR information.

1. Double-click the Daily Work Reports icon.
2. Double-click the Daily Work Reports icon.
3. Click the **Open** button.

4. Click the **Contract ID** button.

5. In the **Contract ID** list box, scroll to and double-click Contract ID ID.

6. In the **Inspector** list box, scroll to and double-click Inspector Name *Brown, Sam*.

7. In the **Date** list box, scroll to and double-click DWR Date 08/08/08.

8. Double-click the **DWR Date** field.

9. Click the back arrow until the calendar displays *August 2008*.

10. Click the **08/11/08** date.

11. Click the **OK** button.

12. Click the **Yes** button.

13. In the **High Temperature** field, type 85 degrees.

14. In the **Low Temperature** field, type 70 degrees.

15. In the **A.M.** field, click the expand arrow and click **Cloudy/Overcast**.

16. In the **P.M.** field, click the expand arrow and click **Partly Sunny**.

17. In the **Remarks Type** list box, scroll to and click **-Environmental**.

18. In the **Remarks** text box, type *Erosion from last night’s rain on Brown-Weber Route*.

19. In the **Remarks Type** list box, scroll to and click **-Safety**.

20. In the **Remarks** text box, type *All devices in place as per TCP*.

21. Click the **Save** button.
Modifying a Copied DWR

Once a Daily Work Report is copied, the User may modify the Contractors, Personnel Types, Equipment, and Daily Staff on the new DWR to reflect the activities of the day.

The Contractors Folder Tab

The Contractors (Prime and Sub), and Personnel Types as well as the number of workers may be modified on the Contractors folder tab.

![Daily Work Reports](image)

Figure 6-2. DWR Contractor Folder Tab

The Inspector is to review the DWR Contractors folder tab on a copied DWR for accuracy and modify the information to document the day’s Contractors and personnel types on site.
Exercise 6-2
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will update the Contractors folder tab on a copied DWR.

Login: tpxxxxx  Group: INSP  Contract: ID

1. Click the Contractors folder tab.
2. Click the Contractor A5768 AMERICAN SAFETY SVS INC.
3. Click the Personnel Type Truck Driver-Teamster.
4. Click the Delete button.
5. Click the Yes button.
6. Click the Save button.
7. In the Traffic Control Coordinator(1) Hours Worked field, type 8.
8. Click the Save button.
9. Click the Contractor I2943 IEW CONSTR GP **PRIME**.
10. Click the Personnel Type area.
11. In the Labor Foreman Hours Worked field, type 8.
12. In the Laborer Hours Worked field, type 8.
13. In the Laborer(1) Hours Worked field, type 4.
14. Click the New button. An empty row is added to the list.
15. In the Personnel Type drop-down list, click the expand arrow and click Asphalt Laborer.
16. In the Nbr of Persons field, type 3.
17. In the Hours Worked field, type 8.
18. Click the Save button.
The Contractor Equipment Folder Tab

The contractors’ equipment as well as the number of pieces used may be modified on the Contractor Equipment folder tab.

![Daily Work Reports](image)

Figure 6-3. The Daily Contractor Equipment Folder Tab

The Inspector is to review the Contractor Equip. folder tab on a copied DWR for accuracy and modify the information to document the days equipment on site.
Exercise 6-3
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will update the Contractors Equipment folder tab on a copied DWR.

Login: tpxxxxx     Group: INSP     Contract: ID

1. Click the Contractor Equipment folder tab.
2. Click the 12943 I EW CONSTR GP **PRIME** Contractor.
3. Click the Equipment ID-Description area.
4. Click the New button. An empty row is added to the list.
5. In the Equipment ID-Description drop-down list, click the expand arrow and click Compactor Vibratory Roller.
6. In the Nbr. of Pieces field, type 1.
7. In the Nbr Used field, type 1.
8. In the Hours Used field, type 4.
9. Click the Save button.
The Work Activities Folder Tab

The NJDOT Daily Activity Hours should be modified on the Work Activities folder tab.

Figure 6-4. The Daily Contractor Equipment Folder Tab

The Inspector is to review the Work Activities folder tab on a copied DWR for accuracy and modify the information to document the day’s activity hours.

Exercise 6-4
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will update the Work Activities folder tab on a copied DWR.

Login: tpxxxxx  Group: INSP  Contract: ID

1. Click the Work Activities folder tab.
2. How many hours are recorded for Curb and Sidewalk? 8
3. Click the Save button.
Recording Items on a DWR Template

DWR Templates are used to record Contract activity data that cannot be entered on standard SiteManager panels. DWR Templates can also calculate values for work items and those values can be returned to populate the Placed Qty field of the Daily Work Report. If an item has an associated template for the Contract that returns a value, then the Placed Qty field can only be populated by that return value by recording data to DWR Templates. The list of DWR templates available for the item may be accessed with the DWR Template button.

Any DWR Templates associated to the selected Item are available from the DWR Template window for viewing or entering data. The DWR Template panel is accessed with the DWR Template button. If the item requires the use of a template, the DWR Template panel automatically displays when the work item location and Contractor data is saved.

![The DWR Template Button](image)

Figure 6-5. The DWR Template Button

The DWR Templates panel displays a list of the DWR Templates available for use with this Work Item. The user chooses which DWR Template associated to the selected Item to view or record data to. Once the DWR Template has been chosen the User can enter data into the template.

![The DWR Template Panel](image)

Figure 6-6. The DWR Template Panel

As of October 2008, the following templates are available:

- DC 29B
- DC 29C
- DC 29D
- DC 92
- Lane Occupancy
- Asphalt Percentage
NJDOT has developed a number of SiteManager DWR Templates similar to the forms currently used for calculating and recording item quantities.

The Asphalt Percentage Template MUST be populated with the Asphalt Percent for items subject to an asphalt adjustment if the DC 29B or DC 29C is NOT utilized.

Lane Occupancy Charges are to be applied through a DWR template. If the charges do occur, the Resident Engineer or his designee are to initiate a Change Order to add the Lane Occupancy Charge item to the Contract. Once the Change Order is approved, the item is to be recorded on a DWR for the date the charge should be applied.

The DC 29B and DC 29C templates contain a field to capture the Asphalt percentage.
Exercise 6-5
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you enter Contractor equipment for the Prime and Subcontractor.

Login: _tpxxxxx_   Group: _INSP_   Contract: _ID_

1. Click the **Work Items** folder tab.

2. Scroll to and click Line Item Number **0029**, Category Number **0001**, Item Code **401063M**, Description **Hot Mix Asphalt 12.5 H 76 Surface Course**.

3. Click the **Record Work Item** button. SiteManager displays the info on the **Work Items** panel.

4. Click the **New** button.

5. In the **Plan Page Nbr** field, type **10**.

6. In the **Contractor** drop-down list, click the expand arrow and click **IEW CONSTR GP **PRIME****.

7. In the **Location** field, type **Rt. 8002**

8. In the **Station From** field, type **102 + .0 L 25**.

9. In the **Station To** field, type **102 + 25 L 25**.

10. Click the **Save** button.

11. Click the **DWR Template** button.

12. Double-click Template ID **DC 29B**, Description **DC 29B — Bituminous Concrete Pavement**.

13. In the **Producer** field, type **Tilcon – Riverdale**.

14. In the **Base Temperature** field, type **74**.

15. In the **Asphalt Percentage** field, type **5**.

16. In the **Mix No** field, type **C14DC0125**.

17. In the **Highest** field, type **318**.

Notice the availability of the Asphalt Percentage template.
18. In the **Lowest** field, type **312**.

19. Click the **Save** button.

20. In the **Location Baseline Station to Station** field, type **102+00 to 102+25**.

21. In the **Lane** field, type **L1**.

22. In the **Lift** field, type **1**.

23. In the **Thickness In.** field, type **2**.

24. In the **Lot No.** field, type **1**.

25. In the **Lbs. Received** field, type **157,000**.

26. In the **Lbs. Laid** field, type **154,000**.

27. In the **S. Y. Laid** field, type **667**.

28. What is the **Lbs/S. Y.?**

\[
\begin{align*}
230.88
\end{align*}
\]

29. Click the **Save** button.

30. Click the **New** button.

31. In the **Location Baseline Station to Station** field, type **102+00 to 102+25**.

32. In the **Lane** field, type **R1**.

33. In the **Lift** field, type **1**.

34. In the **Thickness In.** field, type **2**.

35. In the **Lot No.** field, type **2**.

36. In the **Lbs. Received** field, type **158,000**.

37. In the **Lbs. Laid** field, type **155,000**.

38. In the **S. Y. Laid** field, type **668**.

39. What is the **Lbs/S. Y.?**

\[
\begin{align*}
232.04
\end{align*}
\]

40. What is the **Placed Quantity?**

\[
\begin{align*}
154.50
\end{align*}
\]
41. Click the **Save** button.

42. Click the **Close** button.

43. Click the **Close** button.
Review for Section 6

To copy a DWR:

1. Double-click the Daily Work Reports icon.
2. Double-click the Daily Work Reports icon.
3. Click the Open button.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. In the Inspector list box, scroll to and double-click the desired Inspector.
6. In the Date list box, scroll to and double-click the desired DWR date.
7. Double-click the DWR Date field.
8. Click the back arrow until the calendar displays the month and year of the DWR date that will be copied.
9. Click the DWR date to copy.
10. Click the OK button.
11. Click the Yes button.
12. In the High Temperature field, type the high temperature.
13. In the Low Temperature field, type the low temperature.
14. In the A.M. field, click the expand arrow and click the appropriate morning weather condition.
15. In the P.M. field, click the expand arrow and click the appropriate afternoon weather condition.
16. In the Remarks Type list box, scroll to and click -Environmental.
17. In the Remarks text box, type the environmental remarks.
18. In the Remarks Type list box, scroll to and click -Safety.
19. In the Remarks text box, type the Safety remarks.
20. Click the Save button.

To add a Contractor to a DWR:

1. Double-click the Daily Work Reports icon.
2. Double-click the Daily Work Reports icon.
3. Click the Open button.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. In the Inspector list box, scroll to and double-click the desired Inspector.
6. In the Date list box, scroll to and double-click the desired DWR date.
7. Click the Contractors folder tab.
8. On the Contractors folder tab, click the Contractor area.
9. Click the New button. An empty row is added to the list.
10. In the Contractor drop-down list, click the expand and click the desired Contractor.
11. Click the Save button.

To delete a Contract from a DWR:

1. Double-click the Daily Work Reports icon.
2. Double-click the Daily Work Reports icon.
3. Click the Open button.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. In the Inspector list box, scroll to and double-click the desired Inspector.
6. In the Date list box, scroll to and double-click the desired DWR date.
7. Click the Contractors folder tab.
8. Click the desired Contractor.
9. Click the Delete button.
10. Click the Yes button.
11. Click the Save button.
To add a personnel type:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Open** button.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Inspector** list box, scroll to and double-click the desired Inspector.
6. In the **Date** list box, scroll to and double-click the desired date.
7. Click the **Contractors** folder tab.
8. On the **Contractors** folder tab, click the desired Contractor.
9. Click the **Personnel Type** area.
10. Click the **New** button. An empty row is added to the list.
11. In the **Personnel Type** drop-down list, click the expand arrow and click the desired personnel type.
12. In the **Nbr of Persons** field, type the number of onsite persons for the personnel type.
13. In the **Hours Worked** field, type the number of hours worked for the personnel type.
14. Click the **Save** button.

To delete a personnel type:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Open** button.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Inspector** list box, scroll to and double-click the desired Inspector.
6. In the **Date** list box, scroll to and double-click the desired date.
7. Click the **Contractors** folder tab.
8. On the **Contractors** folder tab, click the desired Contractor.
9. Click the desired Personnel Type.
10. Click the **Delete** button.
11. Click the **Yes** button.
12. Click the **Save** button.

To add contractor equipment:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Open** button.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Inspector** list box, scroll to and double-click the desired Inspector.
6. In the **Date** list box, scroll to and double-click the desired date.
7. Click the **Contractor Equipment** folder tab.
8. Click the desired Contractor.
9. Click the **Equipment ID-Description** area.
10. Click the **New** button. An empty row is added to the list.
11. In the **Equipment ID-Description** drop-down list, click the expand arrow and click the desired equipment.
12. In the **Nbr. of Pieces** field, type the equipment number of pieces onsite.
13. In the **Nbr Used** field, type the equipment number that was used.
14. In the **Hours Used** field, type the number of hours the equipment was used.
15. Click the **Save** button.

To delete contractor equipment:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Open** button.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Inspector** list box, scroll to and double-click the desired Inspector.
6. In the **Date** list box, scroll to and double-click the desired date.
7. Click the **Contractor Equipment** folder tab.
8. Click the desired Contractor.
9. Click the desired Equipment ID-Description.
10. Click the **Delete** button.
11. Click the **Yes** button.
12. Click the **Save** button.
To add NJDOT Activity Hours:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Open** button.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Inspector** list box, scroll to and double-click the desired Inspector.
6. In the **Date** list box, scroll to and double-click the desired date.
7. Click the **Work Activities** folder tab.
8. Click the **New** button.
9. In the **Work Activities** drop-down list, click the expand arrow and click the activity.
10. In the **Reg. Hours** field, type the number of hours worked.
11. Click the **Save** button.

To delete NJDOT Activity Hours:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Open** button.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Inspector** list box, scroll to and double-click the desired Inspector.
6. In the **Date** list box, scroll to and double-click the desired date.
7. Click the **Work Activities** folder tab.
8. Click the desired activity.
9. Click the **Delete** button.
10. Click the **Yes** button.
11. Click the **Save** button.

To use a DWR template:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Open** button.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Inspector** list box, scroll to and double-click the desired Inspector.
6. In the **Date** list box, scroll to and double-click the desired date.
7. Click the **Work Items** folder tab.
8. Scroll to and click the desired item.
9. Click the **Record Work Item** button. SiteManager displays the info on the Work Items panel.
10. Click the **New** button.
11. In the **Plan Page Nbr** field, type plan page number.
12. In the **Contractor** drop-down list, click the expand arrow and click desired Contractor.
13. In the **As-Built Qty** field, type the As-Built Quantity, if available.
14. In the **Location** field, type the location.
15. In the **Station From** field, type stations from information.
16. In the **Station To** field, type stations to information.
17. Click the **Save** button.
18. Click the **DWR Template** button.
19. Double-click the desired template.
20. Enter the template information.
21. Click the **Save** button.
22. Click the **Close** button.
23. Click the **Close** button.
Summary for Section 6

In the following exercise you will copy and modify a DWR.

Login: tpxxxxx    Group: INSP    Contract: 8888D

Copy the DWR created for Contract 8888D by Sam Brown on 08/12/08 to create a DWR for 08/13/08.

Modify the DWR to reflect the following information:

Weather conditions:
- High - 95 degrees
- Low - 65 degrees
- AM – Partly Sunny
- PM – Humid

Remarks:
- Environmental: No environmental issues as of today
- Safety: All Safety devices clean and installed as per TCP.

Contractors:
- IEW Constr Gp
- Parapet Constructors

IEW Personnel:
- 1 Forman worked 8 hours
- 4 Laborers worked 8 hours each

Parapet Constructors Personnel:
- 3 Carpenters worked 8 hours each
- 1 Carpenter foreman worked 8 hours
- 3 Laborers worked 8 hours each

IEW Equipment:
- Traffic Line Remover – Truck Mtd. – 1 onsite and used for 8 hours.
- Pick-Up Truck – 1T – 1 onsite and used for 8 hours.
- Bituminous Distributor Truck – 1 onsite and used for 4 hours.

Parapet Constructors Equipment:
- Compressor – Diesel – 1 used onsite for 8 hours.

Work Activities:
- Sam Brown – Drainage – 4 hours.

Work Item:
Line Item Number 0028, Category Number 0001, Item Code 401030M, Description Tack Coat
- Plan Page Nbr: 34
- Contractor: IEW CONSTR GP
- Location: Route 476 Southbound
- Station From: 505 + 75 L 25
- Station To: 805 + 75 L 25
DWR Template:
Template ID **DC29C**, Description **DC29C Tack Coat**
- Producer: **Exxon, Bayway**
- Producer Location: **Bayway, NJ**
- Grade of Materials Applied: **RC-70**
- Specific Temperature Range of Material: 70 to 140
- Percent Asphalt: **100**
- Location Station to Station: **505 + 75 L 25 to 805 +75 L 25**
- Lane or Side: **L**
- Lot No: **9**
- Tank No: **7**
- Date Material Inspected: **081208**
- Delivery Slip No: **531**
- Truck No: **11**
- Gage on Truck Start: **21.5**
- Gage on Truck Finished: **32**
- Temp of Matl: **130**
- Conversion Factor: **0.9725**
- Gallons Applied Gross: **130**
- Number of SY Covered: **5457**
- What is the Placed Quantity? **126.43**

Exit SiteManager.
This page intentionally left blank.
7 Creating Diaries

By the end of this section, you will be able to:

Understand SiteManager Diaries

Create a Diary

View and Authorize a DWR

Create a Charge Day

Create a No Charge Day

Adjust a Diary
Understanding SiteManager Diaries

The Resident Engineer or his designee creates Diaries daily. Each Diary is a daily collection of the authorized Daily Work Reports submitted by all Inspectors working on the Contract. The Resident Engineer submits one Diary per day per Contract. Diaries can also be created for days when no Daily Work Reports are collected. The Diary panel has two folder tabs:

Authorize

Charge

The Resident Engineer uses the Diary window to perform five functions:

1. Create a new or open an existing Diary for a specific contract and day
2. Preview Daily Work Reports of their inspectors for a specific contract and day
3. Authorize them (or not)
4. Apply Charges for a specific contract and day
5. Make Remarks

![Figure 7-1. The Diary Authorize Folder Tab](image)

7-2
Exercise 7-1
Main Panel > Daily Work Reports > Diary

In the following exercise, you will create a new diary.

Login: **tpxxxxx**  Group: **RE**  Contract: **ID**

1. Double-click the **SiteManager** icon on your desktop.
2. In the **User ID** field, type **tpxxxxx**.
3. Press the **Tab** key.
4. In the **Password** field, type **pass**.
5. Press the **Enter** key.
6. Double-click the **Daily Work Reports** icon.
7. Double-click the **Diary** icon.
8. Click the **Services** menu and then click the **Choose Keys** choice.
9. In the **Contract ID** list box, scroll to and double-click Contract ID **ID**.
Creating a Diary

The Diary Authorize folder tab lets the Resident Engineer create a Diary. The Resident Engineer can create a Diary with or without Daily Work Reports. Typically, the Resident Engineer creates a Diary from the Daily Work Reports that have been submitted by the Inspectors. To create a Diary, the User selects a Contract first, and then enters the diary’s date on the Diary Authorize panel. By entering the date, the Resident Engineer is also selecting the Daily Work Reports with this date and creating a Diary with this date. The Resident Engineer can enter a date by selecting it from a calendar. If the User double-clicks the Diary Date field, a calendar is displayed on which the User can select the date.

![Select Date Calendar]

Figure 7-2. The Calendar

The User can not enter a date that is after the current system data.

After the User selects a date, the Diary Authorize folder tab lists the Daily Work Reports submitted for the selected date. If a Diary has not already been saved for the selected date, a new Diary is created. The reports are listed alphabetically by the name of the Inspector who submitted the report.
The Resident Engineer or his designee are to create a Diary for each day of the Contract, beginning with the Official Contract Start Date or the Work Begin Date, whichever date occurs first. Diaries are to be created for each day until the Contract is complete, which is identified in SiteManager when the Completion Date key date is entered.

Exercise 7-2
Main Panel > Daily Work Reports > Diary

In the following exercise, you will create a new diary.

Login: tpxxxxx Group: RE Contract: ID

1. In the Diary Date field, type 080708.
2. Press the Enter key.
3. Click the Save button.
Viewing and Authorizing DWR

The Preview option on the Diary panel lets the User view and print a summary of a Daily Work Report without leaving the Diary panel.

The Diary Authorize folder tab lets the Resident Engineer authorize or unauthorize Daily Work Reports. A Daily Work Report with a check in the Authorized check box is considered authorized. When a Daily Work Report is marked as authorized, SiteManager enters the current date in the Authorized Date field. The User can remove authorization (and the authorized date) by removing the check from the Authorized check box.

If the Resident Engineer chooses not to authorize a Daily Work Report, the Inspector may access the DWR for modification. Only the author of the Daily Work Report (the Inspector) can modify the Daily Work Report. By authorizing a Daily Work Report, the Resident Engineer is flagging that DWR for use by the Contractor Payments component of SiteManager in the Estimate Generation process. Authorization approves the installed work reported by the DWR to be included in the next Estimate for payment.

Once an estimate has been approved, the authorized Daily Work Reports associated with the estimate become read-only in SiteManager and further changes to those DWRs are not allowed.

Figure 7-3. The Daily Work Report Preview
Prior to authorizing the DWR, the Resident Engineer is to ensure all placed quantities are correct. This can be done by reviewing the DWR in the DWR window or by reviewing the Preview DWR Report in the Diary window.

If the Resident Engineer notices a discrepancy with the DWR, the creator of the DWR is to be notified so that it can be corrected. If the creator of the DWR is not available prior to the end of the estimate period, the Resident Engineer is to create his own DWR to adjust the quantity and note the purpose of the adjustment in Remarks for the item on the DWR.

Remarks are available for each Diary. The Resident Engineer is to enter his or her comments regarding the day on the Diary or on his or her DWR.
Exercise 7-3
Main Panel > Daily Work Reports > Diary

In the following exercise, you will preview and authorize a DWR.

Login: tpxxxxx  Group: RE  Contract: ID

1. In the Inspector list box, click the DWR for Brown, Sam.

2. Click the Services menu, and then click the Preview DWR choice.

3. Click the Close button.

4. Click the Authorized check box (ON).

5. Click the Save button.
Creating a Charge Day

The Diary Charge folder tab lets the User record charge or credit information for the day and enter remarks. The User reviews the Daily Work Reports in the Diary to determine if work was performed on the Contract. If work was performed, a Full Day or Half Day charge can be applied to the Contract end date.

![Diary Charge Folder Tab](image)

Figure 7-4. The Diary Charge Folder Tab

The Resident Engineer is to record the type of charge for each day of the Contract and for active Milestones, as applicable.

The Charge information entered on a Diary is displayed on the Tabulation of Work Days Report.
**Exercise 7-4**  
Main Panel > Daily Work Reports > Diary

In the following exercise, you will charge the Contract and Milestone with a Working Day.

Login: *tpxxxxx*  
Group: *RE*  
Contract: *ID*

1. Click the **Charge** folder tab.
2. Click in the **Milestone** area.
3. Click the **New** button.
4. In the **Milestone** drop-down list, select Milestone *01 Stage1a*.
5. Click the **Save** button.
Creating a No Charge Day

A No Charge (credit) day is a day on which no work was performed on the Contract. For No Charge days, no time is applied towards the Contract end date. For Half Days and No Charge days, the User must enter a credit reason to explain why a credit was given. The User can also apply charge or credit information to milestones for the Contract. For Half Days and No Charge days applied to a milestone, the User must also enter a credit reason.

Figure 7-5. The Diary Charge Folder Tab
**Exercise 7-5**
Main Panel > Daily Work Reports > Diary

In the following exercise, you will create a no charge diary.

- **Login:** tpxxxxx  **Group:** RE  **Contract:** ID

1. Click the Authorize folder tab.
2. Click the New button.
3. In the Diary Date field, type 080908.
4. Press the Enter key.
5. Click the Save button.
6. Click the Charge folder tab.
7. Click the No Charge radio button.
8. In the Credit Reason drop-down list, click the expand arrow and click Saturday.
9. Click the Save button.
10. Click in the Milestone area.
11. Click the New button.
12. In the Milestone drop-down list, select Milestone 01 Stage 1a.
13. Click the Save button.
14. Click the Close button.
Adjusting a Diary

The Diary Adjustment Window Diary Tab allows adjustments to charge days on a Diary associated with a paid estimate. The top of the window displays the current Diary Charge information. The lower window displays the adjustments that have been made.

![Diary Adjustments window]

Figure 7-6. The Diary Adjustment Window

The Resident Engineer is to adjust charge days for the Contract and Milestones on paid estimates in the Diary Adjustments window.

A reason for the adjustment is to be included in the Remarks field.
Exercise 7-6
Main Panel > Daily Work Reports > Diary

In the following exercise, you will adjust the charge type for a Diary on a paid estimate.

Login: tpxxxxx    Group: RE    Contract: 7777K

1. Double-click the Diary Adjustment icon.

2. In the Contract ID list box, scroll to and double-click Contract ID 7777K.

3. In the Diary list box, scroll to and double-click Diary Date 09/19/2008.

4. Click the New button.

5. In the Charge drop-down list, click the expand arrow and click No Charge.

6. In the Credit Reason drop-down list, click the expand arrow and click Weather.

7. In the Remarks field, type Weather conditions unfavorable for work.

8. Click the Save button.

9. Click the Close button.

10. Click the Main Panel folder tab.
Review for Section 7

To create a Diary for a Charge Day:

1. Double-click the Daily Work Reports icon.
2. Double-click the Diary icon.
3. Click the Services menu and then click the Choose Keys choice.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. In the Diary Date field, type date of the diary.
6. Press the Enter key.
7. Click the Save button.
8. Click the Charge folder tab.
9. Click in the Milestone area.
10. Click the New button.
11. In the Milestone drop-down list, select desired milestone.
12. Click the Save button.
13. Click the Close button.

To create a Diary for a No Charge Day:

1. Double-click the Daily Work Reports icon.
2. Double-click the Diary icon.
3. Click the Services menu and then click the Choose Keys choice.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. Click the Authorize folder tab.
6. Click the New button.
7. In the Diary Date field, type date of the diary.
8. Press the Enter key.
9. Click the Save button.
10. Click the Charge folder tab.
11. Click the No Charge radio button.
12. In the Credit Reason drop-down list, click the expand arrow and click the desired reason.
13. Click the Save button.
14. Click in the Milestone area.
15. Click the New button.
16. In the Milestone drop-down list, select desired milestone.
17. In the Charge Amount drop-down list, click the expand arrow and click the desired charge.
18. In the Credit Reason drop-down list, click the expand arrow and click desired reason.
19. Click the Save button.
20. Click the Close button.

To Preview and Authorize a DWR

1. Double-click the Daily Work Reports icon.
2. Double-click the Diary icon.
3. Click the Services menu and then click the Choose Keys choice.
4. In the Contract ID list box, scroll to and double-click desired the Contract ID.
5. In the Inspector list box, click the Inspector’s name.
6. Click the Services menu, and then click the Preview DWR choice.
7. Click the Close button.
8. Click the Authorized check box (ON).
9. Click the Save button.

To adjust a diary on a paid item:

1. Double-click the Diary Adjustment icon.
2. In the Contract ID list box, scroll to and double-click the desired Contract ID.
3. In the Diary list box, scroll to and double-click the desired diary date.
4. Click the New button.
5. In the Charge drop-down list, click the expand arrow and click the desired charge.
6. In the Credit Reason drop-down list, click the expand arrow and click the credit reason.
7. In the Remarks field, type the reason remark.
8. Click the Save button.
9. Click the Close button.
Summary for Section 7

In the following exercise you will create Diaries and review activities on Contract 8888E

Login: tpxxxxx Group RE Contract: 8888E

2. Preview Sam Brown’s DWR created on 08/11/08.
3. What items were placed on 08/11/08 according to Sam Brown’s DWR?
   610025M Removal of Traffic Stripes and 551030M Curb Reconstruction, Curb

4. Authorize Sam Brown’s DWR.
5. Charge Milestone 1 Stage1a with a Working Day.
6. Create a new Diary for Contract ID 8888E of 08/16/08. Make this Diary a No Charge Day with the reason code Saturday.
7. When should the Diary Adjustment window be used?
   The Diary Adjustment window is only used to modify the time charged on a Contract and/or when the Diary has already been included on an estimate.
8. Exit SiteManager.
8 Creating the Weekly

By the end of this section, you will be able to:

- Record Daily Hours
- Identify This Week’s and Next Week’s Activities
- Record Weekly Material Hours
- Confirm the Weekly Hours
- Generate the Weekly Progress Report
Recording Daily Hours

The Contract Manpower Program is a custom program developed for the specific use of NJDOT to capture the planned hours as well as the Daily hours of individuals working on a Contract.

The Weekly Hours folder tab displays Contract personnel that were selected in the Contract Personnel folder tab during the Contract Activation Process. If needed, Contract personnel may be modified throughout the life of the Contract.

When accessing the Contract Manpower Program for the purpose of recording daily hours for Contract personnel, the User must first select the week ending date from the Week Ending drop-down list. Hours for Contract personnel may be recorded in the Contract Manpower Program starting with the week the Contract was loaded into SiteManager until the Contract is complete.

To record hours to Contract personnel the User must click either the Regular Hours or Over Time Hours field for the for the date and desired individual, which opens the Daily Work window. In the Daily Work window, regular and overtime hours can be recorded for the individual. When complete, the User must click the Save and Close button to return to the Weekly Hours folder tab or the User may use the Next Day or Previous Day buttons to record other the hours for the same individual on different days.

Daily State and Local Police hours are recorded in the Daily Work window. To access the Daily Work Window for State and Local Police, the User must click either the Regular Hours or Over Time Hours field. The total hours for all the State and Local Police on the Contract should in the Daily Hours folder tab in the fields for either State or Local Police Hours.

The total hours entered for each Contract personnel and State and Local Police are displayed on the Weekly Hours folder tab.
Figure 8-1. Contract Manpower Program – Weekly Hours Folder Tab

<table>
<thead>
<tr>
<th>Name</th>
<th>Title</th>
<th>Regular</th>
<th>Overtime</th>
<th>Other Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brown, Sam</td>
<td>Construct. C &amp; M Tech 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 8-2. Contract Manpower Program – Daily Work Data Window
The Resident Engineer or his designee are to record the daily hours for all personnel on the Contract.

**Exercise 8-1**

**Main Panel > Contract Administration > Contract Records > Contracts**

In the following exercise, you will record the weekly hours for Contract personnel.

**Login:** tpslew  **Group:** OENGR  **Contract:** 7777E

1. Double-click the **SiteManager** icon on your desktop.
2. In the **User ID** field, type tpslew.
3. Press the **Tab** key.
4. In the **Password** field, type pass.
5. Press the **Enter** key.
6. Double-click the **Contract Administration** icon.
7. Double-click the **Contract Records** icon.
8. Double-click the **Contracts** icon.
9. In the **Contract ID** list box, scroll to and double-click Contract ID 7777E.
10. Click the **Attachments** button.
11. Double-click the **Contract Manpower Program** attachment.
12. In the **Week Ending** drop-down list, select **Week Ending 08/08/08**.
13. In the **08/07/08**, column, click the **Reg Hours** field for **Brown, Sam**.
14. In the **Curb and Sidewalk Regular** field, type 8.
15. Click the **Next Day** button.

---

**Daily Hours for each work activity can be found on the Daily Staff folder tab in the Daily Work Report window.**

Daily Hours for each work activity can be found on the Daily Staff folder tab in the Daily Work Report window.
16. In the **Curb and Sidewalk Regular** field, type 8.

17. Click the **Save and Close** button.

18. In the 08/07/08, column, click the **Reg Hours** field for **Jones, Kelly**.

19. In the **Resident Engineer Regular** field, type 8.

20. Click the **Next Day** button.

21. In the **Resident Engineer Regular** field, type 8.

22. Click the **Save and Close** button.

23. In the 08/07/08, column, click the **Reg Hours** field for **Lewis, Tyler**.

24. In the **Office Work Regular** field, type 4.

25. Click the **Next Day** button.

26. In the **Office Work Regular** field, type 4.

27. Click the **Save and Close** button.

28. In the 08/07/08, column, click the **Reg Hours** field for **State Police**.

29. In the **State Police Regular** field, type 24.

30. Click the **Save and Close** button.
Identifying This Week’s and Next Week’s Activities

The Resident Engineer or his Designee should identify the work activity that best summarizes the work performed by the Contract personnel on the Weekly Hours folder tab in the Contract Manpower Program. The activity selected in the This Week and Next Week drop-down lists is automatically transferred to the Weekly Report.

![Figure 8-3. Contract Manpower Program – This Week and Next Week Activities](image)

The Resident Engineer or his designee are to identify the work activity that summarizes the main type of work performed by each Contract Personnel for the current and following week.
Exercise 8-2
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will identify the next week’s activities for personnel on the Contract.

Login: tpslew Group: OENGR Contract: 7777E

1. For the This Week column for Brown, Sam, in the Activities drop-down list, click the expand arrow and click Curb & Sidewalk Insp.

2. For the Next Week column for Brown, Sam, in the Activities drop-down list, click the expand arrow and click Drainage Insp.

3. For the This Week column for Jones, Kelly, in the Activities drop-down list, click the expand arrow and click Resident Engineer.

4. For the Next Week column for Jones, Kelly, in the Activities drop-down list, click the expand arrow and click Resident Engineer.

5. For the This Week column for Lewis, Tyler, in the Activities drop-down list, click the expand arrow and click Office Work-EEO.

6. For the Next Week column for Lewis, Tyler, in the Activities drop-down list, click the expand arrow and click Vacation.

7. Click the Save button.

The This Week and Next Week drop-down lists displays activities in alphabetical order.
Recording Weekly Material Hours

The Resident Engineer or his Designee should record the total regular and overtime hours for the week for the Materials Team Lead and the Materials Technicians working on the Contract in the Contract Manpower Program on the Weekly Hours folder tab.

![Figure 8-4. Contract Manpower Program – Material Hours](image)

The Resident Engineer or his designee are to record the total regular and overtime hours for the Materials Team Lead and Technicians on the Contract on the Weekly Hours folder tab.

Exercise 8-3

Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will record the weekly material hours.

Login: tpslewi  Group: OENGR  Contract: 7777E

1. In the **Materials Team Lead Reg** field, type 10.
2. In the **Materials Technician Reg** field, type 12.
3. Click the **Save** button.
Confirming the Weekly Hours

The Resident Engineer or his Designee should click the Time Complete button on the Weekly Hours folder tab to identify that the modifications to the Contract Personnel time for the week is complete. Once the Time Complete button is clicked and the User confirms the selection, no modifications can be made to the week’s hours, however, the weekly hours can be viewed in an inquiry window.

Figure 8-5. Contract Manpower Program – Time Complete Message

The Resident Engineer or his designee are to confirm the weekly hours by clicking the Time Complete button once all hour information has been entered for the week.

Once the Time Complete button is selected, no additional modifications can be made to the week’s reported hours.
Exercise 8-4
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will confirm the weekly hours for all personnel on the Contract.

Login: tpslew Group: OENGR Contract: 7777E

1. Click the Time Complete button.
2. Click the OK button.
3. Click the Close button.
4. Click the Close button.
Generating the Weekly Progress Report

The Weekly Report is generated from Crystal Reports and used to review the week’s item activities on the Contract as well personnel work hours. Crystal Reports can be accessed directly through a web browser or through the SiteManager Reports icon on the Main Panel. Once in Crystal Reports, the user must identify the parameters for the generation of the report. Parameters for the Weekly Progress Report include the Contract ID, the Week Ending Date, the Most Appropriate Project Status, and other additional statuses.

![Figure 8-6. The Weekly Progress Report Parameters](image)

The Resident Engineer or his designee are to generate the Weekly Report for review. The Weekly Report is to be exported to PDF and emailed to the required reviewers.
Exercise 8-5
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will generate the Weekly Report.

Login: tpslew Group: OENGR Contract: 7777G

1. Click the Main Panel folder tab.
2. Double-click the Reports icon.
3. Double-click the Weekly Progress Report 7777G.
4. What two items were installed this week? Curb Piece and Drum
5. Click the Close button.
6. Click the Close button to return to SiteManager.
Review for Section 8

To record the weekly hours for Contract Personnel:

1. Double-click the Contract Administration icon.
2. Double-click the Contract Records icon.
3. Double-click the Contracts icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract.
5. Click the Attachments button.
6. Double-click the Contract Manpower Program.
7. In the Week Ending drop-down list, click the expand arrow and click the desired week.
8. Click the Reg Hours field for the desired personnel and date.
9. Click the desired activity field and type the desired hours. Repeat until hours for all activities for the day for the selected person have been entered.
10. Click the Next Day button to record hours for the next day if applicable.
11. Click the Save and Close button.

To record State and Local Police hours:

1. Double-click the Contract Administration icon.
2. Double-click the Contract Records icon.
3. Double-click the Contracts icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. Click the Attachments button.
6. Double-click the Contract Manpower Program.
7. In the Week Ending drop-down list, click the expand arrow and click the desired week.
8. In the Week Ending drop-down list, click the expand arrow and click the desired week.
9. Click the State Police field and type the desired hours.
10. Click the Next Day button to record hours for the next day if applicable.
11. Click the Save and Close button.
12. Click the Reg Hours field for State Police.
13. Click the Local Police field and type the desired hours.
14. Click the Next Day button to record hours for the next day if applicable.

To record This Week and Next Week activities:

1. Double-click the Contract Administration icon.
2. Double-click the Contract Records icon.
3. Double-click the Contracts icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract.
5. Click the Attachments button.
6. Double-click the Contract Manpower Program.
7. In the Week Ending drop-down list, click the expand arrow and click the desired week.
8. In the This Week column for the desired personnel, click the Activities drop-down list, and click the desired activity.
9. In the Next Week column for the desired personnel, click the Activities drop-down list, and click the desired activity.
10. Click the Save button.

To record weekly material hours:

1. Double-click the Contract Administration icon.
2. Double-click the Contract Records icon.
3. Double-click the Contracts icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract.
5. Click the Attachments button.
6. Double-click the Contract Manpower Program.
7. In the Week Ending drop-down list, click the expand arrow and click the desired week.
8. Click the Materials Team Lead hours field and type the desired hours.
9. Click the Materials Technician hours field and type the desired hours.
10. Click the Save button.
To confirm the weekly hours:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Contracts** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. Click the **Attachments** button.
6. Double-click the **Contract Manpower Program**.
7. In the **Week Ending** drop-down list, click the expand arrow and click the desired week.
8. Click the **Time Complete** button.
9. Click the **OK** button.
10. Click the **Close** button.

To view Crystal Reports:

1. Double-click the **Reports** icon.
2. In the **System** field, type **snj 187:6400**.
3. In the **User Name** field, type **TSP_Construction**.
4. In the **Password** field, type **pave09**.
5. In the **Authentication** drop-down list, click the expand arrow and click **Enterprise**.
6. Click **Folders**.
7. Click the **TSP Construction** folder.
8. Click the desired report.
9. Enter the required Parameters.
10. Click the **OK** button.
11. View, Print, or Save the report.

To export a Crystal Report to PDF format:

1. Generate the desired report.
2. Click the **Export this Report** button.
3. In the **File Format** drop-down list, click the expand arrow and click **Adobe Acrobat (PDF)**.
4. Click the **OK** button.
5. Click the **Save** button.
6. Save the report in the desired location.
7. Exit Crystal Reports.
Summary for Section 8

In the following exercise you will create the weekly by recording the weekly activities for Contract 8888E.

Login: tpslew Group: OENGR Contract: 8888E

1. For Contract 8888E, open the Contract Manpower Program for week ending 08/15/08.

2. Record the following activity hours for Sam Brown:
   - 08/11/08
     - Curb and Sidewalk 8 hours
   - 08/12/08
     - Curb and Sidewalk 8 hours
   - 08/13/08
     - Curb and Sidewalk 4 hours
     - Drainage 4 hours

3. Record the following activity hours for Kelly Jones:
   - 08/11/08
     - Resident Engineer – 8 hours
   - 08/12/08
     - Resident Engineer– 8 hours
   - 08/13/08
     - Resident Engineer– 8 hours

4. Record the following activity hours for State Police
   - 08/11/08 – 8 hours
   - 08/12/08– 8 hours
   - 08/13/08– 8 hours

5. Identify This Week’s and Next Week’s activities for Sam Brown as Curb and Sidewalk Insp.

6. Identify This Week’s and Next Week’s activities for Kelly Jones as Resident Engineer.

7. Record that the Materials Technicians worked on the Contract for 24 hours.

8. Confirm that the weekly hours are complete.

9. Exit SiteManager.
9 Generating a Progress Estimate

By the end of this section, you will be able to:

- Review the NJDOT Progress Estimate Process
- Generate the Installed Work Report
- Generate the Estimate to Verify Quantities
- View the SiteManager Inbox
- View the Estimate Summary for Overruns
- Generate the Estimate Summary Report
- Determine the Fuel and Asphalt Price Adjustments
- Generate the Estimate for Payment and View the Estimate Summary Window
- View Estimate Discrepancies
- View the Estimate Item Detail Window
- View the Estimate Item Paybook Window
- View the Line Item Adjustment Window
- View the Contract Adjustment Window
- Approve the Estimate
- Track the Estimate
- Correct an Estimate
SiteManager Estimate Overview

The Estimate Generation process manages the Estimate functionality from the generation of an Estimate through the approval of the Estimate. The functionality is divided into the following areas:

- Generation of the Estimate
- Review of Estimate information
- Resolution of Estimate discrepancies
- Review of Estimate item details
- Approve or reject Estimate
- Tracking of Estimate status
- Log Payment Of Estimate

Figure 9-1. The Estimate Panel
Reviewing the NJDOT Progress Estimate Process

The Progress Estimate process begins with the creation of a Daily Work Report (DWR) and concludes with the last level approval of the Progress Estimate.

Inspectors, Office Engineers, and Resident Engineers should create DWRs to record construction activity by the close of business the day after the work was performed. The Office Engineer or the Resident Engineer should create a Diary for each day of the Estimate period, including weekends and holidays.

The Resident Engineer should review the DWRs listed on the Diary for accuracy. If an error is found on a DWR, the Resident Engineer should contact the creator of the DWR so that the DWR may be corrected. If the creator of the DWR is not available, the Resident Engineer should create his own DWR to make an adjusting entry and provide an explanation regarding the record in Remarks on the DWR. Once the DWR is correct, the Resident Engineer should authorize the DWR for payment.

The Resident Engineer should generate the Installed Work Report prior to generating an Estimate to review the item quantities that should be included on the next Estimate and to determine if there are any DWRs that should have been authorized for payment but are still unauthorized. If an error is detected, the Resident Engineer should ensure it is corrected before generating the Estimate.

The Resident Engineer should generate a draft Estimate for the purpose of verifying quantities with the Contractor. Once the Estimate is generated, the DWRs can no longer be unauthorized on a Diary or modified in the DWR window. Once the quantities for payment have been determined, the fuel and price adjustments applicable to the items in the Estimate period should be calculated and be recorded on a DWR and authorized on a Diary.

The Resident Engineer should generate an Estimate for the purpose of payment. Once the Estimate is generated, the DWRs can no longer be unauthorized on a Diary or modified in the DWR window. The Resident Engineer should review the Estimate, fix or override all discrepancies, and associate all contract adjustments to the Estimate prior to approving the Estimate for payment. SiteManager windows and reports that may be used to review the Estimate are as follows:

   Estimate Summary Window

   Estimate Discrepancy Window
Once the Estimate has been reviewed and modified, the Resident Engineer should generate the Estimate Summary Report. This is the report that will eventually be sent to the Contractor from Accounting Operations. If the Resident Engineer is satisfied with Estimate, then he should proceed to the next step of approving the Estimate. If the Resident Engineer finds an error or omission, then he should follow the Estimate Correction Procedure to fix the Estimate prior to its approval.

Accounting Operations should receive a SiteManager generated email to the SiteManager Inbox alerting them that an Estimate is ready for approval. Accounting Operations should review the Estimate in SiteManager as required for its approval. If Accounting Operations determines that the Estimate should not be paid, then the Estimate should be rejected in the Estimate Rejection window. If Accounting Operation determines that the Estimate should be paid, then the Estimate should be approved in the Estimate Approval window in SiteManager upon receipt of the SiteManager Inbox notification that the Resident Engineer has received the DL 72 from the Contractor. Once the Estimate is approved in SiteManager, Accounting Operations should send the contractor the Voucher and Estimate Certificate. The Estimate should also be manually entered into MASCE and FMIS.
Generating the Installed Work Report

The Installed Work Report displays the amounts for all items installed in a Contract (from both unauthorized and authorized Daily Work Reports) that are not included on an Estimate.

![Figure 9-2. The Install Work Report](image)

The Resident Engineer or his designee are to generate the Installed Work Report prior to generating the Estimate to review quantities that have not yet been included on an Estimate. Any ‘Auth’ box that does not have an ‘X’ is not authorized and will not be included in the next Estimate.
Exercise 9-1
Main Panel > Contractor Payments > Reports > Installed Work Report

In the following exercise, you will generate the Installed Work Report.

Login: tpsjone Group: RE Contract: 7777J

1. Double-click the SiteManager icon on your desktop.
2. In the User ID field, type tpsjone.
3. Press the Tab key.
4. In the Password field, type pass.
5. Press the Enter key.
6. Double-click the Contractor Payments icon.
7. Double-click the Reports icon.
8. Double-click the Installed Work icon.
9. In the Contract ID column, scroll to and double-click Contract ID 7777J.
10. Have all DWRs been authorized for payment? Yes
11. Click the Close button.
The Generate Estimate window can be accessed within the Contractor Payments component or by direct access from the In-Box. The default Estimate choice is Progress.

When Generate Estimate is initiated by clicking the OK button, SiteManager will verify that a prior Estimate does not exist for an overlapping period of time (only one Estimate is valid for a period of time). If one does exist, the user will be prompted with a window to confirm the deletion of the prior Estimate. If the deletion is confirmed, the generation process will delete the prior Estimate and initiate the generation of the new Estimate as a background process. Otherwise, the generation will be halted leaving the prior Estimate intact.

Once the Estimate has been submitted, an In-Box message will confirm whether or not the Estimate generated successfully.

The Estimate generation process allows the user to generate an Estimate for the Contract. The user selects to generate a Progress or a Final Estimate from the Contractor Payments component. SiteManager then performs a background process which performs the following activities:

**Delete pending Estimate.** This activity deletes any previous pending Estimate which has been calculated but not approved. The deletion will remove only details tied to the previous pending Estimate.

**Determine quantities for payment.** This activity will determine the quantity to be paid for each line item on the Contract which has items installed for the Estimate period.

**Calculate stockpiled materials.** This activity will determine if an installed item has stockpiled materials. If it does, the process will use a stockpiled materials conversion factor to add a new line item adjustment to adjust the amount of payment which is to be made for
the line item.

**Identify discrepancies.** This activity checks for and reports discrepancies for the work being performed by defined rules and conditions, e.g., physical completion dates for milestones with projected end dates during the Estimate period. This activity provides a window with discrepancy details for the Resident Engineer so that proactive steps can be taken for various project issues. The edits performed during the Progress Estimate are a subset of the edits performed during the final Estimate.

**Calculate retainage.** This activity automatically calculates the amount of retainage for the Estimate period based upon the method identified for the Contract. The calculated or gross retainage amount is dispensed among the various retainage accounts. If securities exist, a portion may be encumbered. When escrow accounts exist, a portion may be distributed to the account. Any remaining will be distributed to a cash retainage contract account. Escrow balances are maintained separately.

**Determine Funding Amounts.** This activity will calculate the funding amount for the different funding sources based upon the funding given for the Contract, project, category or item.

The Resident Engineer is to generate a draft Estimate for the purpose of verifying the quantities with the Contractor.
Exercise 9-2
Main Panel > Contractor Payments > Estimates > Generate Estimate

In the following exercise, you will generate the Estimate to verify quantities.

Login: **tpsjone** Group: **RE** Password: **7777F**

1. Click the Contractor Payments folder tab.
2. Double-click the Estimate icon.
3. Double-click the Generate Estimate icon.
4. In the Contract list box, scroll to and double-click Contract ID **7777F**.
5. In the End field, type **090508**.
6. Click the Generate Estimate button.
7. In the message to delete the current Estimate, click the Yes button.
8. In the message to reconnect to the servers, click the No button.
9. In the message, click the OK button.
10. Click the Close button.

The steps to generate an Estimate will vary slightly in Production since servers are not available in the Training application. Refer students to Review section for Production steps.
Viewing the SiteManager Inbox

Users will receive specific messages generated by SiteManager (System Generated Messages). In addition to SiteManager mail and the external mail, the In-Box acts as a workflow manager by routing system-generated messages to appropriate users and subsequently allowing access to specific SiteManager functions through these messages. System-generated messages are sent automatically to one or more users.

For example, when the user generates an Estimate, the user will receive an In-Box message. When opening the In-Box message,

- If the Estimate generation was successful and the request was for a Progress or Final Estimate, the Estimate Summary panel will be displayed.
- If the Estimate generation was successful and the request was for a supplemental Estimate, the Contract Adjustments panel will be displayed.
- If the Estimate generation was unsuccessful, then the Estimate Activity Log report will be displayed.

The In-Box is accessed using the Accessories panel.

![In-Box Example]

Figure 9-3. SiteManager In-Box
The Resident Engineer is to view the SiteManager Inbox to verify the successful generation of the Estimate. A message is also sent to the Resident Engineer’s NJDOT email address.

### Exercise 9-3

Main Panel > Accessories > Inbox

In the following exercise, you view the SiteManager inbox for a message stating that the Estimate has finished processing.

- **Login:** tpsjone  
  - **Group:** RE  
  - **Contract:** 7777F

1. Click the **Main Panel** tab.
2. On the **Main Panel**, double-click the **Accessories** icon.
3. On the **Accessories** panel, double-click the **In-Box** icon. SiteManager displays the **In-Box** window.
4. Double-click the message titled **Est Nbr = 0001 for 7777F finished successfully.**
Viewing the Estimate Summary for Overruns

The Estimate Summary panel allows the user to view calculated Estimate summary information. It can be navigated to directly or from the In-Box. The panel shows three sets of totals:

- Current Estimate,
- Combined totals for previous Estimate(s),
- Totals to date.

![Figure 9-4. The Estimate Summary Panel](image)

The Resident Engineer is to view the Estimate Summary window to determine if the Estimate includes item overruns. If overruns exist, the Resident Engineer is to ensure that the placed quantities are accurate by viewing the Estimate Discrepancy and Estimate Item Detail Window.

If necessary, the quantities are to be modified by following the Estimate Correction Procedure before proceeding with the Progress Estimate Process.

The Estimate Correction Procedure is discussed later in this Section.
Exercise 9-4
Main Panel > Accessories > Inbox

In the following exercise, you view the Estimate summary for overruns.

Login: tpsjone   Group: RE   Contract: 7777F

1. Did an item overrun on this Estimate? Yes ($250.00)

2. Click the Close button.

3. Click the Close button.

4. Click the Main Panel folder tab.
Generating the Estimate Summary Report

The Estimate Summary Report is generated through Crystal Reports, which is accessible directly through the Crystal Reports Server or by double-clicking the Reports icon on the SiteManager Main Panel. The user should then log into Crystal Reports and select the Estimate Summary Report. When generating the report, the user should select the Contract ID and the Estimate Number as the parameters. The Estimate Summary Report can be viewed online, printed, or exported to PDF. The Estimate Summary Report can be regenerated throughout the life of the Contract. Once the Estimate begins the approval process, it cannot be modified without rejecting the Estimate and regenerating it.

![Figure 9-5. Estimate Summary Report Parameters](image)

The Resident Engineer is to generate the Estimate Summary Report to verify the quantities of the Estimate with the Contractor.

If the quantities require modification, then the item quantities are to be modified on a DWR and the Estimate regenerated before proceeding with the Progress Estimate Process.

---

**Exercise 9-5**

Main Panel > Reports

In the following exercise, you will generate the Estimate Summary Report to verify quantities.

1. Double-click the Reports icon.
2. Double-click the Estimate Summary Report 7777F.
3. How many items are paid on this Estimate? _______________
4. Click the Close button.
5. Click the Close button to return to SiteManager.

---

In Production the Reports icon will open in Crystal Reports.
Determining the Fuel and Asphalt Price Adjustments

Fuel and asphalt price adjustments are applied to an Estimate through separate items on a Daily Work Report. The amount of the fuel adjustment is determined by generating the Fuel Price Adjustment report for the Estimate period. The amount of the asphalt adjustment is determined by generating the Asphalt Price Adjustment report for the Estimate period.

Generating the Fuel and Asphalt Price Adjustments Reports

The Fuel Price Adjustment Report and the Asphalt Price Adjustment Report are generated through Crystal Reports, which is accessible directly through the Crystal Reports Server or by double-clicking the Reports icon on the SiteManager Main Panel. The user should then log into Crystal Reports and select either the Fuel Price Adjustment or the Asphalt Price Adjustment report. When generating the reports, the user should enter the Contract ID and the Estimate Number as the parameters. The report can be viewed online, printed, or exported to PDF. The reports can be regenerated for the selected Estimate throughout the life of the Contract. The adjustment reports show only the adjustment calculated based on the Estimate selected.

Figure 9-6. Price Adjustment Report Parameters

The Resident Engineer is to generate the Fuel Price Adjustment and the Asphalt Price Adjustment Reports after the quantities on the Estimate have been verified.
Exercise 9-6
Main Panel > Reports

In the following exercise, you will generate the Fuel and Asphalt Price Adjustment Reports.

Login: tpsjone Group: RE Contract: 7777F

1. Double-click the Reports icon.

2. Double-click the Asphalt Price Adjustment Report.

3. What is the Asphalt Price Adjustment? $946.31

4. Click the Close button.


6. What is the Fuel Price Adjustment? $112.01

7. Click the Close button.

8. Click the Close button to return to SiteManager.

Refer to the Review section for Crystal Reports steps.
Creating a DWR and Diary for Fuel and Asphalt Price Adjustments

If a Contract allows for fuel adjustments, then the Fuel Price Adjustment item will be on the Contract with a $1.00 unit price and a quantity of an anticipated fuel price adjustment for the Contract. If a Contract allows for asphalt adjustments, then the Asphalt Price Adjustment item will be on the Contract with a $1.00 unit price and a quantity of an anticipated asphalt price adjustment for the Contract.

To apply the adjustment for fuel and/or asphalt to the Estimate, a DWR must be created and authorized and then the Estimate must be re-run. When creating the adjustment DWR, the following information should be included:

Contract
Date
General remark stating for which Estimate number the fuel and/or asphalt adjustments are being applied
Prime Contractor identified on the Contractor’s folder tab
The appropriate fuel or asphalt adjustment with the adjustment amount entered in the Placed Qty and As-Built Qty fields, the Prime Contractor, and location

Figure 9-7. Price Adjustment Daily Work Report
The Resident Engineer is to create a DWR within the Estimate period to record the quantities of the fuel and asphalt price adjustments and then authorize the DWR on a Diary.

**Exercise 9-7**
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will create a DWR to record price adjustments and authorize the DWR on a Diary.

   Login: tpsjone Group: RE Contract: 7777F

1. Double-click the Daily Work Reports icon.
2. Double-click the Daily Work Reports icon.
3. In the DWR Date field, type 090408.
4. Press the Tab key.
5. In the Remarks Type list box, scroll to and click General.
6. In the Remarks text box, type Price Adjustments for 0001 Estimate.
7. Click the Save button.
8. Click the Contractors folder tab
9. On the Contractors folder tab, click the Contractor area.
10. Click the New button. An empty row is added to the list.
11. In the Contractor drop-down list, click the expand and click IEW CONSTR GP *PRIME*.
12. Click the Save button.
13. Click the Work Items folder tab.
14. Scroll to and double-click Line Item Number 0023, Category Number 0001, Item Code 160006M, Description Asphalt Price Adjustment.
15. Click the New button.

16. In the Placed Qty field, type 946.31

17. In the Contractor drop-down list, click the expand arrow and click I EW CONSTR GP *PRIME*.

18. In the As Built Qty field, type 946.31

19. In the Location field, type Throughout Project.

20. Click the Measured radio button ON.

21. Click the Save button.

22. Click the Selects Work Item button.

23. Scroll to and double-click Line Item Number 0022, Category Number 0001, Item Code 160003, Description Fuel Price Adjustment.

24. Click the New button.

25. In the Placed Qty field, type 112.01

26. In the Contractor drop-down list, click the expand arrow and click I2943 IEW CONSTR GP *PRIME*.

27. In the As Built Qty field, type 112.01

28. In the Location field, type Throughout Project.

29. Click the Measured radio button ON.

30. Click the Save button.

31. Click the Close button.

32. Double-click the Diary icon.

33. In the Inspector list box, click the DWR for Jones, Kelly.

34. Click the Authorized check box (ON).

35. Click the Save button.

36. Click the Close button.

37. Click the Main Panel folder tab.
Generating the Estimate for Payment and Viewing the Estimate Summary Window

Once the fuel and asphalt price adjustments have been added to a Daily Work Report for a date within the Estimate period and the DWR has been authorized on a Diary, the Resident Engineer should regenerate the Estimate so that the fuel and asphalt price adjustment items are included on the Estimate.

![Figure 9-8. The Generate Estimate Window](image)

The Resident Engineer is to regenerate the Estimate for payment once the fuel and asphalt items have been included on a DWR and authorized on a Diary.
Exercise 9-8
Main Panel > Contractor Payments > Estimates > Generate Estimate

In the following exercise, you will generate the Estimate for payment and view the Estimate Summary window.

Login: tpsjone   Group: RE   Contract: 7777P

1. Double-click the Contractor Payments icon.
2. Double-click the Estimate icon.
3. Double-click the Generate Estimate icon.
4. In the Contract list box, scroll to and double-click 7777P.
5. In the End field, type 090508.
6. Click the Generate Estimate button.
7. In the message to delete the current Estimate, click the Yes button.
8. In the message to reconnect to the servers, click the No button.
9. In the message, click the OK button.
10. Click the Close button.
11. Double-click the Estimate Summary window.
12. In the Estimate list box, scroll to and double-click Estimate Number 0001.

13. What is the total to be paid to the Contractor?
   $18,119.20

14. Click the Close button.

Notice the increase in Item Earnings due to the Fuel and Asphalt Price Adjustment items.
Viewing Estimate Discrepancies

SiteManager identifies the discrepancies associated with an Estimate. The discrepancies are of two levels; discrepancies at Estimate level and discrepancies at item level. For instance, if a Checklist Event is not met the discrepancy is associated to the Estimate. Or, if there is an overrun situations, the discrepancy is associated with the line item.

There are two options with discrepancies:

- Resolve
- Override

Types of Discrepancies

There are four types of discrepancies and each will be identified using different criteria. These four discrepancies are as follows:

- Overrun Discrepancy
- Milestone Completion Discrepancy
- Contract Completion Discrepancy
- Checklist Event Discrepancy

The Estimate Discrepancy panel displays all the discrepancies associated with an Estimate. Discrepancies can be associated to an Estimate or to a Estimate item (Contract item with installed quantities for the Estimate period). The Estimate discrepancies will be listed at the top of the panel and item discrepancies will be listed after them. The Status field values will be either Unresolved or Override. When the Identify Discrepancy function is requested by the Recalculate Discrepancies choice (or by Generate Estimate process), the discrepancy is re-determined.
Resolving Estimate Discrepancies

Discrepancies generated by the Estimate Generation process may be resolved prior to approving the Estimate. When the user clicks the Estimate discrepancy and then clicks the Navigation button on the toolbar, SiteManager opens a window to help resolve the Estimate discrepancy. For example, if a milestone Estimate discrepancy is selected, then the Milestone window is opened when the Navigation button is clicked.

![Figure 9-9. The Estimate Discrepancy Panel](image)

If possible, the Resident Engineer is to resolve each Estimate discrepancy.
Exercise 9-9
Main Panel > Contractor Payments > Estimates > Estimate Discrepancy

In the following exercise, you will create, view and resolve an Estimate discrepancy.

Login: tpsjone  Group: RE  Contract: 7777P

1. Double-click the Estimate Discrepancy icon.

2. Click the discrepancy that says Event DC127 for date (09/04/08) has not occurred.

3. Click the Navigation button.

4. In the Event Type list box, click the checklist event for DC127.

5. In the Actual Date field, and type 090408.

6. Click the Save button.

7. Click the Close button.

There are two projected dates. We only need to satisfy the 09/04/08 date since the Estimate End date is 09/05/08.
Recalculating Estimate Discrepancies

Recalculating an Estimate in the Estimate Discrepancy window will cause any resolved discrepancies to be removed for that Estimate, but will not affect overridden or unresolved discrepancies.

![Image of Estimate Discrepancies window]

Figure 9-10. Recalculated Estimate Discrepancy

The Resident Engineer is to recalculate the discrepancies after resolving all possible Estimate discrepancies.
Exercise 9-10
Main Panel > Contractor Payments > Estimates > Estimate Discrepancy

In the following exercise, you will recalculate the Estimate discrepancies

Login: tpsjone   Group: RE    Contract: 7777P

1. Click the Services menu and click the Recalculate Discrepancies choice.

2. Click the Yes button.

3. Click the OK button.

4. Click the Save button.
## Overriding Estimate Discrepancies

Overriding an Estimate Discrepancy in the Estimate Discrepancy window will cause the discrepancy to be ignored by SiteManager for the specified Estimate only. If the Estimate discrepancy is not resolved by the next Estimate, it will reappear.

<table>
<thead>
<tr>
<th>Discrepancy Type</th>
<th>Override Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Overruns</td>
<td>Item Overruns SiteManager will automatically override these discrepancies with a message stating “This discrepancy has been addressed by line item adjustment &lt;insert adjustment detail&gt;.” This override will continually appear until a Change Order is approved to increase the item quantity. The Resident Engineer is to verify that the overrun is due to increased quantities. If the discrepancy is due to incorrect placed quantities, the Estimate is to be deleted and the DWR quantities adjusted appropriately.</td>
</tr>
<tr>
<td>Contract Completion Date</td>
<td>The Resident Engineer is to verify that a change order is being processed or initiate one. The discrepancy can then be overridden with an explanation. The Resident Engineer is to also determine if Liquidated Damages are appropriate to apply to the Estimate.</td>
</tr>
<tr>
<td>Milestone Completion Date</td>
<td>The Resident Engineer is to verify the status of the Milestone. If the milestone is not complete, the Resident Engineer is to verify that a change order is being processed or initiate one. The discrepancy can then be overridden with an explanation. The Resident Engineer is to also determine if disincentives are appropriate to apply to the Contract. A Change Order to add the Disincentive item to the Contract or to modify the quantity of the Disincentive item is to be initiated. The disincentive is to be applied to the Contract via DWR once the Change Order is approved.</td>
</tr>
<tr>
<td>Checklist Event Completion Date Missed</td>
<td>The Resident Engineer is to notify the Contractor that the insurance expiration date is approaching and then override the discrepancy with an explanation.</td>
</tr>
<tr>
<td>Insurance Expiration Checklist Events</td>
<td>The Resident Engineer is to notify the Contractor that the insurance expiration date is approaching and then override the discrepancy with an explanation.</td>
</tr>
<tr>
<td>EEO Reports</td>
<td>This event type includes the TAD 1276/CC257, FHWA 1409, AD 267, AD 268, 1391, and the Monthly Training Report. The Resident Engineer is to notify the Contractor that the report is overdue and then override the discrepancy with an explanation.</td>
</tr>
</tbody>
</table>
The Resident Engineer is to override discrepancies on Progress Estimates after taking the action appropriate for the discrepancy. Final Estimates cannot be approved with Estimate discrepancies.

Exercise 9-11
Main Panel > Contractor Payments > Estimates > Estimate Discrepancy

In the following exercise, you will override a discrepancy.

Login: tpsjone   Group: RE    Contract: 7777P

1. Click the discrepancy that says Milestone 01 is not reached.

2. In the Status drop-down list, click the expand arrow and click the Override choice.

3. In the Remarks window, type Change Order Pending to increase time.

4. To close the Remarks window, on the toolbar, click the Remarks button.

5. Click the Save button.

6. Click the Close button.

To view overrun discrepancy Remarks, sort by the status column, click the discrepancy and then click the Remarks button.
Viewing the Estimate Item Detail Window

The Estimate Item Detail panel displays the Item quantities from approved Daily Work Reports. For the current unapproved Estimate, this panel allows the adjustment of selected Item quantity fields.

![Figure 9-12. The Estimate Item Detail Panel](image)

The Resident Engineer is to review the Estimate Item Detail window for information regarding item quantities to date.
Exercise 9-12
Main Panel > Contractor Payments > Estimates > Estimate Item Detail

In the following exercise, you will view the Estimate Item Detail window.

Login: tpsjone  Group: RE  Contract: 7777P

1. Double-click the Estimate Item Detail icon.

2. In the list box, scroll to and click the record for Line Item Number 0011, Item Code 159006M, Item Description Drum.

3. What is the Current Qty? 150

4. What is the Paid to Date Qty? 160

5. Click the Close button.
Viewing the Estimate Item Paybook Window

This Estimate Item Paybook is an inquiry only window showing the payment history for a Contract Item. The Item payment history displays in reverse chronological order meaning the current Estimate Item displays on the first row. Thus, it is possible that the first row is not yet paid. Whether the first row is paid or not can be determined by the Reviewer User ID. If the Reviewer User ID is the final reviewer, then the Item is sent in the current Estimate for payment.

![Estimate Item Paybook Window](image)

Figure 9-13. Estimate Item Paybook window

The Resident Engineer is to view the Estimate Item Paybook window to determine which Estimates included a particular item.
Exercise 9-13
Main Panel > Contractor Payments > Estimates > Estimate Item Paybook

In the following exercise, you will view the Estimate Item Paybook.

Login: tpjone    Group: RE    Contract: 7777P

1. Double-click the Estimate Item Paybook icon.

2. In the Contract list box, scroll to and double-click Contract ID 7777P.

3. In the Line Item list box, scroll to and double-click Ln Itm Nbr 0011, Item Code 159006M, Desc Drum.

4. What was the adjustment made for this item on Estimate Nbr 0001? ______________

5. Click the Close button.

6. Click the Contractor Payments folder tab.
Viewing the Line Item Adjustment Window

The Line Item Adjustments window allows the user to inquire about the Line Item Adjustments for an Estimate. The top portion of the window displays all the Estimate Line Items for which an adjustment is present. The bottom portion of the window displays associated adjustment information.

![Figure 9-14. The Line Item Adjustments Panel](image-url)

The Resident Engineer is to view the Line Item Adjustment window for details regarding adjustments made to items due to Stockpiled Materials and Item Overruns. All Line Item Adjustments are made automatically by SiteManager.
Exercise 9-14
Main Panel > Contractor Payments > Contract Adjustments > Line Item Adjustments

In the following exercise, you will view the line item adjustments.

Login: tpsjone Group: RE Contract: 7777A

1. Double-click the Contract Adjustments icon.
2. Double-click the Line Item Adjustments icon.
3. Scroll to and click Catg Nbr 0001, Line Item Number 0011, Item Code 159006M, Description Drum.
4. By what quantity did this item overrun? __________
5. Click the Close button.

Item 0046 is listed twice as the item was stockpiled and then the stockpile was replenished, resulting in two initial payments.
Viewing the Contract Adjustment Window

The Contract Adjustments window lists all the different types of Contract adjustments and the associated detail information for a Contract or an Estimate. The Description folder tab of the Contract Adjustment window allows the user to access adjustments made on previous Estimates within the same Contract and allows for adjustments to be applied on the current pending Estimate.

The following Contract Adjustments can be made in the Contract Adjustment window.

- Cash Retainage Withheld
- EEO Adjustment
- Liquidated Damages Substantial Completion
- Liquidated Damages Final Completion

The user may add, modify, or delete Contract Adjustments that are not system-generated. Transportation agency-defined Contract adjustment descriptions are entered into the system at system setup.

Figure 9-15. The Contract Adjustments Panel
The Resident Engineer is to make the necessary Contract Adjustments and review the adjustments made by the SiteManager automatically.

The Cash Retainage Withheld adjustment will be made by SiteManager automatically. The Resident Engineer is to only make this adjustment manually if the securities balance is negative and direction is provided by Construction Services.

Exercise 9-15
Main Panel > Contractor Payments > Contract Adjustments > Contract Adjustments

In the following exercise, you will view the Contract Adjustments window.

Login: tpsjone  Group: RE  Contract: 7777P

1. Double-click the Contract Adjustments icon.
2. What is the amount of the retainage withheld? -5285.62
3. Click the Close button.
4. Click the Contractor Payments folder tab.
5. Double-click the Estimate icon.
Approving the Estimate

This Estimate Approval window allows the authorized reviewers to approve all Estimate types (Progress, Final, or Supplemental). The approval process provides an audit trail, providing who approved the Estimate and when it was approved.

The Estimate can be modified up until the first level approval is entered by the Resident Engineer. Once the Estimate is in INAP status, the Estimate cannot be modified, unless it is rejected by the next Estimate level approver. Once the final approval level submits his approver, the Estimate can no longer be changed in SiteManager.

Figure 9-16. The Estimate Approval Panel
The Progress Estimate is approved by the following personnel:

- Resident Engineer
- Accounting Operations

The Final Estimate and Supplemental Estimates are approved by the following personnel:

- Resident Engineer
- Regional CST Eng/Maint. Engineer
- Accounting Operations

Once the Estimate is approved by the Resident Engineer, the Contractor is to be sent Form DL 72. Once this form is submitted from the Contractor to the Field Office, the Resident Engineer or his designee are to create a Correspondence Log record and scan and attach the DL 72. The Correspondence Log record is to then be forwarded to Accounting Operations.

---

**Exercise 9-16**

Main Panel > Contractor Payments > Estimates > Estimate Approval

In the following exercise, you will approve the Progress Estimate.

- **Login:** tpsjone  **Group:** RE  **Contract:** 7777P

1. Double-click the **Estimate Approval** icon.

2. In the **Contract** list box, scroll to and double-click the Contract ID 7777P.

3. Click the **Approved** check box (ON).

4. Click the **Save** button.

5. Click the **Close** button.

6. Click the **Ok** button.
Tracking the Estimate

The Estimate Tracking panel is a view-only window that allows the tracking of Estimate generation, approval, and rejection.

![Estimate Tracking Panel](image)

Figure 9-17. The Estimate Tracking Panel

Users are to view the Estimate Tracking window to determine the approval status of an Estimate.
Exercise 9-17
Main Panel > Contractor Payments > Estimates > Estimate Tracking

In the following exercise, you will track the Estimate.

Login: tpsjone Group: RE Contract: 7777G

1. Double-click the Estimate Tracking icon.

2. Click the Open button.

3. Click the Contract ID button.

4. In the Contract ID list box, scroll to and double-click Contract ID 7777G.

5. In the Estimate list box, scroll to and double-click Estimate Number 0001.

6. Click the Close button.
Correcting an Estimate

During the Progress Estimate Process, if a quantity is discovered to be incorrect on the Estimate and the Estimate has not been fully approved (Accounting Operations approval), then the quantity should be corrected and the Estimate regenerated.

The Estimate Correction Procedure is detailed below:

- Delete the Estimate in the Estimate History window.
- Unauthorize the DWR in question on the Diary.
- Contact the creator of the DWR to fix the DWR. (If the creator of the DWR is not available, the Resident Engineer may modify/create his own DWR and provide an explanation in the Remarks area of the DWR.)
- Re-authorize the DWR on the Diary.
- Re-generate the Estimate.
- Continue with the Progress Estimate Process Plan

Pending Estimates can only be deleted in the Estimate History window. The Estimate History window allows the selection and display of all Estimates for a Contract. Clicking the Open button displays the Estimate number or the period end date of the Estimate entered to define the starting row. The Estimates will display from most recent to the oldest Estimate. The Estimate History window may be used to view the Status of an Estimate. Applicable statuses in NJDOT include the following:

- PEND – Pending. Pending Estimates exist while the Resident Engineer is generating and reviewing the Estimate. Pending Estimates may be deleted and regenerated by the Resident Engineer.
- INAP – In Approval. Estimates that are in approval have at least one approval level provided. Estimates that are in INAP status may be rejected or approved.
- RECT – Rejected. Rejected Estimates may be regenerated and resubmitted for approval.
- APVR – Approved. Approved Estimates have all levels of approval and cannot be modified.
The Resident Engineer is to follow the Estimate Correction Procedure if an error is discovered with the Estimate prior to its full approval.

Exercise 9-18
Main Panel > Contractor Payments > Estimates > Estimate History

In the following exercise, you will correct an Estimate using the Estimate Correction Procedure.

Login:  tpsjone  Group: RE  Contract: 7777H

1. Double-click the Estimate History icon.

2. Click the Open button.

3. In the Contract ID list box, scroll to and double-click Contract ID 7777H.

4. Click to select Estimate Number 0001.

5. On the toolbar, click the Delete button.

6. In the message box, click the Yes button.

7. Click the Close button.
8. Click the **Main Panel** folder tab.

9. Double-click the **Daily Work Reports** icon.

10. Double-click the **Diary** icon.

11. Click the **Open** button.

12. In the **Date** list box, scroll to and double-click date Diary Date 08/08/08.

13. In the **Inspector** list box, click to select the DWR for **Brown, Sam**.

14. Click the **Authorized** check box (OFF).

15. Click the **Save** button.

16. Click the **File** menu and then click the **Exit** choice.

17. Double-click the **SiteManager** icon on your desktop.

18. In the User ID field, type **tpsbrow**.

19. Press the **Tab** key.

20. In the **Password** field, type **pass**.

21. Press the **Enter** key.

22. Double-click the **Daily Work Reports** icon.

23. Double-click the **Daily Work Reports** icon.

24. Click the **Open** button.

25. From the **Contract ID** selection list, double-click Contract ID 7777H.

26. In the **Inspector** list box, double-click User ID **tpsbrow**.

27. From the **Date** list box, double-click DWR Date **08/08/08**.

28. Click the **Work Items** folder tab.

29. Scroll to and double-click Line Item Number **0011**, Category Number **0001**, Item Code **159006M**, Description **Drum**.

30. In the **Placed Qty** field, type **10**.

31. Click the **Save** button.
32. Click the **File** menu and then click the **Exit** choice.

33. Double-click the **SiteManager** icon on your desktop.

34. In the **User ID** field, type **tpsjone**.

35. Press the **Tab** key.

36. In the **Password** field, type **pass**.

37. Press the **Enter** key.

38. Double-click the **Daily Work Reports** icon.

39. Double-click the **Diary** icon.

40. Click the **Open** button.

41. In the **Contract** list box, scroll to and double-click **Contract ID 7777H**.

42. In the **Date** selection list, scroll to and double-click **Diary Date 08/08/08**.

43. In the **Inspector** list box, click to select the **DWR for Brown, Sam**.

44. Click the **Authorized** check box (ON).

45. Click the **Save** button.

46. Click the **Close** button.

47. Click the **Main Panel** folder tab.

48. Click the **Contractor Payments** folder tab.

49. Double-click the **Estimate** icon.

50. Double-click the **Generate Estimate** icon.

51. In the **Contract** list box, scroll to and double-click **Contract ID 7777H**.

52. In the **End** field, type **090508**.

53. Click the **Generate Estimate** button.

54. In the message box, click the **No** button.

55. In the message box, click the **OK** button.
56. Click the Close button.
Review for Section 9

To generate the Installed Work Report:
1. Double-click the Contractor Payments icon.
2. Double-click the Reports icon.
3. Double-click the Installed Work icon.
4. In the Contract ID column, scroll to and double-click the desired Contract ID.
5. Click the Close button.

To generate the Estimate:
1. Click the Contractor Payments icon.
2. Double-click the Estimate icon.
3. Double-click the Generate Estimate icon.
4. In the Contract list box, scroll to and double-click the desired Contract ID.
5. In the End field, type the end date.
6. Click the Generate Estimate button.
7. In the message, click the OK button.
8. In the message, click the OK button.
9. Click the Close button.

To view The SiteManager inbox for a message stating that the Estimate has finished processing:
1. Double-click the Accessories icon.
2. Double-click the In-Box icon.
3. Double-click the desired message.
4. Click the Close button.

To generate a Crystal Report:
1. Double-click the Reports icon.
2. In the System field, type snj 187:6400.
3. In the User Name field, type TSP_Construction.
4. In the Password field, type pave09.
5. In the Authentication drop-down list, click the expand arrow and click Enterprise.
6. Click Folders.
7. Click the TSP_Construction folder.
8. Click the desired report.
9. Enter the required Parameters.
10. Click the OK button.
11. View, Print, or Save the report.

To export a Crystal Report to PDF format:
1. Generate the desired report.
2. Click the Export this Report button.
3. In the File Format drop-down list, click the expand arrow and click Adobe Acrobat (PDF).
4. Click the OK button.
5. Click the Save button.
6. Save the report in the desired location.
7. Exit Crystal Reports.

To create a DWR to record price adjustments and authorize the DWR on a Diary:
1. Double-click the Daily Work Reports icon.
2. Double-click the Daily Work Reports icon.
3. Click the Services menu, and then click the Choose Keys choice.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. In the DWR Date field, type the DWR date.
6. Press the Tab key.
7. In the Remarks Type list box, scroll to and click General.
8. In the Remarks text box, type the remark for the price adjustment.
9. Click the Save button.
10. Click the Contractors folder tab.
11. On the Contractors folder tab, click the Contractor area.
12. Click the New button. An empty row is added to the list.
13. In the Contractor drop-down list, click the expand and click Contractor.
14. Click the Save button.
15. Click the Work Items folder tab.
16. Scroll to and click the Work Item.
17. Click the Record Work Item button.
18. Click the New button.
19. In the Placed Qty field, type the quantity.
20. In the Contractor drop-down list, click the expand arrow and click the Contractor.
21. In the As Built Qty field, type the quantity.
22. In the Location field, type the location.
23. Click the Save button.
24. Click the Close button.
25. Double-click the Diary icon.
26. In the Inspector list box, click the DWR for the Inspector. Click the Authorized check box (ON).
27. Click the Save button.
28. Click the Close button.

To view the Estimate Summary window:
1. Double-click the Contractor Payments icon
2. Double-click the Estimate icon.
3. Double-click the Estimate Discrepancy icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. In the Estimate list box, scroll to and double-click the desired Estimate Number.
6. Click the Close button.

To view, resolve, and recalculate an Estimate discrepancy:
1. Double-click the Contractor Payments icon
2. Double-click the Estimate icon.
3. Double-click the Estimate Discrepancy icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. In the Estimate list box, scroll to and double-click the desired Estimate Number.
6. Click the Close button.
7. In the Status drop-down list, click the expand arrow and click the Override choice.
8. In the Remarks window, type the desired remarks.
9. To close the Remarks window, on the toolbar, click the Remarks button.
10. Click the Save button.
11. Click the Close button.

To override a discrepancy:
1. Double-click the Contractor Payments icon
2. Double-click the Estimate icon.
3. Double-click the Estimate Discrepancy icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. In the Estimate list box, scroll to and double-click the desired Estimate Number.
6. Click the discrepancy.
7. In the Status drop-down list, click the expand arrow and click the Override choice.
8. In the Remarks window, type the desired remarks.
9. To close the Remarks window, on the toolbar, click the Remarks button.
10. Click the Save button.
11. Click the Close button.

To view the Estimate Item Detail window:
1. Double-click the Contractor Payments icon
2. Double-click the Estimate icon.
3. Double-click the Estimate Item Detail icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. In the Estimate list box, scroll to and double-click the desired Estimate Number.
6. Click the Yes button.
7. Click the Close button.

To view the Estimate Item Paybook:
1. Double-click the Contractor Payments icon
2. Double-click the Estimate icon.
3. Double-click the Estimate Item Paybook icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. In the Line Item list box, scroll to and double-click the desired item.
6. Click the Close button.
To view the Line Item Adjustments window:

1. Double-click the **Contractor Payments** icon.
2. Double-click the **Contract Adjustments** icon.
3. Double-click the **Line Item Adjustments** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Estimate** list box, scroll to and double-click the desired Estimate number.
6. Click the **Close** button.

To view the Contract Adjustments window:

1. Double-click the **Contractor Payments** icon.
2. Double-click the **Contract Adjustments** icon.
3. Double-click the **Contract Adjustments** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Estimate** list box, scroll to and double-click the desired Estimate number.
6. Click the **Close** button.

To delete an Estimate in the Estimate History Window:

1. Double-click the **Contractor Payments** icon.
2. Click the **Estimates** icon.
3. Double-click the **Estimate History** icon.
4. In the **Contract** list box, scroll to and double-click the desired Contract.
5. In the **Estimate** list box, scroll to and double-click the desired Estimate Number.
6. Click the **Delete** button.
7. Click the **Yes** button.
8. Click the **Close** button.

To approve an Estimate:

1. Double-click the **Contractor Payments** icon.
2. Click the **Estimates** icon.
3. Double-click the **Estimate Approval** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Estimate** list box, scroll to and double-click the desired Estimate Number.
6. Click the **Approved** check box (ON).
7. Click the **Save** button.
8. Click the **Close** button.
9. Click the **Ok** button.

To track an Estimate:

1. Double-click the **Estimate Tracking** icon.
2. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
3. In the **Estimate** list box, scroll to and double-click the desired Estimate Number.
4. Click the **Close** button.
Summary for Section 9

In the following exercise you will generate and approve a Progress Estimate.

Login: tpsjone  Group: RE

1. Generate the Installed Work Report for Contract ID 8888J.

   Are all the DWRs authorized?  Yes

2. Generate a Progress Estimate for Contract ID 8888F with an estimate end date of 09/07/08.

3. Navigate to the Estimate Summary window.

   Has an overrun adjustment been generated?  No

4. Describe how you would apply fuel and asphalt price adjustments to an Estimate?

   Generate the fuel and asphalt price adjustment reports, create a DWR for a date during the Estimate period, authorize the DWR and regenerate the Estimate.

5. Navigate to the Estimate Summary window and open Estimate Nbr 0001 for Contract ID 8888P.  What is the total paid to the Contractor?  $24,756.81


7. Resolve the discrepancy for the AD 267 missed checklist event. Enter 09/06/08 as the Actual Date. (Hint: click the Navigation button.)

8. Recalculate the discrepancies.

9. Override the Milestone 01 is not reached discrepancy with the remark Change Order is Pending.

10. Navigate to the Estimate Item Detail window? For Catg Nbr 0001, Line Item Number 0028, Item Code 401030M, Description Tack Coat. What is the installed quantity to date?  130

11. Navigate to the Estimate Item Paybook. For Contract ID 8888P, Catg Nbr 0001, Line Item Number 0028, Item Code 401030M, Description Tack Coat, have any adjustments been made to this item?  No

12. Navigate to the Line Item Adjustments window. How many adjustments were made on Estimate Number 0001?  1
13. Navigate to the **Contract Adjustments** window. How much retainage was withheld on Estimate Number **0001**? ________________

14. Where can you generate the **Estimate Summary Report**?

   Reports Icon or Crystal Reports

15. Approve Estimate Nbr **0001** for Contract ID **8888P**.

16. Navigate to the **Main Panel**.
10 Creating a Change Order

By the end of this section, you will be able to:

- Review the SiteManager Change Order Process
- Create the Change Order Header
- Create a Time Adjustment
- Modify Existing Items
- Add New Items
- Add a Force Account Item
- Calculate the Change Order
- Add Change Order Explanations
Reviewing the SiteManager Change Order Process

The Change Order process allows legal changes to be made to a Contract by creating, approving, and tracking changes.

Contract Change Orders may include:

- Quantity adjustments for existing items
- Adding new items of work to the Contract
- Time Extensions on milestones or revisions to a Contract completion date
- Adding items of work to the Contract per a Force Account
- Final Quantity (NJDOT will not use this function)

Except for zero dollar, users can specify more than one function to make up a Change Order. Before a Change Order is saved, edits are performed to ensure that its components are reconciled with its selected functions. Messages advise the user if information has not been entered for a selected function.

Before the user can select a specific window in the Change Order function, a specific Contract must be selected from a pick list containing valid Contracts, and associated, existing Change Orders. A specific Contract must be selected from the pick list to create a new Change Order.

Change Order Life Cycle

The life cycle of Contract Change Orders is reflected in the Change Order functions in SiteManager.

Creation of a New Change Order

A Change Order can only be created by the Resident Engineer or his designee. Specific information about the Change Order must be recorded using the Change Order Header window, the Change Order Items window, the Time Extension window, and/or the Change Order Explanations window.
Maintaining Change Orders

Once a Change Order has been created, updates to the Change Order information may be required. Change Order header information, items, time frames, and explanations may be modified in update mode on the appropriate windows.

Review and Approval of Change Orders

After it is created, a draft Change Order can be forwarded via in-box notification for parallel review. Parallel review is concurrent review by more than one reviewer at a time.

The writer of the Change Order can also place the Change Order into Pending status and submit it for a hierarchical approval, skipping the review process.

Users involved in reviewing a Draft Change Order or approving a pending Change Order can record their decisions about proposed changes to the Contract on-line, using the Review/Approve window. Reviewers/Approvers receive an In-Box message from the author requesting an action, review or approval for the Change Order. The In-Box message specifies the Contract and Change Order number.

All Change orders on a Contract must be either Approved or Denied in order for the Final As-built Change Order Complete Date to be entered in Contract Administration, as part of the Contract Finalization Process. (Change Orders may not be in a Draft or Pending status for the Contract Finalization Process.)

Tracking the Change Order

At any time, the writer of the Change Order may view the status of a Change Order in the review or approval cycle by opening the Tracking window. The Tracking window for a Change Order is a view-only window and displays:

- The date a request for recommendation was sent to a reviewer or approver
- The reviewer or approver’s name
- The action requested - review or approve
- The date the reviewer or approver makes a recommendation
- The recommendation - Approved or Denied
Authorized users may also display details about current and historic Contract items on-line using the Item Summary window.

**Change Order Conditions**

There are three conditions that affect how the Change Order process in SiteManager works. These are the:

- Type of Contract
- Function(s) associated with the Change Order
- Status of the Change Order

**Change Order Functions**

There are six types of Change Orders:

- Overrun/Underrun
- Extra Work
- Time Adjustment
- Force Account
- Zero Dollar
- Final Quantity (NJDOT will not use this function)

A Change Order may be a combination of types except for a Zero Dollar Change Order.

Users define the purpose of the Change Order by selecting among the different functions. Except for Zero Dollar, users can specify more than one function to make up a Change Order. The functions available on a Change Order are:

- **Overruns or Underruns**: Used when the quantities associated with the Contract items are either exceeded or not needed to complete the Contract or work item.
- **Extra Work**: Used when additional work items are required to complete the Contract.
- **Time Adjustments**: Used when the timeframes need to be adjusted to
reflect the completion period for a milestone or Contract.

**Force Account**

Used when the parties agree that a change is required but there is not yet an agreement on the cost of that change. The Force Account must already be established on the Contract in order to have a Force Account Change Order. A force account Change Order requires adding a new line item to the Contract.

**Zero Dollar**

Used only for Contract adjustments that will not affect the dollar amount of the Contract (example: changing the location of a project).

**Final Quantity**

NJDOT will not utilize this function.

### Change Order Status

The Change Order Status field displays the current status of the Change Order in the creation, review, and approval process. The Change Order Status types are:

- **Draft**
  
  A Change Order is Draft status while it is being created, edited, or forwarded on for review.

- **Pending**
  
  A Change Order is changed to Pending status when it needs to be submitted for the approval process. While in Pending status, the Change Order cannot be modified except for its status.

- **Denied**
  
  When the Recommendation for a Change Order is denied using the Change Order Review/Approve window, SiteManager puts the Change Order back into Pending status in case the disapproval was conditional and the Change Order merely needs correction. A Change Order denied during the Approval process may have its status changed to back to Draft, may be corrected, may have its status changed back to Pending, and may be resent through the approval process.

  While in Pending status, a Change Order can also be put into Denied status using the Status droplist. When changed to Denied status using the Status droplist, the entire Change Order is changed permanently to Read Only mode and may never again be modified or deleted. This should only be done when the Change Order is disapproved and will never be revised, but
needs to remain as project documentation.

**Approved**

A Change Order will be placed in Approved status when the last approver completes the approval process – it is not a manual selection. When a Change Order has been approved by its final approval level, it cannot be altered. Adjustments can only be made by creating a new Change Order.

All Change Orders must be in either Approved or Denied status for the Contract Finalization Process.

![Figure 10-1. The Change Order Maintenance Panel](image)

The Resident Engineer or his designee are to create Change Orders in SiteManager.
Exercise 10-1
Main Panel > Change Orders > Change Order Maintenance > Header

In the following exercise, you will open the Header window.

Login:  tpsjone  Group:  RE  Contract:  7777G

1. Double-click the Change Orders icon.

2. Double-click the Change Order Maintenance icon.

3. Double-click the Header icon.

4. Click the Services menu, and then click the Choose Keys choice.

5. In the Contract ID list box, scroll to and double-click Contract ID 7777G.
Creating the Change Order Header

The Change Order Header window allows an authorized user to:

- Create a new Change Order by entering a new descriptive information for a Change Order, or
- Maintain the current descriptive information about an existing Change Order as the status of the Change Order progresses from Draft through Pending to Approved or Disapproved.

The user must have specific authority to create and maintain Change Orders in SiteManager. The Change Order function determines the entries that must be made and the windows that must be accessed to create and maintain a Change Order. With the exception of the Zero Dollar Change Order, a Change Order may have multiple functions checked. For example, one Change Order may be identified as Extra Work and Force Account. Messages appear prompting users to complete required fields.

```
Figure 10-2. The Change Order Header Window
```

<table>
<thead>
<tr>
<th>Change Order Reasons</th>
<th>Standard Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID 001</td>
<td>Changes Authorized by Construction in accordance with CPH Sec 4-A (including as-builts), which are not in any other description of change.</td>
</tr>
<tr>
<td>ID 002</td>
<td>Traffic impact modification or safety enhancement</td>
</tr>
<tr>
<td>ID 003</td>
<td>Additional work for Corrective Action comment, including work after completion date</td>
</tr>
<tr>
<td>ID 004</td>
<td>Project Manager change to add or delete work (Scope change)</td>
</tr>
<tr>
<td>Change Order Reasons</td>
<td>Standard Explanations</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>Right of Way</td>
<td>005 Change to address a Right of Way issue</td>
</tr>
<tr>
<td>Utility</td>
<td>006 Change to address a Utility issue</td>
</tr>
<tr>
<td>Environmental</td>
<td>007 Change to address an Environmental issue</td>
</tr>
<tr>
<td>Contract Correction</td>
<td>008 Change to address an error or omission in the Contract</td>
</tr>
<tr>
<td>Field Conditions</td>
<td>009 Any other Project Management change based on field conditions.</td>
</tr>
<tr>
<td>Specification Change</td>
<td>010 Change in Specification by the Department</td>
</tr>
<tr>
<td>Material Change</td>
<td>011 Change in Material by the Department and/or Contractor</td>
</tr>
<tr>
<td>Value Engineering</td>
<td>012 Implementation of a Value engineering proposal</td>
</tr>
<tr>
<td>Contractor Request</td>
<td>013 Implementation of a Contractor requested change (except VE or Material)</td>
</tr>
<tr>
<td>Time Adjustment</td>
<td>014 Only a Time Adjustment and/or mitigation of a delay (No Quantities)</td>
</tr>
<tr>
<td>Incentive/Disincentive Payment</td>
<td>015 Incentive/Disincentive Payments (including bonus and penalty)</td>
</tr>
<tr>
<td>Other – See Change Order Description</td>
<td>016 Unique Situations, including Force Majeure (i.e. Act of God, fire, flood, strikes, accident, etc.)</td>
</tr>
</tbody>
</table>

Table 10-1. Change Order Reason and Explanation Table

The Resident Engineer or his designee are to create the Change Order Header.

The main reason for the Change Order is to be selected in the Reason Code drop-down list. Refer to Table 10-1. Change Order Reason and Explanation Table for Change Order reason descriptions. If there is more than one reason for the Change Order, additional reasons can be selected in the Change Order Explanation window.

Certification of Completion is an option in both the Reason Codes and Change Order Type drop-down lists. Certification of Completion is to only be selected by the Project Close Out Engineer for the Certification of Completion Zero Dollar Change Order.

If the Change Order is created as the result of a claim, then the claim is to be linked to the Change Order in the Dispute ID field.

If the Change Order is created for the purpose of a Force Account, then the Force Account is to be linked to the Change Order in the Force Account field.
Exercise 10-2
Main Panel > Change Orders > Change Order Maintenance >
Header

In the following exercise, you will enter the header information for a Change Order.

Login:  tpsjone  Group:  RE  Contract:  7777G

1. In the Description field, type To add COP#1.

2. In the Reason Code drop-down list, click the expand arrow and click Traffic Impact Mod or Safety Enhancement.

3. In the CO Type drop-down list, click the expand arrow and click Supplementary Agreement.

4. Click the Overrun/Underrun check box (ON).

5. Click the Extra Work check box (ON).

6. Click the Time Adjustment check box (ON).

7. Click the Force Account check box (ON).

8. In the Force Account ID field, perform a Search and double-click Force Account 1.

9. Click the Save button.

This Change Order will be to modify an item that was overrun, add an extra work item, adjust time for the Contract and a milestone, and add a Force Account item.
Creating a Time Adjustment

The Time Adjustments window allows authorized users to enter one or more time adjustments for a Change Order. At least one adjustment must be recorded using this window if the Time Adjustment function is selected on the Change Order.

Time adjustments may be related to the following:

- the Contract completion date
- milestone(s) on the Contract, or
- both the Contract completion date and milestone(s) associated with the Contract

The Charge Type for the Contract determines which timing components of the Contract and its associated milestones may be entered and modified. There are three charge types for Contracts. The changeable fields and required fields on the Time Adjustment Window are determined by the Contract's charge type as follows:

- **Available Days (AD)**
  Computes time periods based on the working days charged to the Contract and/or to each milestone. Only the number of days adjusted may be entered in the Time Adjustment Window. No completion date applies to this charge type.

- **Fixed Date (DT)**
  Has a specific fixed end date for the Contract or for milestones within the Contract. Only the completion date field may be entered. SiteManager computes the number of days adjusted.

- **Calendar Days (CD)**
  Computes the end date for the Contract and for milestones based on the number of calendar days allocated for the work. The number of days adjusted may be entered. SiteManager then computes the completion date.

Only one time adjustment per Contract and per milestone may be entered per Change Order.
The Resident Engineer or his designee are to enter time adjustments for Contract and milestone time.

The reason for the time adjustment is to be entered in the Explanations text field.

The explanation field displays on Change Order reports.
Exercise 10-3
Main Panel > Change Orders > Change Order Maintenance > Change Order Time Adjustments

In the following exercise, you will create a time adjustment to modify Contract and Milestone time.

Login: tpsjone  Group: RE  Contract: 7777G

1. Click the Services menu and then click the CO Time Adjustments choice.

2. Click the Time Adjustment Days field and type 10.

3. In the Explanation field, type An additional 10 days is required to have a subcontractor paint the traffic stripes required by COP No. 1. This work cannot be done concurrently with the critical path.

4. Click the Save button.

5. Click the New button.

6. Click the For Milestone radio button.

7. Click Milestone Number 01 from the drop-down list.

8. Click the Time Adjustment Days field and type 5.

9. In the Explanation field, type Traffic Operations restricted lane closings.

10. Click the Save button.

11. Click the Close button.
Modifying Existing Items

The Change Order Items window allows the user to:

- Select an existing item on the Contract for inclusion in the Change Order
- Add a new item to the Contract by including it in the Change Order
- Select and modify an existing item in the Contract already associated with the Change Order
- Delete an item from a Change Order

Whenever the Change Order function is an overrun/underrun and/or extra work, the Change Order Items window must be used to make the corresponding entries and/or modifications to the Change Order items.

When you add extra work, you must add a new item from the NJDOT’s Item Master list.

Figure 10-4. The Change Order Items Window - Change Order Item Folder Tab
The Resident Engineer or his designee are to modify the quantities of existing items on the Contract in the Change Order Items window.

If the reason for including the item on the Change Order is As-built Adjustment, Scope Change, Contract Correction, Field Conditions, or Contractor Request then the appropriate Area of Change is to also be selected.

Exercise 10-4
Main Panel > Change Orders > Change Order Maintenance > Change Order Items

In the following exercise, you will modify an existing item on the Contract.

Login:  tpsjone  Group:  RE  Contract:  7777G

1. Click the Services menu and then click the CO Items choice.

2. Click the Services menu and the click the Adjust Item Qty choice.

3. In the Contract Items list box, scroll to and double-click for Line Nbr 0018, Item Code 159108M, Description Traffic Control Truck with Mounted Crash.

4. In the This Change Order quantity field, type 1.0.

5. Click the Save button.
Adding New Items

New items may only be added to an active Contract through the Change Order process. When a new item is added to a Contract, the user must enter a Line Item Nbr, unit price, the quantity of the item, and a description of the item on the New Item tab of the Change Order Item window.

When a new item is added to the Contract through this process, the information about a new line item is not saved to the database until it is completed and saved on the Change Order Item tab. The New Contract Item tab performs all edits and passes all new item data to the Change Order Item tab where both the new item and Change Order information are saved. The Contract item list is not updated with the new item until the Change Order is approved.

Figure 10-5. The Change Order Items Window - New Contract Item Tab
The Resident Engineer or his designee are to add new Contract items to the Change Order on the New Contract Item folder tab.

The first item added to the Contract is to be given Line Item Number 9001 and each addition item is to increase sequentially (i.e. 9001, 9002, 9003, etc.)

If the needed item is not available in the Item Code field, the Resident Engineer is to complete the Non-Standard Item Number Request form and submit it to the Transport Office.

The Specialty and Pay Plan Qty check boxes are to be selected as applicable for the Item.

If the reason for adding the item is for As-Built Adjustment, Scope Change, Contract Correction, Field Conditions, or Contractor Request, then the appropriate Area of Change is to be selected on the Change Order Item folder tab.

If a new category or funding source is required for the item, the SiteManager Coordinator is to create the new Category, and Capital/Operations Programming is to associate the new funding source to the Category.
Exercise 10-5
Main Panel > Change Orders > Change Order Maintenance > Change Order Items

In the following exercise, you will enter add a new item to the Contract.

Login:  
Group:  
Contract:  

1. Click the New button.
2. Click the New Contract Item folder tab.
3. In the Project Nbr drop-down list, click the expand arrow to the right of the current selection and click 7777G.
4. In the Category Nbr drop-down list, click the expand arrow to the right of the current selection and click 0001 Roadway.
5. In the Line Item Nbr field, type 9001.
7. In the Unit Price field, type .25.
8. Click the Change Order Item folder tab.
9. In the Area of Change drop-down list, click the expand arrow and click Roadway.
10. In the This Change Order quantity field, type 20,000.
11. Click the Save button.
Adding a Force Account Item to a Change Order

The purpose of a Force Account is to record unexpected and unplanned expenses. Force Accounts are created in Contract Records and daily activities regarding the Force Account are tracked in Daily Work Reports. A Change Order is required to add the Force Account item to the Contract and acquire the appropriate funding. Once the Change Order is approved, the Force Account item is paid by installing the item on the DWR, authorizing the DWR on a Diary, and generating an estimate.

The Change Order can be created for the appropriate amount of the Force Account. Once the Force Account work is complete, the amount displayed on the Summary folder tab in the Force Accounts window. The Force Account item quantity can then be adjusted with an Overrun/Underrun Change Order.

Figure 10-6. The Force Account Panel

The Resident Engineer or his designee are to include the Force Account item on a Change Order for each Force Account on the Contract. The Force Account Description is to be entered as the Item’s Supplemental Description. The item is to be entered with a unit price of $1.00 and the quantity is to be the Contractor’s and Resident Engineer’s Estimate.

Once the Change Order is approved, the actual cost of the Change Order is to be entered in the Placed Qty and As-Built Qty fields on a DWR.
Exercise 10-6
Main Panel > Change Orders > Change Order Maintenance > Change Order Items

In the following exercise, you will add the Force Account to the Contract.

Login: tpsjone Group: RE Contract: 7777G

1. Click the New button.
2. Click the Services menu and then click the CO Items choice.
3. Click the New Contract Item folder tab.
4. In the Project Nbr drop-down list, click the expand arrow to the right of the current selection and click 7777G.
5. In the Category Nbr drop-down list, click the expand arrow to the right of the current selection and click 0001.
6. In the Line Item Nbr field, type 9002.
8. In the Unit Price field, type 1.00.
9. In the Supplemental Description field, type FA 1 Inlet Reconstruction.
10. Click the Change Order Item folder tab.
11. In the Area of Change drop-down list, click the expand arrow and click Drainage.
12. In the This Change Order quantity field, type 931.20.
13. Click the Force Account Item check box (ON).
14. Click the Save button.
15. Click the Close button.
16. Click the Save button.

If time permits, show the Force Account Summary folder tab and verify the Force Account total.

Items added via Change Order begin with line item number 9001 and increase sequentially.
Calculating the Change Order

After the full Change Order creation or maintenance activities are complete, including entries or updates to the Change Order items, time adjustments and explanations windows as desired, the user may re-calculate the display only values on the Change Order header window.

The Resident Engineer or his designee are to calculate the amount of the Change Order.

If the Contract has Federal Oversight and the Change Order is calculated to be greater than $10,000, the Resident Engineer or his designee are to contact the FHWA Area Engineer to obtain verbal approval. The date verbal approval is given is to be entered in the Federal Tentative Verbal Approval Date field.

If the Change Order is valued at under $10,000, then the Resident Engineer or his designee are to enter the date the Change Order was created in the Federal Tentative Verbal Approval Date field.
Exercise 10-7
Main Panel > Change Orders > Change Order Maintenance >
Header

In the following exercise, you will calculate the Change Order.

Login: **tpsjone**  Group: **RE**  Contract: **7777G**

1. Click the **Services** menu and then click **Calculate Change Order** choice.

2. Click the **Save** button.

3. Click the **Close** button.
**Adding Change Order Explanations**

The Change Order Explanation window is used to document the reasons for Contract changes. This window allows the author of the Change Order to record the reason for changes in the Contract included in the Change Order. It also allows reviewers and approvers to view the Change Order reasons.

There are two types of explanations that may be associated with a Contract Change Order:

- One or more specific explanations pertaining to *items* on a Change Order, and
- One or more explanations pertaining to the Change Order as a whole.

![Figure 10-8. The Change Order Explanations Window](image)
The Resident Engineer or his designee are to enter the reasons for the Change Order in the Change Order Explanations window in accordance with the following:

**General Change Order Explanations:**

- Sequence Number 1 – This is to always be entered as the Location of Proposed Change Order.

- Next GEN Explanation – This area is reserved for capturing the purpose of the Change Order. It is to be either copied and pasted from the Construction Order Catalog or manually typed into the text field.

- Next GEN Explanation – This area is reserved for the appropriate DAG statement if required (Rittenbury).

- Next GEN Explanation – This area is reserved for the appropriate funding explanations such as the Project Manager statements, the FHWA statement, or the 3rd party participation statement.

**Explanations Applied to Specific Items:**

- COTS Standard explanations are to be applied to specific items if the reason for including the item on the Change Order differs from the reason selected in the Reason Code field on the Header window. For example, if a Change Order is created with three items and only two of the items are for the Utility reason, then the reason for the third item is to be selected from the list of standard explanations.

- Statements regarding particular items are to be made if an item is requiring an adjustment by $25K or more, positive or negative or if a “Pay Proposal” item is adjusted.

Explanations entered in the Change Order Explanation window are exported to various reports. Up to five COTS explanations can be added, but each item should only be associated to one explanation.
Exercise 10-8
Main Panel > Change Orders > Change Order Maintenance > Change Order Explanations

In the following exercise, you will add explanations to the Change Order.

Login: tpsjone Group: RE Contract: 7777G

1. Double-click the Change Order Explanations icon.

2. Click the New button to create a “General Explanation.”

3. In the lower text field, type Throughout Project.

4. Click the Save button.

5. Click the New button to create a “General Explanation.”

6. In the lower text field, type To add COP #1 to this Contract which will enhance the safety of the roadway by adding the 20,000 LF of the extra work item Traffic Stripes, Long life, Epoxy Resin.

7. Click the Save button.

8. In the drop-down list, click the expand arrow and click Explanations Applied to Specific Items.

9. Click the New button.

10. In the Pick Std Exp ID field, perform a Search and double-click Explanation ID 009.

11. In the Change Order Line Items area, double-click Line Item 9001, Additional Description Roadway.

12. Click the Save button.

13. Click the New button.

14. In the Pick Std Exp ID field, perform a Search and double-click Explanation ID 004.

15. In the Change Order Line Items area, double-click Line Item 9002, Additional Description Drainage.
16. Click the **Save** button.

17. Click the **Close** button.

18. Click the **Main Panel** folder tab.
Review for Section 10

To open the Header window:

1. Double-click the Change Orders icon.
2. Double-click the Change Order Maintenance icon.
3. Double-click the Header icon.
4. Click the Services menu, and then click the Choose Keys choice.
5. In the Contract ID list box, scroll to and double-click the desired Contract ID.

To enter the header information for a Change Order:

1. Double-click the Change Orders icon.
2. Double-click the Change Order Maintenance icon.
3. Double-click the Header icon.
4. Click the Services menu, and then click the Choose Keys choice.
5. In the Contract ID list box, scroll to and double-click the desired Contract ID.
6. In the Description field, type the description.
7. In the Reason Code drop-down list, click the expand arrow and click the reason code.
8. In the CO Type drop-down list, click the expand arrow and click change order type.
9. Click the Overrun/Underrun check box (ON).
10. Click the Extra Work check box (ON).
11. Click the Time Adjustment check box (ON).
12. Click the Force Account check box (ON).
13. In the Force Account ID field, perform a Search and double-click the Force Account.
14. Click the Save button.

To create a time adjustment to modify Contract and Milestone time:

1. Double-click the Change Orders icon.
2. Double-click the Change Order Maintenance icon.
3. Double-click the Header icon.
4. Click the Open button.
5. In the Contract ID list box, scroll to and double-click the desired Contract ID.
6. In the Change Order list box, scroll to and double-click the desired CO Nbr.
7. Click the Services menu and then click the CO Time Adjustments choice.
8. Click the Time Adjustment Days field and type the number of adjustment days.
9. In the Explanation field, type the explanation.
10. Click the Save button.
11. Click the New button.
12. Click the For Milestone radio button.
13. Click the Milestone from the drop-down list.
14. Click the Time Adjustment Days field and type the number of adjustment days.
15. In the Explanation field, type the explanation.
16. Click the Save button.
17. Click the Close button.

To modify an existing item on a Contract:

1. Double-click the Change Orders icon.
2. Double-click the Change Order Maintenance icon.
3. Double-click the Header icon.
4. Click the Open button.
5. In the Contract ID list box, scroll to and double-click the desired Contract ID.
6. In the Change Order list box, scroll to and double-click the desired CO Nbr.
7. Click the Services menu and then click the CO Items choice.
8. Click the Services menu and the click the Adjust Item Qty choice.
9. In the Contract Items list box, scroll to and double-click the item.
10. In the This Change Order quantity field, type the Change Order quantity.
11. Click the Save button.
To enter a new item on a Contract:
1. Double-click the Change Orders icon.
2. Double-click the Change Order Maintenance icon.
3. Double-click the Header icon.
4. Click the Open button.
5. In the Contract ID list box, scroll to and double-click the desired Contract ID.
6. In the Change Order list box, scroll to and double-click the desired CO Nbr.
7. Click the Services menu and then click the CO Items choice.
8. Click the New button.
9. Click the New Contract Item folder tab.
10. In the Project Nbr drop-down list, click the expand and click the PCN.
11. In the Category Nbr drop-down list, click the expand arrow and click the category.
12. In the Line Item Nbr field, type line item number.
13. In the Item Code field, perform a Search and double-click the item to be added.
14. In the Unit Price field, type the unit price.
15. Click the Change Order Item folder tab.
16. In the Area of Change drop-down list, click the expand arrow and click the area of change.
17. In the This Change Order quantity field, type the quantity.
18. Click the Save button.

To add a Force Account item to the Contract:
1. Double-click the Change Orders icon.
2. Double-click the Change Order Maintenance icon.
3. Double-click the Header icon.
4. Click the Open button.
5. In the Contract ID list box, scroll to and double-click the desired Contract ID.
6. In the Change Order list box, scroll to and double-click the desired CO Nbr.
7. Click the Services menu and then click the CO Items choice.
8. Click the New Contract Item folder tab.
9. In the Project Nbr drop-down list, click the expand arrow and click the PCN.
10. In the Category Nbr drop-down list, click the expand arrow and click the category.
11. In the Line Item Nbr field, type the line item number.
12. In the Item Code field, perform a Search and double-click the Force Account Item.
13. In the Unit Price field, type unit price.
15. Click the Change Order Item folder tab.
16. In the Area of Change drop-down list, click the expand arrow and click the area of change.
17. In the This Change Order quantity field, type the quantity.
18. Click the Force Account Item check box (ON).
19. Click the Save button.
20. Click the Close button.
To calculate the Change Order:

1. Double-click the Change Orders icon.
2. Double-click the Change Order Maintenance icon.
3. Double-click the Header icon.
4. Click the Open button.
5. In the Contract ID list box, scroll to and double-click the desired Contract ID.
6. In the Change Order list box, scroll to and double-click the desired CO Nbr.
7. Click the Services menu and then click Calculate Change Order choice.
8. Click the Save button.
9. Click the Close button.

To add explanations to the Change Order:

1. Double-click the Change Orders icon.
2. Double-click the Change Order Maintenance icon.
3. Double-click the Change Order Explanations icon.
4. Click the Open button.
5. In the Contract ID list box, scroll to and double-click the desired Contract ID.
6. In the Change Order list box, scroll to and double-click the desired CO Nbr.
7. Click the New button to create a “General Explanation.”
8. In the lower text field, type the explanations.
9. Click the Save button.
10. In the drop-down list, click the expand arrow and click Explanations Applied to Specific Items.
11. Click the New button.
12. In the Pick Std Exp ID field, perform a Search and double-click ID.
13. In the Change Order Line Items area, double-click the line item.
14. Click the Save button.
Summary for Section 10

In the following exercise, you create a Change Order in SiteManager.

1. Navigate to the Header window and create a Change Order for Contract ID 8888G.
   (Hint: You will have to use Choose Keys.)

2. Enter the following information on the Header window:
   - Description: Electrical Change of Plans
   - Reason Code: Field Conditions
   - CO Type: Supplementary Agreement
   - Link the Change Order to Force Account 2.

3. Add a time adjustment to the Contract to increase the time 20 days. Include the following explanation: An additional 20 days is required for additional electrical work that cannot be done concurrently with the critical path.

4. Modify the following existing item on the Contract: Line Item Number 0036, Item Code 610018M, Description RPM, Mono-Directional, Amber Lens.
   - Increase the quantity by 50.00 units.
   - Area of Change: Electrical.

5. Add the following new item to the Contract.
   - Project Number: 8888G
   - Category Number: 0001
   - Line Item Number: 9001
   - Item Code: 701081P Description: 1-3” Flexible Nonmetallic Conduit
   - Unit Price: 35.00
   - Quantity: 190.00
6. Add the following Force Account item to the Contract.
   - Project Number: 8888G
   - Category Number: 0001
   - Line Item Number: 9002
   - Item Code: 109006M Description: Force Account
   - Unit Price: 1.00
   - Supplemental Description: FA2 Deteriorating Bearings
   - Quantity: 7105.34
   - Area of Change: Bridge.
   - Check the Force Account Item check box ON.

7. **Calculate** the Change Order. (Hint: Navigate to the Header window, Services Menu)

8. Navigate to the Change Order Explanations window and enter the following explanations:
   - Location of Proposed Order: From Station 87+90 to 88 +55
   - Purpose of Change Order: There is a conflict with the existing Sprint phone cable.
   - Associate Standard Explanation 009 with only Line Item 9002.

9. Navigate to the Main Panel.
11 Reviewing and Approving a Change Order

By the end of this section, you will be able to:

- Forward a Change Order for Review
- Generate the DC 173 Change Order
- Send a Change Order for Approval
- Approve a Change Order
- Tracking a Change Order
Forwarding a Change Order for Review

During the life of the Contract Change Order, the author is responsible for forwarding it to identified SiteManager users for review.

The Forward Change Order for Review window is accessible to the author of the Change Order, and other users authorized to view the Change Order details. Also, Approvers have access to this window in order to select a replacement or proxy if they are unavailable.

If the author changes the status to Pending and Saves the Change Order, the Forward to option on the Services menu is disabled. The Groups for Approval window appears as a result of saving the Change Order. The author then selects at least one approver from each approval level. Only SiteManager users who have Contract authority for the Contract and who are members of the appropriate security group will appear in the list.

Figure 11-1. The Forward Change Order For Review Window
Before sending a Change Order for approval, the Change Order is to be forwarded for review and modified as needed. Reviewers for Change Orders are to include the following:

- Field Managers
- Project Managers
- Regional Construction / Maintenance Engineer
- FHWA

Reviewers’ comments are to be viewed in the Change Order Tracking window.

During the Review Process, the Resident Engineer or his designee are to modify the Change Order as needed.

---

**Exercise 11-1**

Main Panel > Change Orders > Change Order Maintenance > Header

In the following exercise, you will send a Change Order for review.

Login: **tpsjone**  
Group: **RE**  
Contract: **7777H**

1. Double-click the **Change Orders** icon.
2. Double-click the **Change Order Maintenance** icon.
3. Double-click the **Header** icon.
4. Click the **Open** button.
5. Click the **Contract ID** button.
6. In the **Contract ID** list box, scroll to and double-click Contract ID **7777H**.
7. In the **Change Order** list box, scroll to and double-click CO Nbr **001**.
8. Click the **Services** menu, and then click the **Forward To** choice.
9. On the **Groups for Review** window, click **Contractor**.

10. In the lower window, click User ID **tpsgree**, User Name **Green, Chris**.

11. Click the **Add** button.

12. On the **Groups for Review** window, click **Departmental**.

13. In the lower window, click User ID **tswarr**, User Name **Warren, Jackie**.

14. Click the **Add** button.

15. Click the **OK** button.

16. Click the **Save** button.

17. Click the **OK** button.

18. Click the **Close** button.

19. Click the **Main Panel** folder tab.
Generating the DC 173 Change Order

The DC 173 Change Order is generated through Crystal Reports, which is accessible directly through the Crystal Reports Server or by double-clicking the Reports icon on the SiteManager Main Panel. The user should then log into Crystal Reports and select the DC 173 Change Order. When generating the report, the user should select the Contract ID and the Change Order Number as the parameters. The DC 173 Change Order can be viewed online, printed, or exported to PDF. The DC 173 Change Order can be regenerated throughout the life of the Change Order. Once the Change Order begins the approval process, it cannot be modified without changing the status of the Change Order back to Pending.

![Figure 11-2. DC 173 Change Order Parameters](image)

The Change Order reviewers are to generate the DC 173 Change Order to review the Change Order created in SiteManager. Comments regarding the Change Order are to be made in the Change Order Review/Approval window.
Exercise 11-2
Main Panel > Reports

In the following exercise, you will generate the DC 173 Change Order to review the Change Order.

Login: tpsjone   Group: RE   Contract: 7777H

1. Double-click the Reports icon.

2. Double-click DC 173 Change Order 7777H.

3. What is the status of the Change Order? Draft

4. Click the Close button.

5. Click the Close button to return to SiteManager.
Sending a Change Order for Approval

The Change Order Review/Approve icon allows the user who receives an In-Box message to review a draft Change Order or to approve a pending Change Order. The Review/Approve window allows the user to:

- Access the Change Order information
- View the Contract and Change Order information online
- Document their recommendation to approve or deny the Draft or Pending Change Order
- Record Remarks related to their recommendation. Remarks are optional.

![Figure 11-3. The Change Order Approval Window](image)

Figure 11-3. The Change Order Approval Window
The Resident Engineer or his designee are to initiate the approval process by changing the Change Order Status from Draft to Pending and then saving the Change Order. SiteManager automatically requests the Resident Engineer or his designee to select an individual to approve the Change Order for each level. The following are the Change Order Approval Levels:

- Contractor – The CO Engineer is to be selected to approve the Change Order on behalf of the Contractor.
- Resident Engineer
- Field Manager – If there is not a Field Manager assigned to the Contract, the Resident Engineer is to be selected to approve the Change Order again.
- Project Manager
- Regional CST Eng./Maint. Engineer
- Capital/Operations Programming
- FHWA – This level will only appear if there is Federal Oversight on the Contract.
- Agreement Accounting

Once all levels of approval have been entered in SiteManager, the new items and quantities will be available for recording on Daily Work Reports.

If an item was added to the Contract that is to be excluded from Construction Layout calculations, the Resident Engineer or his designee are to identify that item in the Construction Layout Program after the Change Order has been approved.

Capital/Operations Programming should be selected to provide approval on behalf of FHWA if FHWA cannot approve in SiteManager.

The Construction Layout Program is accessed through the Attachments button on the Contracts window.
**Exercise 11-3**
Main Panel > Change Orders > Change Order Maintenance > Header

In the following exercise, you will send a Change Order for approval by changing the Change Order status from Draft to Pending.

Login: \texttt{tpsjone} \hspace{2em} Group: \texttt{RE} \hspace{2em} Contract: \texttt{7777J}

1. Double-click the Change Orders icon.
2. Double-click the Change Order Maintenance icon.
3. Double-click the Header icon.
4. Click the Open button.
5. Click the Contract ID button.
6. In the Contract ID list box, double-click Contract ID \texttt{7777J}.
7. In the Change Order list box, scroll to and double-click CO Nbr 001.
8. In the Status drop-down list, click the expand arrow and click Pending.
9. Click the Save button.
10. Click Yes to the message confirming the status change to Pending.
11. In the Groups for Approval area, click Contractor.
12. In the lower window, click User ID \texttt{tpsgree}, User Name Green, Chris
13. Click the Add button.
14. In the Groups for Approval area, click Resident Engineer.
15. In the lower window, click User ID \texttt{tpsjone}, User Name Jones, Kelly.
16. Click the Add button.
17. In the Groups for Approval area, click Field Manager.
18. In the lower window, click User ID **tpswarr**, User Name **Warren, Jackie**.

19. Click the **Add** button.

20. In the **Groups for Approval** area, click **Project Manager**.

21. In the lower window, click **tpsjack**, User Name **Jackson, Bailey**.

22. Click the **Add** button.

23. In the **Groups for Approval** area, click **Regional CST Eng/Maint. Eng**.

24. In the lower window, click User ID **tpscay**, User Name **Clay, Andy**.

25. Click the **Add** button.

26. In the **Groups for Approval** area, click **Capital/Operations Programming**.

27. In the lower window, click User ID **tpspark**, User Name **Parker, Pat**.

28. In the **Groups for Approval** area, click **Agreement Accounting**.

29. In the lower window, click User ID **tpsqun**, User Name **Quin, Fran**.

30. Click **OK**.

31. Click **OK**.

32. Click the **Save** button.

33. Click the **File** menu and then click the **Exit** choice.

---

In the next exercise we will log in as the Change Order Engineer and approve the Change Order on behalf of the Contractor.
## Approving a Change Order

In order for the Change Order to be approved, it must be placed in Pending status and forwarded for approval.

![Image](image.png)

**Figure 11-4. The Change Order Review/Approve Window**

Once the Contractor’s signature is received on the DC 173 Change Order, the Change Order Engineer is to enter an electronic approval in the Change Order Review/Approve window in SiteManager. The Change Order Engineer is to note in remarks that the approval is on behalf of the Contractor and forward the DC 173 Change Order to the Regional Construction Engineer or Regional Maintenance Engineer. The Regional Construction Engineer or Regional Maintenance Engineer are to sign the DC 173 Change Order as well as enter electronic approval in SiteManager. The Change Order Engineer is to then forward copies of the DC 173 Change Order to the Contractor and to Agreement Accounting.

All other Change Order approvals are to be entered electronically in SiteManager. If an approver approves the Change Order on behalf of another person (i.e. Capital Programming approves the Change Order for FHWA), then a comment is to be made in Remarks stating the date and who gave the approval.

If an approver decides to deny the Change Order, a reason is to be entered in Remarks with direction to the Resident Engineer. The Resident Engineer is to then modify the Change Order if needed and repeat the Change Order Approval Process.

Once the final approval is entered in SiteManager, the Change Order cannot be modified.
Exercise 11-4
Main Panel > Change Orders > Change Order Maintenance > Change Order Review/Approve

In the following exercise, you will review the Change Order.

Login: tspgree  Group: COENGR  Contract: 7777J

1. Double-click the SiteManager icon on your desktop.
2. In the User ID field, type tspgree.
3. Press the Tab key.
4. In the Password field, type pass.
5. Press the Enter key.
6. Double-click the Change Orders icon.
7. Double-click the Change Order Maintenance icon.
8. Double-click the Change Order Review / Approve icon.
9. In the Contract ID list box, double-click Contract ID 7777J.
10. In the Change Orders list box, double-click CO Nbr 001.
11. Click the Remarks button.
12. In the Remarks text field, type Change Order signed and approved by IEW on <enter today’s date>.
13. Click the Remarks button.
14. Click the Approved radio button.
15. Click the Save button.
16. In the message box, click the Yes button.
17. In the message box, click the OK button.
18. Click the Close button.
19. Click the File menu, and then click the Exit choice.
Tracking a Change Order

The status of a Change Order in the review or approval cycle can be monitored by opening the Tracking window at any time. The Tracking window for a Change Order is a view-only window and displays:

- The date a request for recommendation was sent to a reviewer or approver
- The reviewer or approver’s name
- The action requested - review or approve
- The date the reviewer or approver made a recommendation
- The recommendation - Approved or Denied
- Any Remarks the reviewer or approver has made

Authorized users may also view details about current and historic Contract items online using the Item Summary window.

![Figure 11-5. The Change Order Tracking](image-url)
Throughout the Review and Approval Processes, the Change Order is to be tracked in the Tracking window. The Tracking window displays each reviewer’s and approver’s recommendation and comment.

Exercise 11-5
Main Panel > Change Orders > Change Order Maintenance > Tracking

In the following exercise, you will review the Change Order.

Login: tpsjone  Group: RE  Contract: 7777J

1. Double-click the SiteManager icon on your desktop.
2. In the User ID field, type tpsjone.
3. Press the Tab key.
4. In the Password field, type pass.
5. Press the Enter key.
6. Double-click the Change Orders icon.
7. Double-click the Change Orders Maintenance icon.
8. Double-click the Tracking icon.
9. In the Contract ID list box, scroll to and double-click Contract ID 7777J.
10. In the Change Orders list box, double-click CO Nbr 001.
11. Click the CO Tracking List folder tab.
12. Who is the next level of approval? ________________ Kelly Jones
13. Click the Close button.
14. Click the Main Panel folder tab.
Reviewing and Approving a Change Order

To forward a Change Order for Review:

1. Double-click the Change Orders icon.
2. Double-click the Change Order Maintenance icon.
3. Double-click the Header icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. In the Change Order list box, scroll to and click the desired CO Nbr.
6. Click the OK button.
7. Click the Services menu, and then click the Forward To choice.
8. On the Groups for Review window, click desired group.
9. In the lower window, click the User ID of the desired reviewer.
10. Click the Add button.
11. Repeat steps 11 – 13 for all desired reviewers.
12. Click the OK button.
13. Click the Save button.
14. Click the OK button.
15. Click the Close button.

To view Crystal Reports:

1. Double-click the Reports icon.
2. In the System field, type snj 187:6400.
3. In the User Name field, type TSP_Construction.
4. In the Password field, type pave09.
5. In the Authentication drop-down list, click the expand arrow and click Enterprise.
6. Click Folders.
7. Click the TSP_Construction folder.
8. Click the desired report.
9. Enter the required Parameters.
10. Click the OK button.
11. View, Print, or Save the report.

To export a Crystal Report to PDF format:

1. Generate the desired report.
2. Click the Export this Report button.
3. In the File Format drop-down list, click the expand arrow and click Adobe Acrobat (PDF).
4. Click the OK button.
5. Click the Save button.
6. Save the report in the desired location.
7. Exit Crystal Reports.

To send a Change Order for Approval:

1. Double-click the Change Orders icon.
2. Double-click the Change Order Maintenance icon.
3. Double-click the Header icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. In the Change Order list box, scroll to and click desired CO Nbr.
6. In the Status drop-down list, click the expand arrow and click Pending.
7. Click the Save button.
8. Click Yes to the message confirming the status change to Pending.
9. In the Groups for Approval area, click desired approval group.
10. In the lower window, click the User ID of the approver.
11. Click the Add button.
12. Repeat steps 12 – 14 for all approval groups.
13. Click OK.
14. Click OK.
15. Click the Save button.
To approve a Change Order:

1. Double-click the **Change Orders** icon.
2. Double-click the **Change Order Maintenance** icon.
3. Double-click the **Change Order Review / Approve** icon.
4. In the **Contract ID** list box, double-click the desired Contract ID.
5. In the **Change Orders** list box, double-click the desired CO Nbr.
6. Click the **Remarks** button.
7. In the **Remarks** text field, type the desired remark.
8. Click the **Remarks** button.
9. Click the **Approved** radio button.
10. Click the **Save** button.
11. Click the **Close** button.
12. In the message box, click the **Ok** button.

To track a Change Order:

1. Double-click the **Change Orders** icon.
2. Double-click the **Change Order Maintenance** icon.
3. Double-click the **Tracking** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Change Orders** list box, double-click the desired CO Nbr.
6. Click the **CO Tracking List** folder tab.
7. Click the **Close** button.
Summary for Section 11

In the following exercise, you view and approve a Change Order in SiteManager.

Login: tpsjone  Group: RE  Contract: 8888H

1. Navigate to the Header window and open a Change Order 001 for Contract ID 8888H. Forward the Change Order for Review to Jackie Warren.

2. Name two ways to review the Change Order: Generate the DC 173 or view the SM windows

3. Forward Change Order Nbr. 001 for Contract ID 8888J for Approval using the following approvers:
   - Contractor: Chris Green
   - Resident Engineer: Kelly Jones
   - Field Manager: Jackie Warren
   - Project Manager: Bailey Jackson
   - Regional CST/Maint. Engineer: Andy Clay
   - Capital Operations/Programming: Pat Parker
   - Agreement Accounting: Fran Quin

4. Exit SiteManager.

5. Log into SiteManager as tpsgree and approve Change Order 001 for Contract ID 8888J on behalf of the Contractor.

6. Navigate to the Change Order Tracking window. Who is the next level of approval? Kelly Jones

7. Exit SiteManager.
This page intentionally left blank.
12 Finalizing a Contract

By the end of this section, you will be able to:

- Review the Contract Finalization Process
- Substantially Complete the Contract
- Conduct Close Out Meetings and Inspections
- Apply Adjustments
- View the Certification of Completion Change Order
- Finalize As-Built Quantities
- Calculate the Construction Layout Adjustment
- Prepare for the Final Estimate
Reviewing the Contract Finalization Process

The SiteManager Contract Finalization Plan should be followed for each Contract beginning with the Substantial Completion memo until one year after the Final Estimate.

The Substantial Completion phase of the Contract Finalization process is initiated by the Contractor with a memo to NJDOT. The Resident Engineer or his designee is responsible for tracking the correspondence with the Contractor and making the necessary changes in SiteManager to note the Contract’s substantially complete status, including entering the necessary Critical Dates, reducing retainage, and tracking the correspondence in the Correspondence Log.

The Resident Engineer or his designee is responsible for tracking correspondence and Key Dates related to Close Out Meetings, Contract Inspections, and Material Adjustments. If necessary, Change Orders should be created to add the material adjustment items to the Contract and once the Change Order is approved, the adjustment can be made on the Daily Work Report.

Once the Completion Date is entered by the Resident Engineer, the Close Out Engineer should initiate the Certification of Completion Change Order and for enter the date the Contract is accepted by the State Transportation Engineer in the Contracts window, Critical Date folder tab.

The Resident Engineer or his designee is responsible for determining as-built quantities for the Contract, tracking correspondence related to as-built quantities and balancing final as-built quantities through the use of Daily Work Reports and Change Orders.

Once the as-built quantities are finalized, the Construction Layout Adjustment should be applied on the Daily Work Report.

The Resident Engineer should then prepare for the final estimate by ensuring the following tasks are complete:

- End Contract Authority
- Review Remaining Items
- Create the Final Change Order
- End Contract Time
- Generate the Pre-Final Progress Estimate
Enter the Final As-built Change Order Approved Date

Generate and Approving the Final Estimate
Substantially Completing the Contract

The Substantial Completion phase of the Contract Finalization process is initiated by the Contractor with a memo to NJDOT. The Resident Engineer or his designee is responsible for tracking the correspondence with the Contractor and making the necessary changes in SiteManager to note the Contract’s substantially complete status. Once the Contract is substantially complete, the Resident Engineer or his designee should also Close Out all remaining stockpiled materials.

Viewing a Correspondence Log Record

The Correspondence Log window is used to document correspondence related to the Contract. All correspondence relating to the finalization of the Contract should be tracked in the Correspondence Log window under the Document Category of “Close Out.”

Refer to Section 4 for instructions on closing out stockpiles.

The Resident Engineer or his designee are to create a Correspondence record to document the Contractor’s request of the Contract being Substantially Complete. The correspondence is to be recorded under the Document Category “Close Out” and the request is to be attached to the record as an Attachment.
Exercise 12-1
Main Panel > Contract Administration > Contract Records > Correspondence Record

In the following exercise, you will view a Correspondence Log record for Substantial Completion communications.

Login: tpsjone Group: RE Contract: 7777K

1. Double-click the SiteManager icon on your desktop.

2. In the User ID field, type tpsjone.

3. Press the Tab key.

4. In the Password field, type pass.

5. Press the Enter key.

6. Double-click the Contract Administration icon.

7. Double-click the Contract Records icon.

8. Double-click the Correspondence Log icon.

9. Click the Open button.

10. In the Contract ID list box, scroll to and double-click Contract ID 7777K.

11. In the Correspondence Log list box, scroll to and double-click Corr Srl Nbr 3.

12. What is the Document Category? _________________

13. Click the Close button.
Entering the Substantial Completion Critical Date

Once the Resident Engineer determines the Contract to be substantially complete, the Resident Engineer or his designee should enter the Substantial Work Complete date in the Contract Window on the Critical Date folder tab.

The Resident Engineer or his designee are to enter the Substantial Work Complete date in the Contracts Window on the Critical Date folder tab once the Contract is determined by the Resident Engineer to be substantially complete.
Exercise 12-2
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will enter the actual date for the Substantial Completion Critical Date.

Login: tpsjone   Group: RE   Contract: 7777K

1. Double-click the Contracts icon.

2. Click the Critical Date folder tab.

3. In the Critical Date Description list, click Substantial Work Complete Date.

4. In the Actual Occurrence Date field, type 100708.

5. In the Recipient ID field, perform a Search and double-click User ID tpsclay, User Name Clay, Andy.

6. Click the Save button.

The Regional CST Eng/Maint. Engineer should be notified when the Contract is substantially complete.
Reducing Retainage

The Resident Engineer or his designee should reduce the amount of retainage withheld on the Contract from 2% to 1%, or as designated by the Contract. The change in retainage withholdings is entered in the Contract Window, on the Payment Data folder tab. SiteManager will automatically reduce the retainage on the next estimate.

![Contracts Window Payment Data Folder Tab](image)

The Resident Engineer or his designee are to reduce the amount of retainage withheld on the Contract from 2% to 1%, or as designated by the Contract.
Exercise 12-3
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will reduce retainage for the Contract.

Login: tpsjone   Group: RE   Contract: 7777K

1. Click the Payment Data folder tab.
2. Click the Retainage Changes area.
3. Click the New button.
4. In the Effective Date field, type 102208.
5. In the Pct field, type 1.
6. In the Max Pct field, type 1.
7. Click the Save button.
8. Click the Close button.
9. Click the Main Panel folder tab.

Typically, the Substantial Completion Date is to should be entered as the new retainage date. However, since the final estimate in training has been pre-generated, SiteManager will not allow for a date that is effective prior to the current estimate date.
Conducting Close Out Meetings and Inspections

The Resident Engineer or his designee is responsible for tracking correspondence related to Close Out Meetings, Contract Inspections, and Material Adjustments.

All Correspondence relating to Close Out meetings, Inspections and Material Adjustments should be entered in the Correspondence Log window with a Document Category “Close Out”. If available, the correspondence should be attached to the record.

The Resident Engineer or his designee should enter the actual dates for the following Key Dates:

- Acceptance Inspection
- All Required Material Certs and Drawings
- All Required Payrolls and EEO Statements
- All Required Releases Received
- All ROW Issues Resolved
- Close Out Meeting Held
- Corrective Action Inspection
- DC 123 Final Certificate of Compliance
- LB 95A Materials Cert
- Letter of Corrective Work to Contractor
- Mylars Submission
- Notice of Completion
- Memo of Corrective Work

If it is determined that material adjustments are needed, the Resident Engineer or his designee should create an Extra Work Change Order to add the required adjustment items to the Contract. The unit price should be established as $1.00 and the quantity should be entered as the amount of the adjustment. The following is a list of items created to apply material related adjustments:

- Concrete Rideability Quality Adjustment
Concrete Strength Quality Adjustment
Concrete Thickness Quality Adjustment
Failing Sample Charge
HMA Air Void Quality Adjustment
HMA Rideability Quality Adjustment
HMA Thickness Quality Adjustment

The Change Order should follow the standard review and approval processes. Once the Change Order is approved, the items will be available to record on a Daily Work Report.

Once the Change Order with the adjustment items is approved, the Resident Engineer or his designee should create a DWR to apply the adjustment amounts to the Contractor. The items should be recorded to the Prime Contractor with a location description of “Throughout Project”. The amount of the adjustment should be entered in both the Placed Qty and the Asbuilt Qty fields. The reports detailing the required adjustments should be attached to the Item on the DWR.

Once the DWR is created, the Resident Engineer should authorize the DWR for payment in the Diary window. The adjustments will then be automatically included on the next estimate.

Figure 12-4 Daily Work Reports – Material Adjustment
The Resident Engineer or his designee is responsible for tracking correspondence related to Close Out Meetings, Contract Inspections, and Material Adjustments, initiating the necessary Change Orders to add items, and recording adjustments on Daily Work Reports.

**Exercise 12-4**
Main Panel > Daily Work Reports > Daily Work Reports

In the following exercise, you will view a DWR to charge the Contract for a material adjustment.

Login: tpsjone  Group: RE  Contract: 7777K

1. Double-click the Daily Work Reports icon.
2. Double-click the Daily Work Reports icon.
3. Click the Open button.
4. Click the No button.
5. In the Inspector list box, scroll to and double-click User ID tpsjone.
6. In the Date list box, scroll to and double-click DWR Date 092608.
7. Click the OK button.
8. Click the Work Items folder tab.
9. Scroll to and double-click Line Item Number 9003, Category Number 0001, Item Code 401115M, Description HMA Air Void Quality Adjustment.
10. What is the Unit Price? $1.00
11. What is the Quantity? 50,915.00
12. Click the Close button.
13. Click the Main Panel folder tab.

Material Adjustment Items should be added to the Contract via Change Order for a unit price of (-)$1.00 with the quantity being the amount to be of the adjustment.
Entering the Construction Completion Key Date

The Resident Engineer is responsible for entering the Completion Date, which initiates the Certification of Completion process.

![Contracts Window Payment Data Folder Tab](image)

Figure 12-5 Contracts Window Payment Data Folder Tab

The Resident Engineer is to enter the Construction Completion date in the Key Date window once construction is determined to complete for the Contract.
Exercise 12-5
Main Panel > Contract Administration > Contract Records > Key Dates

In the following exercise, you will enter the Construction Completion Key Date.

Login: tpsjone Group: RE Contract: 7777K

1. Double-click the Contract Administration icon.

2. Double-click the Contract Records icon.

3. Double-click the Key Dates icon.

4. In the Key Date Type list, click Construction Completion Date.

5. In the Actual Date field, type 102008.

6. Click the Save button.

7. Click the Close button.

8. Click the Main Panel folder tab.
Viewing the Certification of Completion Change Order

The Close Out Engineer initiates a Change Order that is used for the purpose of tracking Certification of Completion approvals. The Change Order Header should be created with the following information:

- **Description**: Certification of Completion
- **Reason Code**: Certification of Completion
- **CO Type**: Certification of Completion
- **Function**: Zero Dollar

The Close Out Engineer generates the Certification of Completion Report from Crystal Reports and forwards it to the State Transportation Engineer for signature. All other signature approvals regarding Certification of Completion should be entered in SiteManager in the Change Order Review/Approve window. Once the Construction Acceptance Change Order is approved and the State Transportation Engineer’s signature is received, the Close Out Engineer should enter the date the signature was received in the Accepted Date Actual Date field in the Contract Window on the Critical Date folder tab. The status of the Certification of Completion can be viewed in the Change Order Tracking window.

![Change Order Tracking Window](image)

Figure 12-6  Change Order Tracking Window
The Close Out Engineer is to initiate the Certification of Completion Change Order to track construction acceptance.

The Close Out Engineer is to select individuals from the following Security Groups to indicate that the construction on the Contract has been accepted:

- Resident Engineer (RE)
- Regional Elect. Maintenance Supv. (RELEMSV)
- Regional Maintenance Engineer (RCERMM)
- Project Manager (PM)
- Field Manager (FLDMGR)
- Regional Construction Engineer (RCERMM)
- Director of Operations (DIRECTOR)

These individuals are to accept the construction by approving the Certificate of Completion Change Order.

Once all electronic and physical signatures have been received (State Transportation Engineer and Secretary), the Close Out Engineer is to enter the Accepted Date in the Contracts window Critical Dates folder tab.
Exercise 12-6
Main Panel > Change Orders > Change Order Maintenance > Tracking

In the following exercise, you will view the Certification of Completion Change Order.

Login: **tpsjone**  Group: **RE**  Contract: **7777K**

1. Double-click the **Change Orders** icon.
2. Double-click the **Change Orders Maintenance** icon.
3. Double-click the **Tracking** icon.
4. In the **Contract ID** list box, scroll to and double-click Contract ID **7777K**.
5. In the **Change Orders** list box, double-click CO Nbr **003**.
6. Click the **CO Tracking List** folder tab.
7. Who was the last level of approval? **Robin Gray**
8. Click the **Close** button.
9. Click the **Main Panel** folder tab.
Finalizing As-Built Quantities

The Resident Engineer or his designee is responsible for determining as-built quantities for the Contract, tracking correspondence related to as-built quantities, entering as-built key dates, and balancing the as-built quantities on a Daily Work Report and Change Order.

All Correspondence relating to as-built quantities should be entered in the Correspondence Log window with a Document Category “Close Out”. If available, the correspondence should be attached to the record.

The Resident Engineer or his designee should enter the actual dates for the following Key Dates relating to as-built quantities:

- As-Built Qtys Review by BCM
- As-Built Qtys Sent to Contractor
- As-Built Qtys Agreed to by Contractor
- Pavement As-built Data

The Resident Engineer should generate the As-Built Summary Report to compare the Paid to Date quantities verses the as-built quantities. If the quantities differ, then a DWR should be created to account for the difference in the paid verses as-built amount. The As-Built Summary Report is generated through Crystal Reports, which is accessible directly through the Crystal Reports Server or by double-clicking the Reports icon on the SiteManager Main Panel. The user should then log into Crystal Reports and select the As-Built Summary Report. When generating the report, the user should select the Contract ID as the parameter. The As-Built Summary Report can be viewed online, printed, or exported to PDF. The As-Built Summary Report is a dynamic report in that each time it is generated, the quantities may change based on Daily Work Report and Change Order quantities.

The Resident Engineer or his designee should create a DWR to balance the as-built quantities with the Paid to Date quantities. The Resident Engineer should enter the difference between the two quantities in the placed quantity field.

Once the DWR is created, the Resident Engineer should authorize the DWR for payment in the Diary window. The quantities will then be automatically included on the next estimate.
The Resident Engineer or his designee should create an Overrun/Underrun Change Order to adjust the final quantity on all items. This Change Order should follow the standard Change Order Review and Approval Processes.

The Resident Engineer or his designee is responsible for determining as-built quantities for the Contract, tracking correspondence related to as-built quantities, entering as-built key dates, and balancing the as-built quantities on a Daily Work Report and Change Order.

Exercise 12-7
Main Panel > Reports

In the following exercise, you will generate the As-Built Summary Report.

Login: tpsjone    Group: RE    Contract: 7777K

1. Double-click the Reports icon.

2. Double-click the As-Built Summary Report.

3. What should be the DWR adjustment for Line Item Number 0019 Description Temporary Traffic Stripes?
   500.00

4. What should be the DWR adjustment for Line Item Number 0038 Description Rumble Strip?
   -500.00

5. Click the Close button.

6. Click the Close button to return to SiteManager.
Calculating the Construction Layout Adjustment

The Resident Engineer or his designee is responsible for generating the Calculation of Construction Layout Adjustment Report to determine the construction layout adjustment, recording the construction layout adjustment and balancing the construction layout item on a Change Order, if necessary.

The construction layout adjustment is calculated by the Calculation of Construction Layout Adjustment Report, which should be generated by the Resident Engineer or his designee. The Calculation of Construction Layout Adjustment Report is generated through Crystal Reports, which is accessible directly through the Crystal Reports Server or by double-clicking the Reports icon on the SiteManager Main Panel. The user should then log into Crystal Reports and select the Calculation of Construction Layout Adjustment Report. When generating the report, the user should select the Contract ID as the parameter. The Calculation of Construction Layout Adjustment Report can be viewed online, printed, or exported to PDF.

The Resident Engineer or his designee should create a DWR to record the amount of the construction layout adjustment. The item should be recorded to the Prime Contractor with “Throughout Project” as the location. The Calculation of Construction Layout Adjustment Report should be attached to the item on the DWR.

Once the DWR is created, the Resident Engineer should authorize the DWR for payment in the Diary window. The quantities will then be automatically included on the next estimate.

The Resident Engineer or his designee is responsible for generating the Calculation of Construction Layout Adjustment Report to determine the construction layout adjustment, recording the construction layout adjustment and balancing the construction layout item on a Change Order, if necessary.
Exercise 12-8
Main Panel > Reports

In the following exercise, you will generate the Construction Layout Report.

Login: tpsjone       Group: RE       Contract: 7777K

1. Double-click the Reports icon.

2. Double-click the CST Layout Adj Report.

3. What is the amount of the construction layout adjustment?

   ___________________________
   $550.47

4. What amount should be placed on the Daily Work Report?

   ___________________________
   0.55

5. Click the Close button.

6. Click the Close button to return to SiteManager.
Preparing for the Final Estimate

The Preparing for the Final Estimate section includes several steps required by SiteManager and the NJDOT business processes that must be completed prior to submitting the Final Estimate in SiteManager.

Ending Contract Authority

The Resident Engineer should notify the SiteManager Coordinator to end Contract Authority for all Inspectors and field office personnel who are no longer responsible for entering information in SiteManager. Once the SiteManager coordinator ends Contract Authority for a user, SiteManager maintains a record of the dates that the user had Contract Authority, but the user will no longer have access to the Contract in SiteManager.

The Resident Engineer is to notify the SiteManager Coordinator to end Contract Authority for all Inspectors and field office personnel who are no longer responsible for entering information in SiteManager.
Exercise 12-9
Main Panel > Contract Administration > Contract Records > Contract Authority

In the following exercise, you will view the Contract Authority window.

Login: tpsjone    Group: RE    Contract: 7777K

1. Double-click the Contract Administration icon.
2. Double-click the Contract Records icon.
3. Double-click the Contract Authority icon.
4. In the User Identification list, scroll to and click User ID tpsalle.
5. When did Contract Authority end for Contract ID 7777K?

[10/27/2008]

6. Click the Close button.

Creating the Final Change Order

The Resident Engineer should review the remaining items on the Contract. If an item that requires a fuel or asphalt price adjustment is recorded, but not paid, then a Progress Estimate should be generated to determine the total placed quantities, the Fuel and Asphalt Price adjustment reports should be generated to determine the amount of the adjustment, and a DWR should be created to record the price adjustments. This Estimate does not need to be paid.

Based on the review of the remaining items, the Final Overrun/Underrun Change Order should be created to determine the final quantities of the remaining items on the Contract. This Change Order should be processed as a standard Overrun/Underrun Change Order.

The Resident Engineer is to review the remaining items on the Contract and create an overrun/underrun Change Order as necessary.

SiteManager has a Change Order function called ‘Final Quantity.’ This should not be used at NJDOT.
Ending Contract Time

Once it is determined that Time Charges should stop for the Contract, the actual date for the Key Date DC 23 Tabulation of Working Days Complete should be entered and the Tabulation of Work Days Report should be generated.

The Tabulation of Work Days Report is generated through Crystal Reports, which is accessible directly through the Crystal Reports Server or by double-clicking the Reports icon on the SiteManager Main Panel. The user should then log into Crystal Reports and select the Tabulation of Work Days Report. When generating the report, the user should select the Contract ID as the parameter. The Tabulation of Work Days Report can be viewed online, printed, or exported to PDF.

The Resident Engineer is to enter the Key Date when time is complete for the Contract and then generate the DC 23 Tabulation of Work Days Report.

A DWR and Diary is to be created for each day of the Contract starting with the Official Contract Start Date to the DC 23 Tabulation of Working Days actual date.
Exercise 12-10
Main Panel > Reports

In the following exercise, you will generate the Tabulation of Working Days Report and enter the actual Key Date.

Login: tpsjone Group: RE Contract: 7777K

1. Double-click the Key Dates icon.

2. In the Contract ID list box, scroll to and double-click Contract ID 7777K.

3. In the Key Date Type list, click DC 23 Tabulation of Working Days Comp.

4. In the Actual Occurrence Date field, type 102108.

5. Click the Save button.

6. Click the Close button.

7. Click the Main Panel folder tab.

8. Double-click the Reports icon.


10. How many days were charged as Work Days? 50

11. Click the Close button.

12. Click the Close button to return to SiteManager.

Generating a Pre-Final Progress Estimate

The Resident Engineer should generate a Pre-Final Progress Estimate to ensure that all estimate discrepancies have been resolved. The only estimate discrepancy that should exist at this point is the Contract Time discrepancy. If a discrepancy cannot be resolved, the Close Out Engineer should be contacted.

This estimate should not be paid.
The Resident Engineer is to generate a Pre-Final Progress Estimate and resolve all discrepancies.

**Exercise 12-11**

Main Panel > Contractor Payments > Estimates > Estimate Discrepancy

In the following exercise, you will verify the Estimate Discrepancy window.

Login: **tpsjone**  Group: **RE**  Contract: **7777K**

1. Click the **Contractor Payments** folder tab.
2. Double-click the **Estimate** icon.
3. Double-click the **Estimate Discrepancy** icon.
4. In the **Contract ID** list box, scroll to and double-click Contract ID **7777K**.
5. In the **Estimate** list box, scroll to and double-click Estimate Number **0003**.
6. Are there discrepancies on this estimate? **No**
7. Click the **Save** button.
8. Click the Close button.

9. Click the Main Panel folder tab.

**Entering the Final As-Built Change Order Approved Date**

Just prior to generating the Final Estimate, the Resident Engineer should enter the Final As-built Change Order Approved Critical Date in the Contracts window. Once the Final As-built Change Order Approved date is entered, DWR’s can no longer be created. This date should not be entered until after the As-built Change Order is approved and an estimate is generated to ensure no discrepancies exist on the Contract.

![Contracts Window Critical Date Folder Tab](image)

The Resident Engineer is to enter the Final As-Built Change Order Approved date once the final Change Order is approved and no additional DWR’s will be created.
**Exercise 12-12**
Main Panel > Contract Administration > Contract Records > Contracts

In the following exercise, you will enter Final As-Built Change Order Approved date.

- Login: **tpsjone**  
  Group: **RE**  
  Contract: **7777K**

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Contracts** icon.
4. Click the **Critical Date** folder tab.
5. In the **Critical Date Description** list, click **Final As-Built Change Order Approved**.
6. In the **Actual Occurrence Date** field, type **102108**.
7. Click the **Save** button.
8. Click the **OK** button.
9. Click the **Close** button.
10. Click the **Main Panel** folder tab.

**Generating the Final Estimate**

The Final Estimate is generated in the Generate Estimate window. Each Contract can have one and only one Final Estimate. SiteManager will not allow a Final Estimate with estimate discrepancies to be approved.
The Resident Engineer is to generate the Final Estimate in SiteManager and apply the applicable Contract Adjustments.

**Exercise 12-13**

Main Panel > Contractor Payments > Estimates > Generate Estimate

In the following exercise, you will generate the final estimate.

1. Click the **Contractor Payments** icon.
2. Double-click the **Estimate** icon.
3. Double-click the **Generate Estimate** icon.
4. In the **Contract ID** list box, scroll to and double-click Contract ID 7777L.
5. In the **End field**, type **102108**.
6. Click the **Final** radio button.
7. Click the **Generate Estimate** button.
8. Click the **Yes** button.

9. Click the **NO** button.

10. In the message, click the **OK** button.

11. Click the **Close** button.

**Approving the Final Estimate**

Once the Final Estimate has been generated and reviewed, and the appropriate Contract Adjustments have been applied to the estimate, the Final Estimate should be approved in SiteManager.

![Figure 12-14 Estimate Approval Window](image)

The Resident Engineer is to approve the final estimate, followed by the Regional CST/Maint. Engineer, and then Accounting Operations.

The Resident Engineer should approve the final estimate, followed by the Regional CST/Maint. Engineer, and then Accounting Operations.
**Exercise 12-14**

Main Panel > Contractor Payments > Estimates > Estimate Approval

In the following exercise, you will approve the Final estimate.

Login: **tpsjone**  Group: **RE**  Contract: **7777L**

1. Double-click the **Estimate Approval** icon.
2. In the **Contract** list box, scroll to and double-click Contract ID **7777L**.
3. Click the **Approved** check box (ON).
4. Click the **Save** button.
5. Click the **Close** button.
6. Click the **Ok** button.
7. Click the **File** Menu and then click the **Exit** choice.
8. Double-click the **SiteManager** icon on your desktop.
9. Type **tpscley**.
10. Press the **Tab** key.
11. Type **pass**.
12. Press **Enter**.
13. Click the **Contractor Payments** folder tab.
14. Click the **Estimates** folder tab.
15. Double-click the **Estimate Approval** icon.
16. In the **Contract** list box, scroll to and double-click Contract ID **7777L**.
17. Click the **Approved** check box (ON).
18. Click the **Save** button.
19. Click the **Close** button.
20. Click the **Ok** button.
21. Click the **File** Menu and then click the **Exit** choice.
22. Double-click the **SiteManager** icon on your desktop.
23. Type **tpsjohn**.
24. Press the **Tab** key.
25. Type **pass**.
26. Press **Enter**.
27. Click the **Contractor Payments** folder tab.
28. Click the **Estimates** folder tab.
29. Double-click the **Estimate Approval** icon.
30. In the **Contract** list box, scroll to and double-click Contract ID **7777L**.
31. Click the **Approved** check box (ON).
32. Click the **Save** button.
33. Click the **NO** button.
34. Click the **OK** button.
35. Click the **File** Menu and then click the **Exit** choice.
Review for Section 12

To create a Correspondence Log record with an attachment:

1. Double-click the Contract Administration icon.
2. Double-click the Contract Records icon.
3. Double-click the Correspondence Log icon.
4. Click the Services menu, and then click the Choose Keys choice.
5. In the Contract ID list box, scroll to and double-click the desired Contract ID.
6. In the Correspondence Type drop-down list, click the expand arrow and click the desired correspondence type.
7. In the drop-down list, click the expand arrow and click Received or Sent.
8. In the On field, type the date the correspondence was received or sent.
9. In the Sent From field, type who sent the correspondence.
10. In the Sent To field, type to whom the correspondence was sent.
11. In the Document Category drop-down list, click the expand arrow and click the desired document category.
12. In the Major Topics field, type the major topics.
13. Click the Save button.
14. Click the Attachments button.
15. Click the New OLE button.
16. Click the Create from File button.
17. Browse to the desired document.
18. Click the Open button.
19. Click the OK button.
20. In the Name field, type the name of the attachment.
21. In the Description field, type the description of the attachment.
22. In the Attachment Security box, click the Add All button.
23. Click the Add button.
24. Click the Save button.
25. Click the Close button.

To enter a Critical Date:

1. Double-click the Contract Administration icon.
2. Double-click the Contract Records icon.
3. Double-click the Contracts icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. Click the Critical Date folder tab.
6. In the Critical Date Description list, click the desired critical date.
7. In the Actual Occurrence Date field, type the date.
8. Click the Save button.

To reduce retainage:

1. Double-click the Contract Administration icon.
2. Double-click the Contract Records icon.
3. Double-click the Contracts icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. Click the Payment Data tab.
6. Click the Retainage Changes area.
7. Click the New button.
8. In the Effective Date field, type the date.
9. In the Pct field, type the desired percentage.
10. In the Max Pct field, type maximum percentage.
11. Click the Save button.
To create a Daily Work Report and authorize it on a Diary:

1. Double-click the **Daily Work Reports** icon.
2. Double-click the **Daily Work Reports** icon.
3. Click the **Services** menu, and then click the **Choose Keys** choice.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **DWR Date** field, type the DWR date.
6. Press the **Tab** key.
7. Click the **Save** button.
8. Click the **Contractors** folder tab.
9. On the **Contractors** folder tab, click the Contractor area.
10. Click the **New** button. An empty row is added to the list.
11. In the **Contractor** drop-down list, click the expand and click the desired Contractor.
12. Click the **Save** button.
13. Click the **Work Items** folder tab.
14. Scroll to and click the Work Item.
15. Click the **Record Work Item** button.
16. Click the **New** button.
17. In the **Placed Qty** field, type the quantity.
18. In the **Contractor** drop-down list, click the expand arrow and click the Contractor.
19. In the **As Built Qty** field, type the quantity.
20. In the **Location** field, type the location.
21. Click the **Save** button.
22. Click the **Close** button.
23. Double-click the **Diary** icon.
24. In the **Inspector** list box, click the DWR for the Inspector.
25. Click the **Authorized** check box (ON).
26. Click the **Save** button.
27. Click the **Close** button.

To enter a Key Date:

1. Double-click the **Contract Administration** icon.
2. Double-click the **Contract Records** icon.
3. Double-click the **Key Dates** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Key Date Type** list, click the desired Key Date.
6. In the **Actual Date** field, type the actual date.
7. Click the **Save** button.
8. Click the **Close** button.

To track the Certification of Completion approvals:

1. Double-click the **Change Orders** icon.
2. Double-click the **Change Order Maintenance** icon.
3. Double-click the **Tracking** icon.
4. In the **Contract ID** list box, scroll to and double-click the desired Contract ID.
5. In the **Change Orders** list box, double-click the desired CO Nbr.
6. Click the **CO Tracking List** folder tab.
7. Click the **Close** button.

To generate a Crystal Report:

1. Double-click the **Reports** icon.
2. In the **System** field, type **snj 187:6400**.
3. In the **User Name** field, type **TSP_Construction**.
4. In the **Password** field, type **pave09**.
5. In the **Authentication** drop-down list, click the expand arrow and click **Enterprise**.
6. Click **Folders**.
7. Click the **TSP_Construction** folder.
8. Click the desired report.
9. Enter the required **Parameters**.
10. Click the **OK** button.
11. **View**, **Print**, or **Save** the report.
To export a Crystal Report to PDF format:

1. Generate the desired report.
2. Click the Export this Report button.
3. In the File Format drop-down list, click the expand arrow and click Adobe Acrobat (PDF).
4. Click the OK button.
5. Click the Save button.
6. Save the report in the desired location.
7. Exit Crystal Reports.

To view the Contract Authority window:

1. Double-click the Contract Administration icon.
2. Double-click the Contract Records icon.
3. Double-click the Contract Authority icon.
4. In the User Identification list box, scroll to and click the desired User.
5. View the Contract Authority information in the bottom portion of the window.
6. Click the Close button.

To generate the Final Estimate:

1. Click the Contractor Payments icon.
2. Double-click the Estimate icon.
3. Double-click the Generate Estimate icon.
4. In the Contract list box, scroll to and double-click the desired Contract ID.
5. In the End field, type the end date.
6. Click the Final radio button.
7. Click the Generate Estimate button.
8. In the message, click the OK button.
9. In the message, click the OK button.
10. Click the Close button.

To approve an estimate:

1. Double-click the Contractor Payments icon.
2. Click the Estimates icon.
3. Double-click the Estimate Approval icon.
4. In the Contract ID list box, scroll to and double-click the desired Contract ID.
5. In the Estimate list box, scroll to and double-click the desired estimate number.
6. Click the Approved check box (ON).
7. Click the Save button.
8. Click the Close button.
9. Click the Ok button.
Summary for Section 12

In the following exercise, you review the Contract Finalization Process in SiteManager.

Login: tpsjone  Group: RE  Contract: 8888K

1. Log into SiteManager as tpsjone.

2. When creating Correspondence Log records during the Contract Finalization Process, what should be selected as the Documents Category? __________________________

3. For Contract ID 8888K, enter the Substantial Completion Date of 10/09/08. (Hint: Contracts Window Critical Dates folder tab.)

4. Reduce the retainage withheld on Contract ID 8888K to 1%. Use 10/22/08 as the Effective Date.

5. How would you apply a material adjustment such as a Concrete Rideability Quality Adjustment to a Contract in SiteManager? __________________________________________
   Create a Change Order to add the item to the Contract and then record the item on a DWR.

6. Enter the Construction Completion Key Date of 10/24/08 for Contract ID 8888K.

7. What window can be viewed to verify the status of the Certification of Completion for the Contract? ______________________________________________________

8. What Key Date in SiteManager indicates the ending of Contract time? __________
   DC 23 Tabulation of Working Days Comp.

9. How many discrepancies can you have on the Final Estimate? ____________
   Zero

10. Generate the Final Estimate for Contract ID 8888L. Click the Yes button to delete the existing estimate.

11. Navigate to the Estimate Summary window. What is the total to be paid to the Contractor on the Final Estimate? 176,195.50

12. Navigate to the Main Panel.